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Introduction to Endpoint Investigation

NetWitness Investigate provides data analysis capabilities in NetWitness, so that analysts can analyze
packet, log, endpoint, and UEBA data, and identify possible internal or external threats to security and
the IP infrastructure. This guide helps analysts perform investigations of endpoint data using NetWitness
Investigate.

Note: In Version 11.1 and later, the Hosts and Files views provide a view into endpoint data. Earlier
versions offer access to endpoint data using a standalone NetWitness Endpoint server.

For more information, see the NetWitness Endpoint Quick Start Guide, the NetWitness Investigate Quick
Start Guide, and the NetWitness Investigate User Guide.

Endpoint Metadata

Endpoint metadata is generated when hosts are scanned and when there are real-time activities on the
hosts. You can view the following categories of sessions when metadata forwarding is enabled:

8 Introduction to Endpoint Investigation
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Scan

Categories
Operating
& Tracking Categories

System

Real-time

events

Windows file, service, ¢ Process event - Reports any process related activities, such as
dll, process,
task, autorun,
machine, kernel

openprocess, openosprocess, createprocess,
createremotethread, openbrowserprocess.

hook, image « File event - Reports any file related activities by an executable,
gpok;regQUy such as readdocument, writetoexecutable,
iscrepancies,
.P renameexecutable, selfdeleteexecutable,
suspicious
threads and openphysicaldrive.
removable  Registry event - Reports activities that result in registry creation
device(USB) X . . . .
. or modification, such as modifyservicesimagepath,
detection

modifyfirewallpolicy, createservicesimagepath,
createsecuritycenterconfiguration,
modifybadcertificatewarningsetting,

Modifies Startup Folder Location,

Modifies Winlogon Registry Settings,
Registers Time Provider D11,

Registers Port Monitor D11,

Registers Netsh helper D11,

Registers AppInit D11, Registers AppCert D11,

¢ System event - Reports connection of removable devices(USB
devices), IP change and boot events such as,

removableDeviceConnected,
removableDeviceDisconnected

* Network event - TCP/UDP and incoming/outgoing.

o Reports outbound and inbound network connections on all
supported Windows platforms.

¢ Reports [Pv4 and [Pv6 connections.

o Console event (for Windows 8 and later) - User input that is
entered into a console application, such as cmd.exe,
powershell.exe, is captured and reported with the context
console.local.

Commands executed by cmd.exe, powershell.exe as a result
of inter-process communication through anonymous pipes are
captured and reported with the context console.remote.

Introduction to Endpoint Investigation 9
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Scan

Categories
Operating

& Tracking Categories

System
Real-time

events

For example, Get-Item -Path Registry::HKEY LOCAL
MACHINE\SOFTWARE\Microsoft\Windows\

CurrentVersion.
Linux file, autrorun, o Process event - Reports process related activities such as
loaded library, createprocess.
systemd, : e
o File event - Reports any file related activities by an executable,
process, cron, .
. such as writetoexecutable.
initd, and
machine
Mac file, daemon, * Process event - Reports any process related activities, such as
process, task, openprocess, createprocess, Openosprocess,

dylib, autorun,

. openbrowserprocess, allocateremotememory,
and machine

createremotethread.

¢ File event - Reports any file related activities by an executable,
such as writetoexecutable, renameexecutable,
createautorun, deleteexecutable,
selfdeleteexecutable, writetoplist, writetosudoers,

createbrowserextension.
e Network event - TCP/UDP and incoming/outgoing.

¢ Reports outbound and inbound network connections on all
supported Mac operating systems.

¢ Reports [Pv4 and IPv6 connections.

For more information on metadata, meta keys, meta values, and meta entities, see the NetWitness
Investigate User Guide.

You can track Process events on Mac OS 14 after enabling audit control in your machine. For more
information, see Introduction to Endpoint Agent Installation topic in NetWitness Endpoint Agent
Installation Guide for 12.3.1.

Risk Score

Analysts can use the risk score to begin an investigation on hosts and files. NetWitness uses a proprietary
algorithm to calculate the risk scores ranging from 0 to 100. A subset of alerts associated with hosts and
files contribute to the risk score calculation. Analysts can review critical and high alerts associated with a
risk score to identify strong evidence of malicious activity and take required action.

10 Introduction to Endpoint Investigation


https://community.netwitness.com/t5/netwitness-platform-online/introduction-to-endpoint-agent-installation/ta-p/682772

NetWitness Endpoint User Guide

Note: If you have an Insights agent, you can view the risk score for files but not for hosts. To view the
risk score for hosts, upgrade to the Advanced agent. For more information, see the NetWitness
Endpoint Configuration Guide.

The following factors contribute to the risk score:

« Distinct Alerts. Any host or file activities that are suspicious or malicious generate alerts. Only the
distinct alerts are used for risk score calculation.

o Severity of Alerts. Severity of alerts, such as critical, high, and medium.

This figure is an example of a host with 1 Critical, 2 High and 4 Medium distinct alerts.

ALERTS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

SEVERITY "
Medium Alerts @

1 | >

EVENT TIME SUMMARY TARGET PARAM Show details with values only

HOST DETAILS

09/28/2021 suchost.exe present in C:\FilesForAgent\amd64\
09/28/2021 svchost.exe present in C:\FilesForAgent\i386\
09/28/202111:35:03.000 am suchost.exe present in C:\DriverTest\Automation\amd64\
09/28/202111:35:03.000 am svchost.exe present in C:\DriverTest\Automation\i386\
09/28/202111:35:03.000 am suchost.exe present in C:\DriverTest\dtf\bin\amd64\
il
09/28/202111:35:03. svchost.exe present in C:\DriverTest\dtf\bin\i386\
Administrators

09/28/2021 svchost.exe present in C:\DriverTest\Tools\dtf\bin\amd64\

09/28/2021 X svchost.exe present in C:\DriverTest\Tools\dtf\bin\FilesForAge..
e Intel(R) PRO/1000 MT Network Connection

09/28/202111: svchost.exe present in C:\DriverTest\Tools\dtf\bin\FilesForAge..

00:50:56:01:21:9D
09/28/2021 . suchost.exe present in C:\DriverTest\Tools\dtf\bin\i386\

All the distinct alert shown in the above example can be for the same file or different files. For
example, Modifies File Associations alert is triggered for files, such as svchost.exe and
OneDrive.exe.

ALERTS  PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

SEVERITY

1

Medium Alerts @

| &=
| > EmuUrere
| &
| - &

EVENT TIME SUMMARY TARGET PARAM  SOURCE PARAM

2

09/15/202106:25:59.000 pm svchost.exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135016602-1601_Classes\AppXvsddybnas.. N/A svchost.exe -k wsappx-p
09/15/2021 06:25:59.000 pm OneDrive.exe created registry value HKU\S-1-5-21-2671270392-4241876736-3135916602-1001_Classes\odopen\shell\.. N/A OneDrive.exe /background
09/15/202106:25:59.000 pm OneDrive.exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135916602-1001_Classes\odopen\shell.. N/A OneDrive.exe /background
09/15/202106:25:59.000 pm svchost. exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135016602-1001_Classes\AppXknilqcbmSs.. N/A svchost.exe -k wsappx-p
09/15/202106:25:59.000 pm svchost..exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135916602-1001_Classes\AppX77ghgzrbz.. N/A svchost.exe -k wsappx-p
09/15/202106:25:59.000 pm svchost. exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135016602-1001_Classes\AppXjmgntwab.. N/A svchost.exe -k wsappx-p

09/15/202106:25:59.000 pm svchost.exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135916602-1001_Classes\AppXydk58ugnd.. N/A svchost.exe -k wsappx-p

09/15/2021 06:25:59.000 pm svchost.exe modified registry value HKU\S-1-5-21-2671270392-4241876736-3135916602-1001_Classes\AppXvghb9dhb3.. N/A svchost.exe -k wsappx -p

This figure is an example of a file with the Critical alert. The file can have a same alert name being
triggered by two different hosts as shown below.

Introduction to Endpoint Investigation 11
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SEVERITY

1

EVENT TIME

100 LogonUl.ex

ALERTS

SEVERITY

1

All Alerts @

EVENT TIME

Critical Alerts @

microsoft signedyvalid,catalog

SUMMARY

esent in C: \indows\Sy:

120KB

present in C:\Windows\Systen32\

LogonUI.exe

LogonUI.ex:

microsoft,signedvalid,catalog

SUMMARY

120KB

Blacklisted

Blacklisted

TARGET

NA

NA

NA

NA

NA

TARGET

Event Details

B Investigate Timeline
Summary
LogonUI.exe
Overview

FILENAME
LogonULexe

DIRECTORY
N/A

Event Details

B Investigate Timeline

Summary

@ View Alert Details

@ 10k ourLicaTES

| ALiAs.HOST

# Win2012R2Tmplte

Event Me

8> @ 10k urLicATES

@ View Alert Details

10/03/2022 09:30:34.000 pm LogonUI. exe
LogonUI .exe ¥ host| T

Overview — ALIAsHOST

= WIN-TQ4KCTD66K7

10/03/2022 09:56:37.000 am LogonUI.exe

FILENAME
LogonULexe

10/03/2022 09:56:37.000 am LogonUI.exe
DIRECTORY
NA
SIGNED BY
N/A

The risk score is reset when you perform any of the following actions:

» Whitelist or blacklist a file after investigation. The risk score of a file is set to 0 on whitelisting and
set to 100 on blacklisting.

 If the alerts or events triggered by the host or files on the host are false positive, you make changes to

the Endpoint Application rules or ESA rules and reset the risk score.

Besides the above factors, the risk score is reset when a file no longer matches Yara rules in the
subsequent scans

Note: When you whitelist a file or reset the risk score, the alerts that contributed to the risk score are
not shown in the Host Details tab.

The host risk score depends on the risk score of all the files on the host. When you change the file status
or reset the file risk score, the host risk score is recalculated. For example, the score for all the hosts on
which a blacklisted file is present is recalculated and becomes 100. If the host is not found to be infected,
you can reset the host risk score. This deletes the alerts contributed to the risk score and does not impact
the global file score. For more information on changing the file status, see Changing File Status or
Remediate.

Note: For the risk score calculation, the ESA Correlation server must be configured with an Endpoint
Concentrator. The application rules are automatically deployed on installation. For an upgrade, you
must deploy the application rules from RSA Live. For more information, see the NetWitness Endpoint
Configuration Guide.

12 Introduction to Endpoint Investigation
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Note: For the accurate risk score calculation, the default multi-valued meta keys are required on the
ESA Correlation service. For more information, see "Configure Meta Keys as Arrays in ESA
Correlation Rule Values" section in the £ESA Configuration Guide.

Severity of Alerts

The following table depicts the risk score range based on the associated alert severity:

Risk Score

Severity

Range
High Orange 70-99
Medium Yellow 31-69

The following is an example of alerts contributing to the risk score:

SEVERITY High Alerts © Event Details

Event Metadata
# Investigate Timeline ‘ O View Alert Details

a
" 18> | @@ wioe oupLicates
ule Matched (100¢ Summary i

EVENT TIME SUMMARY ipsrus.xml

09/20/2022 03:44:20.000 pm kor-kor .xml -
Overview SESSIONID

09/20/2022 03:44:20.000 ipsrus.xml
& ki FILENAME 36695

09/20/2022 03:44:20.000 pm ipsptb.xml ipsrus.xml = Ol

09/20/2022 03:44:20 pm
09/20/2022 03:44:20.000 pm ipsrom. xml DIRECTORY

) el N/A
09/20/2022 03:44:20.000 pm ipsjpn.xml 41B

SIGNED BY
\VZN

SIZE

09/20/2022 03:44:20.000 pm verisign.bmp -, &P

3
endpointloghybrid1
09/20/2022 03:44:20.000 pm ipshe.xml
FORWARD.IP
09/20/2022 03:44:20.000 pm ipsfin.xml

09/20/2022 03:44:20.000 pm wmpnss_color126. png MEDIUM
- 32
09/20/2022 03:44:20.000 pm ipsar.xml
_ DEVICETYPE
09/20/2022 03:44:20.000 pm ipsplk.xml

& i
D nwendpoint

In the above example, there are three distinct High alerts. For each alert type, associated events are
displayed. The details of the events are displayed with the metadata information. For more information
on severity alerts and metadata information, see Analyze Hosts Using the Risk Score and Analyze Files
Using the Risk Score.

Global and Local Risk Score

Analysts can get better context on file activities on hosts using the global risk score and the local risk
score of a file.

Global Risk Score - The global risk score is an aggregate of all suspicious and malicious activities
performed by the file across all hosts. This score indicates the potential threat posed by the file across the
NetWitness Platform.

Local Risk Score - The local risk score is calculated on suspicious or malicious activities performed by
the file on a specific host. The local risk score is used for the host risk score calculation.

Introduction to Endpoint Investigation 13
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For more information on the global and local risk score, see Investigating Files and Investigating Hosts.

Automated Incident Creation Based on Risk Score

By default, a threshold is set for the risk score to control the generation of incidents and alerts in
NetWitness Respond. For more information on configuring the threshold limit, see the NetWitness
Respond Configuration Guide.

File Reputation

The File Reputation service available on RSA Live checks the reputation of every file hash against an
extensive database of known file hashes updated in real-time. The file reputation is displayed on the
Investigate and Respond views.

The reputations for a file hash are:

Malicious File hash is labeled as malicious.

Suspicious File hash is suspected to be malicious.

Unknown File hash is not known.

Known File hash information is known to the file reputation service and does not have any

previous bad record.
Known Good File hash information is known good, such as files signed by Microsoft or RSA.
Invalid File hash format is invalid.

The suspicious or malicious files are available for further analysis in the Investigate > Navigate view
and Investigate > Events view. For more information on the file reputation service, see the Live Services
Management Guide.

Note: The File Reputation service supports maximum of 10 million files for a reputation of file hash.

File Status

To help analysts triage and focus on their investigation, NetWitness provides capabilities to manage
suspect and legitimate files. For example, you can whitelist files that are legitimate (such as security
products), or blacklist files based on known threats and investigation.

A file can be classified as follows:

o Blacklist: File that is marked suspicious, such as when ransomware is found by scan.

o Graylist: File that is marked for a later review.

14 Introduction to Endpoint Investigation
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o Whitelist: File that is legitimate and is not to be considered for risk scoring.

e Neutral: Default status.

For more information, see Changing File Status or Remediate.

Remediation

If a file is malicious or infected, you can block the file to prevent future execution on any host.
Remediation helps to:

» Stop or reduce the spread of identified malware, such as viruses, trojans, rootkits, worms, spyware,
and adware.

 Identify attempted breach points to aid in deeper analysis; all events are time-stamped allowing
analysts to trace backward to identify the entry point.

* Remove unwanted software, such as adware, which can potentially mask real malware.

* Stop all actions possible by the loader.

You can block files with the following file extension: EXE, COM, SYS, DLL, SCR, OCX, BAT, PS1,
VBS, VBE, and VB. For more information, see Changing File Status or Remediate.

Network Isolation

If you suspect that a host is potentially compromised with the threat still being active, you can isolate the
host from the network and safely investigate possible threats within the host. By isolating the host, you
can control the spread of an attack and analyze the malware behavior. When a host is isolated, the
connection to the following IP addresses are allowed:

¢ Endpoint Server, Relay Server, DNS, DHCP, Gateways, 0.0.0.0, 255.255.255.255, and any other IP
addresses that the agent connects with.

* Other [P addresses that you include in the exclusion list.

In the isolated state, all events are reported to the Endpoint Server retaining full visibility into activities
on the host. You can continue investigation by requesting scans, downloading MFT, files, and so on. The
following metadata is added to the network events:

e network.isolated - indicates that the host is isolated.

¢ network.connectallowed - indicates that the network connection is allowed as the IP address is
included in the exclusion list.

¢ network.connectblocked - indicates that the network connection is blocked.

Note: If the agent is enabled for log or file collection, make sure that you add the Log Decoder IP
addresses in the exclusion list while you isolate the host.

For more information, see Isolating Hosts from Network.

Introduction to Endpoint Investigation 15



Focusing on Endpoint Analysis

This guide provides the information needed to conduct an investigation that is focused on endpoint data
from configured hosts. Analysts who conduct analysis using Investigate need to have the appropriate
system roles and permissions set up for their user accounts. An administrator must configure roles and
permissions as described in Roles and Permissions for Endpoint Analysts. For more information on roles
and permissions, see the System Security and User Management Guide.

To hunt for information on hosts that have the agent running, begin the investigation in the Hosts view
(Hosts). For every host, you can see processes, drivers, DLLs, files (executables), services, anomalies,
and autoruns that are running, and information related to logged-in users. (See Investigating Hosts.)

You can begin the investigation on files in your deployment in the Files view (Files). (See Investigating
Files.)

Note: To access the Hosts and Files views, you must have the endpoint-server.filter.manage
permission.

Analysts use the Hosts and Files views to investigate or perform analysis on hosts or files using
attributes such as IP address, host name, Mac address, risk score, and so on. This figure shows the high-
level capabilities of an endpoint investigation. The top box are all the possible starting points, and the
lower box shows the tasks that you can accomplish from different starting points.

16 Focusing on Endpoint Analysis
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Begin or Continue an Investigation in the Investigate View or Pivot from the Respond View

Browse Event
Metadata

(Navigate View)

Analyze Suspicious
Files
(Files View)

Analyze Raw Events
and Metadata
(Events Analysis

View)

Identify High Risk

User

(Users View)

Analyze Files and

Processes on Hosts

(Hosts View)

Triage an Incident

(Pivot from Respond

View)

Acton a Network, Log, or Endpoint Event, or on a User Behavior

Reconstruct an Event

Investigate Process

Analyze Events

Export Hosts
Attributes and Global
Files

Remediate

Create an Incident in
Respond

Perform Internal
Lookups

Analyze Downloaded
Files

Analyze Downloaded
MFT

Isolate Host from
Network

Analyze Risk Score
for Files and Hosts

Analyze Risky Users

Review Anomalies

Download Process
Dump or System
Dump

Analyze Hosts/Files
with File Acitivity

Perform External
Lookups

Analyze Certificates

Change File Status or
Remediate
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Investigating Files

Note: The information in this topic applies to NetWitness Version 11.3 and later.

The Files view provides a holistic view of all files in your NetWitness platform. You can apply various
filters, sort, and categorize files into different status to reduce the number of files for analysis and
identify suspicious or malicious files.

Best Practices

The following are some best practices and tips that may help you investigate efficiently to identify and
isolate threats or attacks:

Analyze Events
== |Navigate or Event
Analysis View)

Whitelist Files/ ;
Certificates Signed by GRS Download Files for
Known Good Identlfy‘Flle-s for Analyze Files —= Deeper Analysis mm.a Change File Status Remediate
Investigation
Vendors

Perform External

—-

Lookups

o Whitelist all files signed by RSA, Microsoft, and any other known good vendors. Use the filters to list
the files and change the status of all these files to whitelist. For more information, see Filter Files and
Changing File Status or Remediate.

Note: Some Microsoft signed files are restricted from whitelisting as there is a potential risk of
them being used for malicious purposes. To view the list, see Files Restricted from Whitelisting.

* Change the status of certificate and the associated files automatically. For more information, see
Analyze Certificates.

« Filter to exclude whitelisted, files with valid signature, known good files based on reputation status.
For more information, see Filter Files.

* Lookup Google or VirusTotal with the filename or hash to get more information about a suspected
file. For more information, see Launch an External Lookup for a File.

e Analyze the files using one or more of these indicators:

a. Risk score - Displays the risk score for a file. Analysts can view the associated alerts and events
for further investigation. For more information, see Analyze Files Using the Risk Score.

b. On Hosts - Indicates the number of hosts on which a file exist. If a file is present on fewer hosts
with a high risk score, it may require further investigation. You can also sort or filter using On
Hosts column to narrow down the search during investigation. For more information, see Analyze
Hosts with File Activity.
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c. File status - To manage suspected and legitimate files, analysts can use the file status to manage.
For more information on the various file status, see Changing File Status or Remediate.

d. Reputation status - Indicates the reputation of a file hash for analyst to narrow-down the files to
investigate. For more information, see File Reputation.

e. Signature - A valid signature on a file signed by a trusted vendor, such as Microsoft and Apple
indicates that the file is not a risk. If a file is unsigned, it may be malicious, and needs
investigation.

f. File name - Many trojans write random file names when dropping their payloads to prevent an
easy search across the hosts in the network based on the filename. For example, if a file is named
svchOst.exe, scvhost.exe, Or svchosts.exe, it indicates that the legitimate Windows file
named svchost.exe is being mimicked.

» Investigate a particular file name or hash by pivoting to Navigate or Events view to view context, file
activity on different hosts, and any file transfers across the network through packet data. For more
information, see Analyzing Events.

» Investigate files using a rule-based detection technique. YARA helps to identify threats effectively
using easy-to-create malware descriptions called YARA rules. For more information, see Analyze
Files Using YARA.

* Download suspicious files to the server for deeper analysis. For more information, see Analyzing
Downloaded Files.

* Change the status of the file (blacklist or graylist), and block an infected or malicious file. For more
information, see Changing File Status or Remediate.

View Files

You can view all files present on a specific Endpoint server or consolidated list of all files on multiple
Endpoint servers using the Endpoint Broker for analysis. To view files:

1. Go to Files.

2. Select one of the following:
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NETWITNESS v { T Files

Y Filte 8 endpointioghy... ™/ View Certificates & Change File Status [ AnalyzeEvents | v £ More Actions

endpointbroker - Endpoint Broker Server
SEENTIME  ON HOSTS REPUTATION SIGNATURE PE.RESOURCE... FILE STATUS

FILTERS endpointloghybrid1 - Endpoint Server

Select [P——— . oi er  [/2020170.. Known Good microsoftsignedyalid Microsoft Cor... Neutral
e N 06/11/202017:0... Known Good microsoftsignedyalid  Microsoft Cor...  Neutral
Equals o 06/11/202017:0... Known Good microsoft signedyalid  Microsoft Cor...  Neutral
06/11/202017:0... Known Good microsoftsignedyalid  Microsoft Cor...  Neutral
06/11/202017:0... Known Good microsoftsignedyalid  Microsoft Cor...  Neutral
06/11/202017:0... Known Good 6... microsoftsignedyalid  Microsoft Cor...  Neutral
06/11/202017:0... Known Good microsoftsignedyal.. Microsoft Cor... Neutral
06/11/2020 174 Known Good microsoftsignedyal.. Microsoft Cor... Neutral
06/11/202017:0... Known signedyalid VMware,Inc.  Neutral
06/11/202017:0... 2 Known unsigned Neutral
06/11/2020 17:0... Known signed,valid Microsoft Cor...  Neutral

Unknown

Kok 06/11/202017:0... Known . unsigned VMware, Inc. Neutral

Known Good

D|0|/0 O 0|0|D|0|0)|0O

06/11/2020 17:0. Known Good microsoft,signedyal... Microsoft Cor... Neutral

¢ Endpoint Broker Server to view all files across all Endpoint servers.

+ Endpoint Server to view files on a specific Endpoint server.

3. Select the file that you want to analyze.
4. Click a row to view the following details:

NETWITNESS ) I yashboard . ‘ B

 Filters S endpointloghy... “# Change File Status [ Analyze Events $ More Actions v m Contents1.dir

| FILE DETAIL
O FILENAME RISK SCORE FIRSTSEENTIME  ON HOSTS REPUTATION YARASTA.. SIZE SIGNATURE PERESC {3

09/19/202209:55... 2 Known 24KB  unsigned

09/19/202209:55... 2 Known 455KB  unsigned

09/19/202209:55... Known 264KB  unsigned
2203:40:40.201 pm

09/19/2022 09:55. Known 174by... unsigned

09/19/202209:55... Known 68bytes  unsigned

Known 68bytes unsigned

tation  Known
Known NotMatc.. 55KB  unsigned

09/16/2022 12:19. Known Good - 356.6... microsoftsignedvalid  VMware, Incl ener

Name  ContentsL.dir
09/16/2022 12:19. Known Good - 54MB  microsoftsignedvalid  Microsoft Cc
2.2699033271520945

09/16/2022 12:19... Known Good - 574KB  microsoftsignedvalid  Microsoft Cc T
i 8 bytes

Known Good - 1842.. microsoftsignedvalid  VMware, Inc e
09/16/202212:19... Known Good - 5509.. microsoftsignedvalid  Microsoft Cc
09/16/2022 12:19. Known Good ~ 35.9KB  microsoft,signedyvalid Microsoft Cc - unsigned
09/16/202212:19... 2 Known Good - 939KB  microsoftsignedvalid  Microsoft Cc
09/16/202212:19. Known Good NotMatc.. 5761.. microsoftsignedvalid  VMware, Inc S

outof 6173

¢ File Details displays the file information. For more information, see Launch an External Lookup
for a File.

¢ Risk Details displays the distinct alerts associated with the risk score. For more information, see
Analyze Files Using the Risk Score.

¢ Hosts displays the number of hosts on which file activities are present. For more information, see
Analyze Hosts with File Activity.
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Filter Files

You can narrow down the investigation by filtering files using file name, on hosts, file status, risk score,
remediation, reputation status, operating system, size, entropy, format, signature, company name,
checksum (MD5 and SHA256), downloaded status, and YARA rules.

Note: While filtering on a large data set, use at least one indexed field with the Equals operator for
better performance. The following fields are indexed in the database - Filename, MD5, SHA256,
Operating System, First Seen Time, Format, File Status, On Host, and Reputation Status.

—
—
—
—
—

bopno0e

Select the parameters in the Filters tab. Click Save to save the search and provide a name (up to 250
alphanumeric characters). The filter is added to the Saved Filters list. To delete a filter, hover over the

name and click .

Note: Special characters are not allowed in the filter name except underscore ( _ ) and hyphen (-)
while saving the filter.

For example, to filter the files based on file reputation, select the reputation status in the Filter panel.

Note: For the file size, 1 KB is calculated as 1024 bytes. For example, if the actual size of the file is
8421 bytes, the UI will display it as 8.2 KB instead of 8.22 KB. It is recommended to search using the
bytes format when using the Equals operator.

Add and Sort Columns in the Table

By default, the Files view displays a few columns, and files are sorted based on the risk score. To add or
remove columns:
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1. Go to Files.

2. Select the columns by clicking £ in the right-hand corner.

On Hosts

File Status
Remediation
Reputation
Downloaded
signature

First Seen Time

Operating

Signature Timestamp

Signature Thumbprint

igner

3. Scroll down or enter the keyword to search and select the required columns.

4. To sort the column in ascending or descending order, click the arrow on the column header.

Analyze Files Using the Risk Score

Based on the Alert severity, the files can be analyzed using the following options:

e View Alert Details: This option allows you to analyze the files associated with Critical and High

alerts. For more information, see Investigating a Process.

« Analyze Process Tree: This option allows you to analyze the files associated with Medium alerts.

For more information, see Investigating a Process.

To analyze files associated with Critical and High alerts using the risk score:

1. Go to Files.
The Files view is displayed.

2. In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the files.

3. Select the file and do any of the following.

o Click a row to view the risk associated with the file in the Risk Details panel.

o Click the filename to view the associated alerts and events.

22

Investigating Files



NetWitness Endpoint User Guide

The Alerts tab is displayed.

4. In the Alerts > Severity panel, click the alert severity, such as Critical or High.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.

Note: For each alert, only the latest 1000 events are displayed.

6. To view all the details associated with a specific event, click on an event. The Event Details panel is
displayed with the summary and overview information associated with the event.

7. You can also view the Event Metadata such as IP, Filename, File hash, and Category in the Event
Details panel.

Note: The contexthub-server.contextlookup.read permission is enabled only for Administrators,
Analysts, Malware Analysts, SOC Managers and Respond Administrators. Administrators can
enable this permission for other roles in the Files view to view context lookup for meta values and
perform the Add/Remove from List actions. For more information, see the "Role Permissions"
topic in the System Security and User Management Guide.

8. Click the drop-down option besides the metadata value to view additional information about the
specific metadata. The Context Highlights dialog displays a list of the data sources that have context
data available for meta value. These are the possible data sources: NetWitness Endpoint, Incidents,
Alerts, Hosts, Files, and Feeds.
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CONTEXT HIGHLIGHTS

2 2
INCIDENTS ALERTS

REPUTATION

Context Lookup
Pivot to Investigate > Hosts/Files

Add/Remove from List

9. To investigate the original event and destination domain of the event, do any of the following:

o To investigate the events in a specific time frame, click Investigate Timeline on the Event
Details panel. For more information, see the NetWitness Investigate User Guide.

o To investigate a particular process, click View Alert Details on the Event Details panel. For more
information on process analysis, see Investigating a Process.

SEVERITY | ot Alerts @ Event Details

D Investigate Timeline ||| 7 View Alert Details

EVENT TIME SUMMARY
09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm
FILENAME
09/20/2022 03:44:20.000 pm P ipsrus.xml

TIME
O 0912012022 03:44:20 pm

09/20/2022 03:44:20.000 pm ipsrom.xm DIRECTORY
N/A

09/20/202203:44:20.000 pm
SIGNED BY
N/A

09/20/202203:44:20.000 pm

09/20/202203:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

24 Investigating Files



NetWitness Endpoint User Guide

To analyze files associated with Medium alerts using the risk score:

L.

Go to Files.
The Files view is displayed.

In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the files.

Select the file and do any of the following.

o Click a row to view the risk associated with the file in the Risk Details panel.
o Click the filename to view the associated alerts and events.
The Alerts tab is displayed.

In the Alerts > Severity panel, click the Medium alert severity.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

Click an alert to view the associated events.

Note: For each alert, only the latest 1000 events are displayed.

To view all the details associated with a specific event, click on an event. The Event Details panel is
displayed with the summary and overview information associated with the event.

SEVERITY

Medium Alerts @ Event Details

created process net.exe

devents)
TARGET FILENAME
201:55:38 am

TARGET COMMAND LINE
net.exe ACCOUNTS

TARGET DIRECTORY
C:\Windows\system32\

TARGET USER

TARGET HASH
0bd94a338eea5ade1f2830ae326e6d19

You can also view the Event Metadata such as IP, Filename, File hash, and Category in the Event
Details panel.

Click the drop-down option besides the metadata value to view additional information about the
specific metadata. The Context Highlights dialog displays a list of the data sources that have context
data available for meta value. These are the possible data sources: NetWitness Endpoint, Incidents,
Alerts, Hosts, Files, and Feeds.
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CONTEXT HIGHLIGHTS

2 2
INCIDENTS ALERTS

REPUTATION

Context Lookup
Pivot to Investigate > Hosts/Files

Add/Remove from List

9. To investigate the original event and destination domain of the event, do any of the following:

o To investigate the events in a specific time frame, click Investigate Timeline on the Event
Details panel. For more information, see the NetWitness Investigate User Guide.

o To investigate a particular process, click Analyze Process Tree on the Event Details panel. For
more information on process analysis, see Investigating a Process.

ALERTS  PROCESSES  AUTORUNS 3 IBRARIES ) IES OWNLOADS  SYSTEM INFO  HISTORY

SEVERITY o
Medium Alerts @ Event Details

1 ] ycal Account Policy (1events) Event Metadata

b Investigate Timeline & Analyze Process Tree
EVENT TIME SUMMARY =
18> | @@ mwoeoupuicates

09/27/2022 01:52:52.000 am cmd. exe created process net.exe
Q@D F loating Mox
QD Hicden

TARGET FILENAME

) )
QD Tasks In Program irectory (8events) e

TARGET COMMAND LINE
net.exe ACCOUNTS

TARGET DIRECTORY
C:\Windows\system32\

TARGET USER

TARGET HASH
0Obd94a338eea5ade1f2830ae326e6d19

Analyze Hosts with File Activity

To view the list of hosts on which a file exist, do the following:
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Note: By default, the system detects the best data source for the On Hosts aggregation. To change the
data source, in the Explore view, modify the investigate service ID under endpoint/investigate.

1. In the Files tab, click the row for the file you want to analyze.

2. In the right panel, click the Hosts tab. The list of hosts along with the risk score are displayed.

NETWITNESS 8 2espol I Host Files Dashboar

@ ChangeFile Status || (7 AnalyzeEvents | v || # MoreActions -

06/11/202017:05:... 9... i Microsoft Corpo... Neutral
06/11/202017:05:... 2 c 362.7.. Microsoft Corpo...  Neutral
06/11/2020 17:05:.

06/11/202017:05:...

o s

06/11/202017:05:... 2

3. Click the host name to open the host details.

.~ : . : : :
4. Click to analyze events on the host in the Events view. For more information, see Analyzing
Events.

Analyze Files Using YARA

Y ARA helps analysts with rule-based detection capabilities in identifying and classifying malware. You
can easily create malware descriptions using YARA rules. YARA scans can be performed at the
Endpoint server level and Endpoint agent level.

Analyze Files at the Endpoint Server Level

Administrators must enable and configure YARA on the Endpoint server. To learn more about enabling
and configuring YARA, refer to NetWitness Endpoint Configuration Guide.

Files must be downloaded to the Endpoint server and YARA scans the downloaded files automatically.
The scan results are displayed under YARA STATUS on the Files tab.

To analyze the scanned files,
1. Go to Files.
2. Select the Endpoint server from the server drop-down , to view files.
3. Select a file that is downloaded to the Endpoint server and do any of the following:
¢ Click a row to view the YARA scan details associated with the file in the File Details panel.

e If any file matches one or more YARA rules, the File Details panel displays the matching rule
names besides scan time.

* YARA STATUS field displays the status of the YARA scan. Following are the available statuses
and their definitions
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¢ Matched - The file matches with one or more YARA rules
¢ Not Matched - The file does not match with any of the YARA rules

¢ Not Yet Scanned - There is no scan performed for this file. Files will be scanned automatically
once they have been downloaded. After the scan YARA status will be updated to either
Matched or Not Matched

Note: When a file matches with a YARA rule, high severity alerts are triggered and, the file's
risk score is updated. In the subsequent scans, If the same file doesn't match with a YARA rule,
the risk score will be reset.

Note: If a downloaded file has an error, it will not be scanned by YARA and, the
Downloaded column will display the file download status as Error.

NETWITNESS estig € losts Files

VFilters | | Sendpointbrok... # ChangeFile Status | | (7 Analyze Events # More Actions \/

O FILENAME RISKSCORE ¢ FIRSTSEENTIME  ON HOSTS REPUTATION size YARASTA.. SIGNATURE PERESOUI
09/08/202204:47... O Known 2706.. NotMatc.. unsigned
08/26/202211:22.. 0 Known 45.9 NotMatc... unsigned
08/26/2022 11:22. ) Known Not Matc...  unsigned
9 Known NotMatc... unsigned 072112022 081105658 pm
Known NotMatc... unsigned
09/08/2022 04:47. Known 2 Matches Founc unsigned
08/26/202201:36... Known 0... unsigned VMware, Inc.
09/08/202204:47. Known NotMatc... unsigned
09/08/2022 04:47. Known NotMatc... unsigned
09/08/202204:47... Known 28.. NotMatc.. unsigned Known
Known NotMatc... unsigned
Unknown NotMatc... unsigned

VGAuthService.exe

Known NotMatc... unsigned 6.0834079603718125
Known NotMatc... unsigned 160.0KB

pe

out of 654 files

4. On the Filters pane, scroll to the YARA RULES section. This section provides options to filter the
files based on YARA scan status:

¢ Select Matched to view the files that match YARA rules.

* You can also view the files that do not match YARA rules or not yet scanned against YARA
rules, by selecting Not Matched or Not Yet Scanned from the YARA RULES section.
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NETWITNESS

Sendpointbrok... ™ View Certificates

O  FILENAME RISK SCORE
o
o

a]

Equals

FILE HASH

Equals

Save as...

FIRST SEEN TIME

08/26/202201:36...

09/08/2022 04:47...

09/08/202204:47...

08/26/2022 04:24.

08/26/202:

ON HOSTS

3

08/26/202204:24... 3

09/08/2022 04:47.

09/08/202204:47...

09/08/202202:15...

REPUTATION

Known Good

Known

Known

Known

Known Good

Known

Known

Known

Known Good

Known

Known

Unknown

Known Good

les | O'selected

# More Actions \/

SIZE YARA STA...
69.5KB

2440...

1825...

29.0KB

695KB

1045...

3800

5680...

SIGNATURE

microsoft,signedyalid.

unsigned

unsigned

unsigned

microsoft signedyalid...

unsigned

unsigned

unsigned

microsoft signedyalid...

unsigned

unsigned

unsigned

microsoft,signedyalid.

For more information on investigating with YARA, see NetWitness Investigate User Guide.

Yara Scan at the Endpoint Agent Level

PERESOUI 12

Microsoft Corp,

Apache Softwa

Microsoft Corp}

Free Software F{

Microsoft Corp)

VMware, Inc.

Microsoft Corp,

NetWitness Platform allows you to quickly perform YARA scan at the Endpoint Agent level. A snapshot
of the YARA scan shall be available on the Endpoint server with the details such as:

o List of files matching the YARA rules.

o List of YARA rules ran during the scan and the YARA rules status such as Loaded or Failed to load.

Note: To perform Yara scan at the Endpoint agent level, the agent version must be higher than or
equal to 12.1. This is applicable for the Advanced mode Windows Agents.

e YARA version associated with the agent.

To initiate YARA scan on the Endpoint Agent,
1. Click Hosts.

2. Select the Endpoint server from the server drop-down, to view hosts.

3. Select one or multiple hosts and click Scan > Start Yara Scan.

Investigating Files
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NETWITNESS te Respond Users Hosts |  Files

Y Filters X Sendpointloghy... v > # More Actions

AN O HOSTNAME RISK SCORE ! 05 - DESCRIPTION LAST SCAN TIME AGENT SCANSTATUS  AGENT LAST SEEN

Select o 2 d:

u] - Microsoft Windows 8.1 Enterpri... 08/29/2022 12:35:08 pm 11daysago
HOST STATUS
O Managed o Microsoft Windows 7 Enterprise  09/08/2022 12:35:55 pm 2days ago

u] Microsoft Windows 7 Enterprise  08/30/2022 06:50:51 pm aminute ago
Microsoft Windows 8 Enterpris...  08/25/202201:01:01am aminute ago
Microsoft Windows 8.1 Enterpri... 08/30/202206:44:59 pm

Microsoft Windows 11 Home 08/26/2022 11:57:44 am

Microsoft Windows 8.1 Enterpri... 08/24/2022 1 am  Idie aminute ago
mac0s 1168 08/29/202208:04:42pm  Scanning 15daysago &

HOSTNAME Microsoft Windows 10 Education ~ — le 12 daysago

Equals Microsoft Windows 10 Education 08/11/2022 11:17:18 am 19daysago &

4. On Start Yara Scan pop-up,

Click and upload the YARA rule zip file.
Select System Drive (Default selection) or All Fixed Drives.

c. Enter the Max File Size in Kilo Bites (KB).
d. Select CPU Maximum.

Start Yara Scan
Performs a scan on the selected hosts against the YARA rules; Upload the
YARA rule files in zip format.

(only advanced managed Windows hosts with agent version 12.0 or higher
will qualify)

Cancel

5. Click Start scan. See the command status In the Host > History tab.

To analyze the scanned hosts and files:

1. Log in to the NetWitness Platform.

2. Click Hosts.
3. Select the Endpoint server from the server drop-down to view hosts.

4. Select the Host and YARA Snapshot Time, and do any of the following:

o In the Host details view, click Files and select a row to view the YARA scan details associated
with the file in the Details panel.
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If any file matches with one or more YARA rules, the Details panel displays the matching rule
names besides scan time.

AUTORUNS  FILES ~ DRIVERS  LIBRARIES ~ ANOMALIES JOWNLOADS ~ SYSTEM INFO  HISTORY YARA RULES

Y Filters Files @& Change File Status 4 Analyze Events $ More Actions

@ AL FILES AVAILABLE ON HOST

FILE DETAILS
O FILENAME LOCALRISK SCORE  GLOBAL RISK SCORE  ON HOSTS FILE STATUS REPUTATION  DOWNLC 3}

100 Neutral Known

100 Neutral Known

100 Neutral Unknown

100 Neutral Unknown 09/21/2022 04:08:07.218 am
100 Neutral Known
100 Neutral Unknown
100 Neutral Unknown 09:52:44.130am
100 Neutral Unknown
G —— — domainyar:domain
100 Neutral Known
100 Neutral Known Wi

100 Neutral Known

03 out of 1803 files | 1 selected N 5-1-5-18.recovery

® Toggle the All Files Available on Host to view all the files irrespective of the snapshot
selected.

Note: When a file matches with a YARA rule, high severity alerts are triggered and the file's
risk score is updated.

NETWITNESS Respon ! Hosts | il ) eport

UKHAYDENMO... & 3
100 14 days ago 12310 07/26/2022 02:46:55 pm (Yara Scan)

ALERTS  PROCESSES  AUTORUNS FILES JRIVERS  LIBRARIES ~ ANOMALIES )OWNLOADS SYSTEM INFO  HISTORY  YARA RULES

Y Filters X Files

@ ) ALLFILES AVAILABLE ON HOST

FILE NAME O  FILENAME LOCAL RISK SCORE  GLOBAL RISK SCORE  ON HOSTS. FILE STATUS REPUTATION DOWNL {5}

Equals o 2 Neutral Known

u] 2 Neutral Known

u} 2 Neutral Known

u] Neutral Known

Neutral Known

Neutral Known

Neutral Known

Neutral Unknown

Neutral Known

o On the Filters pane, scroll to the YARA Rules section. This section provides options to filter the
files based on YARA scan status: Select Matched to view the files that match YARA rules.

® You can also view the files that do not match YARA rules or not yet scanned against YARA
rules, by selecting Not Matched or Not Yet Scanned from the YARA rules section.
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NETWITNESS vestig kesponc L Hosts Fil Jashboarc ports

1000 UKHAYDENMO... & i AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION R—
windows Idle 14 days ago 12310 07/26/2022 02:46:55 pm (Yara Scan)

ALERTS PROCESSES AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES NLOADS ~ SYSTEM INFO  HISTORY YARA RULES

Y Filters X Files @ ) ALLFILES AVAILABLE ON HOST

FILENAME LOCAL RISK SCORE  GLOBAL RISK SCORE ~ ON HOSTS FILE STATUS REPUTATION  DOWNL

2 Neutral Known

2 Neutral Known

3 Neutral Known

Neutral Known

Neutral Known

Neutral Unknown

Neutral Known

Neutral Known

Neutral Known

Neutral [

Neutral Known

¢ In the Host details view, click the YARA Rules tab to know if the YARA rules used for the scan
are successfully loaded or failed to load. If any of the YARA rules are failed to load, hover over

icon (Failed to load) to know the reason for failure.

ALERTS PR S AUTORUNS FILES DRI S ES N Vi SYSTEM INFO HISTORY YARA RULES
YARA RULE STATUS
yara-rule\open-source\maldocs\Maldoc_UserFormyar V/  Loaded
yara-rule\open-source\maldocs\Maldoc_VBA_macro_codeyar Loaded
yara-rule\open-source\maldocs\Maldoc_Word_2007_XML _Flat_OPC.yar Loaded
yara-rule\open-source\utils\base64yar Loaded
yara-rule\open-source\utils\domainyar Loaded
yara-rule\open-source\utils\ipyar Loaded
yara-rule\open-source\utils\magicyar Loaded
yara-rulé\open-source\utils\suspicious_stringsyar Loaded

Loaded

yara-rule\open-sourcelutils\urlyar

L L L L LKL KLKL KL

yara-rule\open-source\utils\virustotalyar Loaded
yara-rule/open-source/exploit_kits/EK Zeusyar Failed to load
yara-rule/open-source/deprecated/Android_AliPay_smsStealeryar

yara-rule/open-source/deprecated/Android_Amtrckr_20160519yar

yara-rule/open-source/deprecated/Android_ASSDdeveloperyar Fa oad

yara-rule/open-source/deprecated/Android_AVITOMMSyar Failed toload

o In the Host details view, click the History tab to view the command history.

Analyze Files Using OPSWAT

OPSWAT (MetaDefender Core) provides advanced malware detection capabilities by scanning files with
multiple anti-malware engines simultaneously. Administrators need to enable and configure OPSWAT
on the Endpoint server. To learn more about enabling and configuring OPSWAT, see NetWitness
Endpoint Configuration Guide.

All downloaded files (executable) will automatically be sent to OPSWAT server for scanning once
OPSWAT is enabled and configured on the endpoint servers.
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NETWITNESS n osls d Reporls

</ Filters & endpointloghy... View Certificates ‘ ‘ & Change File Status ‘ l 4 Analyze Events | v £ More Actions

O  Fename RISK SCORE ON HOSTS ¥  SIZE DOWNLOADED  FIRST SEEN TIME OPSWAT STATUS YARA STATUS

& Ninite Chrome FileZilla Installere... (3) 2 4153KB v 05/10/202108:18:03am -

o ) 16.7 KB 05/10/202110:47:29am ~ NoThreat Detected = — e
- ils with values only

4413KB 05/10/202110:30:10am | /\ =
240KB 05/10/2021 10:08:00 am - Scan i 05/10/202111:50:05.542 am

6384KB 05/10/202110:05:21am | /\
Infected (eset)
1367 KB 05/10/202110:05:21am | NoThreat Detected e

Infected (bitdefender)

87.3KB 05/10/202110:05:21 am EICAR Test File

349.0KB 05/10/2021 10:05:21 am - Infected (k7)
Trojan (000139291)

56MB - 05/10/202110:05:21am = — - Infected (clamav)
EICAR Test_File
26MB 05/10/202110:05:21am = No Threat Detected

3637KB - 05/10/202110:05:21am | —

3520KB 05/10/2021 10:05:21 am _ FileName  Ninite Chrome FileZilla Installer.exe

8820K8B 05/10/202110:05:21am  NoThreat Detected S780855045972551
2 4153KB
5575KB 05/10/2021 10:05:21 am
=
37.9KB 05/10/2021 10:05:21 am No Threat Detected

45.9KB 05/10/202110:05:21am  NoThreat Detected = —
Showing 100 out of 130files | 1 selected eatures  signedyalid

Scan files with OPSWAT

Downloaded files are automatically sent to the OPSWAT server for scanning. However, you can also
initiate the scan manually using options under theMore Actions menu. Executable files with the
following file extensions, pe, script, macro, and elf are supported by this feature. The maximum file size
limit is set to 10MB by default. You can increase or decrease it if required.

Automatic scan:

The endpoint server will automatically send all (executable) downloaded files to the OPSWAT server.
The scan results will be displayed under theOPSWAT STATUS column on theFiles tab.

Manual Scan:

You can also manually initiate an OPSWAT scan using the options under theMore Actions menu on the
Files tab.

The More Actions menu provides the following options:

Manual Scan - Scan selected files

1. Select the files that need to be sent to the OPSWAT server for scanning.

2. Select More Actions > Scan with OPSWAT.
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NETWITNESS

¥ Filters X SEndpointloghy... & Change File Status # More Actions ™

Google Lookup
O  Fename RISK SCORE ON HOSTS v osize DOWNLOADED

VirusTotal Lookup
Select 100 8 56MB

5 Noj
= Save aLocal Copy
Equals No

N
Scan with OPSWAT

No:
Reset Risk Score

No Threat Detected Not Matc.

Not Matc.

3. Click Scan on the confirmation pop-up.

Scan with OPSWAT

Selected files that are downloaded to the server will be scanned.

Manual Scan - Scan all files
1. Select More Actions > Scan All with OPSWAT.

NETWITNESS vestig Files

Y Filters S Endpointloghy... > || View Certificates % More Actions
Scan All with OPSWAT
S FiLE NAME RIsK sCORE ONWOSTS ¢ SIZE  DOWNLOADED OB |
Select 8 56MB

e 2370. No Threat Detected

Equals 61.0KB No Threat Detected  Not Matc.

o 90.0KB No Threat Detected  Not Matc.

O Neutral 680KB No Threat Detected ~ Not Matc...

330KB No Threat Detected  Not Matc...

2. Click Scan on the confirmation pop-up.
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Scan All with OPSWAT X

Files matching the filter criteria and downloaded to this endpoint server will
be included in the scan. Select endpoint broker to include files downloaded to
other endpoint servers.

Note: Time needed to scan will depend on the number of files that need to be
scanned.

o [

View OPSWAT Scan Results

The scan results will be displayed under theOPSWAT STATUS column on theFiles tab as follows:
- - File is infected

- - Suspicious file

- Scan failed; see troubleshooting section for more information.

L DUTER R EERE)| The file is clean as of the last scanned time.

- - Not yet scanned.
Click on a file to view scan results under theFILE DETAILS panel.

e Scan Time: States the last scanned time.

» Scan details: States whether a file is infected or suspicious or no threat detected, names of anti-
malware engines that identified the threat.
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NETWITNESS vestigate Respond ers Host: Files Dashboard Reports

7 Filters & Endpointlog! v View Certificates & Change File Status 4 Analyze Events | v 2 More Actions

O  Fiename RISK SCORE ONHOSTS ¥ SIZE DOWNLOADED  OPSWAT STATUS YARA STATUS REMEDIATION
8 5.6MB - -

5 237.0KB No Threat Detected - - Show details with values only

4 610KB Not Matched

Time  06/09/202112:02:58473pm

90.0KB No Threat Detected Not Matched

680KB No Threat Detected Not Matched

Suspicious (eset)

Eicar test file

330KB No Threat Detected Not Matched

Suspicious (ahnlab)
EICAR Test_File
Suspicious (bitdefender)
EICAR Test_File
Suspicious (clamav)
EICAR Test_File

174KB Not Matched

4725KB No Threat Detected Not Matched

208KB No Threat Detected Not Matched

111.3KB Not Matched

525KB Not Matched = ScanTime ~ 06/09/202107:24:26.808 am

1105KB No Threat Detected

(SESESE SR SRS S S SR SR SRS

372KB

490KB

14MB

Alerts and Impact on Risk scores

Alerts: Critical alerts will be triggered when OPSWAT finds a file as infected, and High severity alerts
when a file is found suspicious.

Risk score: If a file is found infected or suspicious by OPSWAT, the risk score of that file and the
corresponding host will be increased.

NETWITNESS Investigate Responc sere 0sts Files yashboard Report:

< Filters & Endpointloghy... View Certificates "% Change File Status [ Analyze Events | v $ More Actions v/ csrss.exe

FILE DETAILS RISK DETAILS
O  Fie NAME RISK SCORE ONHOSTS ¥ SIZE DOWNLOADED  OPSWAT STATUS YARA STATUS REMEDIATION REPUTA

LERTS SEVERITY
8 56MB - -

5 2370KB No Threat Detected = - 2

610KB Not Matched = = Gy
900KB No Threat Detected Not Matched
680KB No Threat Detected Not Matched
330KB NoThreat Detected Not Matched
B osee 17.4KB Not Matched
4725K8 No Threat Detected Not Matched
208KB No Threat Detected Not Matched
1113KB Not Matched
525KB Not Matched

1105KB No Threat Detected

4
v
4
4
v
4
4
v
v
4
4
v

372KB

49.0KB

Launch an External Lookup for a File

While analyzing a file, you can search Google or VirusTotal with the filename or hash to get more
information about the file. To launch the search:
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1. Go to Files.
2. View the details of the file name and hash from the table MD5, SHA1, and SHA256 columns, or
view the details in the File Details tab on the right panel.

3. Select one or more files, and right-click or in the More Actions drop-down list in the toolbar, do the
following:

NETWITNESS vestig ONC yashboard Report

Y Filters : S EPS1- Endpoi... v & ChangeFileStatus | | (£ AnalyzeEvents | v || § MoreActions

e FILE NAME U FIRSTSEENTIME  ONHOSTS REPUTATION size SIGNATURE PE.RESOURCES..

Select 09/15/202105:58... 3 5 . microsoft;signedyalid... Microsoft Corp..

Change File Status 10/29/2021 02:52.. . unsigned

Equals Analyze Events 09/27/202111:39. - unsigned

Google Lookup File Name - microsoftsignedyalid  Microsoft Corp...

VirusTotal Lookup microsoft,signedyalid... Microsoft Corp...

. signedyalid

57...  signed,invalid

Save a Local Copy
10/29/202105: - crosoft signedyalid... Microsoft Corp...

Analyze File

Scan with OPSWAT 10/29/202 - microsoft.signedyalid...  Microsoft Corp...

Reset Risk Score 10/25/202109:48... - 8... signedyalid

10/25/202109:48.. signedyalid
09/23/202107:28.. 86MB  unsigned

09/23/202107:28... - unsigned
O Invalid

u] ) 09/23/202 unsigned

L=< Shov cted

a. Select Google Lookup and perform a search on the filename, MD5, SHA1, or SHA256.
b. Select VirusTotal Lookup and perform a search on MD5, SHAT1, or SHA256.

Note: To open files in multiple tabs, make sure you enable the pops-up in the browser.

Set Files Preference

By default, the Files view displays a few columns and the files are sorted based on the risk score. If you
want to view specific columns and sort data on a specific field:

1. Go to Files.
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2. Select the columns by clicking E=3 in the right-hand corner. The following example shows the drop-
down list displayed while adding columns:

Remediation

Reputation

Operating

SignatureTimes

3. Sort the data on the required column.

Note: The selections you make here become your default view every time you log in to the Files view.

Export Global Files

To extract the list of global files to a comma-separated values (csv) file:

Note: While filtering on a large data set, use at least one indexed field with the Equals operator for
better performance. You can export up to 100k files at a time.

1. Go to Files.

2. Filter the files by selecting the required filter option.

3. Add columns by clicking =3 in the right-hand corner.
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4. Click to export the files to a csv file.

NETWITNESS

Y Filters S endpointloghy... /|| View Certificates ‘& Change File Status || (7 Analyze Events | v || # MoreActions \/

FILE NAME RISKSCORE ~ © FIRSTSEENTIME  ONHOSTS REPUTATION size SIGNATURE PERESOURCES... FILE STATUS
06/11/2020 17:05:... Known Good 95MB  microsoftsignedyalid  Microsoft Corpo... Neutral
06/11/2020 17:05:... Known Good 1439..  microsoftsignedyalid  Microsoft Corpo... Neutral

Equals ) 06/11/2020 17:05: Known Good 362.7 mi ft.signed,valid Microsoft Corpo...  Neutral
06/11/2020 1 2 Known Good 6590..  microsoftsignedyalid  Microsoft Corpo... Neutral
06/11/2020 1. 2 Known Good 567KB  microsoftsignedyalid  Microsoft Corpo... Neutral

06/11/2020 17:05-.. Known Good 8026.. microsoftsignedyalid  Microsoft Corpo... Neutral

06/11/202017:05:.. 2 Known Good 135 KB __ microsoft.signedyalid...  Microsoft Corpo... Neutral

You can either save or open the CSV file.

Analyze Certificates

Note: The information in this topic applies to NetWitness Version 11.3 and later.

The Certificates view provides a list of code-signing certificates reported by hosts found in your
deployment and their associated properties. You can select the certificates under a specific Endpoint
server.

To view the certificates in an Endpoint server:
1. Go to Files.

2. From the drop-down menu, select the Endpoint server to view certificates present on that server. To
view a consolidated list of certificates, select the Endpoint Broker server.

3. Select a file and do one of the following:

NETWITNESS 8 Files

Y Filters X B EPS1-Endpoi.. v || ViewCertificates & ChangeFile Status || (7 Analyze Events | v || $ More Actions v/

0 FILENAME RISKSCORE ¢ FIRSTSEENTIME  ONHOSTS REPUTATION SIGNATURE PERESOURCES... 1 {0

09/15/202105:58... 3 = 0...  microsoftsignedyalid... Microsoft Corp...
Change File Status

I Anclyze Events 10729/20210252... 4 - . unsiged
Equals | Google Lookup ), 09/27/202111:39... 1 - unsigned
| VirusTotal Lookup 11/08/202110:32... - microsoftsignedyalid  Microsoft Corp...

View Certificates
11/05/202105:54... - microsoft signedyalid... Microsoft Corp...

Download File to Server
{ 11/02/202103:48... - 8...  signedyalid
11/02/202101:59... - .. signedjnvalid
10/29/202105:4... - microsoftsignedyalid... Microsoft Corp...
| i 10/29/20210131... - microsoftsignedyalid... Microsoft Corp...
Reset Risk Score
10/25/202109:48... - 8...  signedyalid
10/25/202109:48... signedyalid

09/23/202107:28... unsigned

0 09/23/202107:28... unsigned

8] n 09/23/2021 unsigned

St 2 es| 1selected
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o Right-click and select View Certificates from the context menu.

¢ Click View Certificates in the toolbar.

Change the Certificate Status

You can assign a Whitelist status to the certificate signed by certain trusted vendors and this status can
be automatically applied to all files that is signed by this certificate. If you consider abc a trusted vendor,
you can set the status for the certificates signed by abc as Whitelist.

Similarly, you can also set the certificate status as Blacklist or Neutral. If a company's certificate is
stolen or compromised, you can blacklist this certificate and remediate.

To change the certificate status:

1. Select a certificate, and click Change Certificate Status.

Change Certificate Status

CERTIFICATE 5TATUS

= applied to all files
O Blacklist
O Whitelist
O Neutral

COMMENTS

Enter comments

Cancel

2. In the Change Certificate Status dialog, select a status - Blacklist, Whitelist, or Neutral.

Note: If you have manually updated a file status in the Files or Hosts view, changing the status in
the Certificate view does not impact the file status as the manual update takes precedence. For
example, if you have whitelisted the file vmci.sys that is signed by VMware, Inc. in the Files or
Hosts view, and you have blacklisted VMware, Inc. in the Certificate view, the file vmci.sys
remains Whitelisted though the certificate is blacklisted.

3. Add a comment and click Save.

4. Click < Files to go to the Files view.

Note: In a multi-server environment, changing the status of a certificate in one endpoint server updates
the respective files in other endpoint servers. For example, if a certificate status is set to Blacklist on
one endpoint server, all files signed by this certificate are set to Blacklisted on all endpoint servers.
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Filter Certificates

You can filter certificates on status, signature, friendly name, and thumb print.

Y Filters X Certificates | % Change Certificate Status f Analyze Events -

SAVED FILTERS FRIENDLY NAME STATUS ISSUER THUMB PRINT NOT VALID BEFORE UTCDA1 {5}

Select Microsoft Windows Pu...  Neutral C=US, 5=Washington, L=Redmond, .. 99922da31f07a02edb07cd8bs0a..  2018-06-06T18:57:34.000+0000

99922da31f07a02edb07cd8b60a137f14«

Showing 1 out of 1 certificates | 1 selected

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters list. To delete a filter, hover over the name, and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

Manage Blocked File Hashes

Blocked File Hashes view Files > Manage > Blocked File Hashes allows administrators and analysts
to perform the following actions.

o View already blocked File Hashes in the deployment.

e Add new File Hash and block it.

o Delete and unblock the Blocked File Hashes.

o Import and block multiple File Hashes using the CSV file.

You can block up to a maximum of 50,000 file hashes.

IMPORTANT:

- Enter only valid SHA256 hashes; otherwise, the blocking functionality might break.

- Do not block any file hashes signed by RSA, Microsoft, and Apple. It might make your Endpoints
unresponsive.

- If the number of already blocked File Hashes is 0, and you import more than 50K File Hashes, only
the first S0K File Hashes are blocked.
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Note: Analysts must have the contexthub-server.datasource.read permission to access the Blocked
File Hashes view.

Toolbar Actions

The table below lists the toolbar actions available in the Blocked File Hashes view.

Description

B EIirT, Sclect this option to block a single File Hash.

- Select this option to delete the blocked File Hashes.

Select this option to import and block multiple File Hashes.

Select this option to return to the Files view.

View Blocked File Hashes

You can view the File Hashes already blocked as part of NetWitness deployment in the Blocked File
Hashes view.

To view the Blocked File Hashes:

1. Go to Files > Manage > Blocked File Hashes.
The Blocked File Hashes view is displayed.

NETWITNESS ves ale c o 5 Files Dashl
Y Filters . 'Hashcs ~ + AddHash | | @ Delete 2 Import | @

FILE HASH SOURCE ADDED BY COMMENTS FILE STATUS
ccabe63588d52a633bb6ca01c69c693534651e7cd 14dd533bcS00...  Import admin 05/30/202: .. demo Blacklist
. Import admin 9... demo Blacklist
admin f 9 demo Blacklist
admin ... demo Blacklist
ccabes: 3bb6cad1c69c6! 51e d . Import admin 307:09... demo Blacklist
ccabe63588d52a633bb6ca01c69c6935: 3 0 Import admin 0 9.. demo Blacklist

ccabe63588d52a633bb6ca01c69c693534651e7cd14dd533bc S00. Import admin V: J demo Blacklist

7cd14dd533bc500...  Import admin .. demo Blacklist

Import admin 0 07:09... demo Blacklist

. Import admin 0 07:09... demo Blacklist
. Import admin .. demo Blacklist
. Import admin 7:09... demo Blacklist
. Import admin 0 07:09... demo Blacklist
admin 3 .. demo Blacklist

Import admin 7:09... demo Blacklist
Import admin 05/ 09-. demo Blacklist

Import admin 307:09-.. demo Blacklist

Showing 22563 of 22563 blocked file hashes

2. View the list of Blocked File Hashes in the File Hash column.
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Add File Hash

You can add a new File Hash to the list of blocked hashes using the Add Hash option in the Blocked
File Hashes view.

To block a new File Hash:
1. Go to Files > Manage > Blocked File Hashes > Add Hash.
The Add File Hash dialog is displayed.

Add File Hash

Black hash Instr

e, [t maght make your

owing file types with the wi host running in

2. Enter the File Hash.
3. Specify the reason for blocking the new File Hash in the Comment section.

4. Click Block Hash.

Import File Hashes

You can import and block the File Hashes in bulk using the Import option in the Blocked File Hashes
view.

To import the File Hashes:

1. Go to Files > Manage > Blocked File Hashes > Import.
The Import File Hashes dialog is displayed.
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Import File Hashes

owing file types with the windo heest running ir

b, v, weh, el cmd

Click amywhere in the block or drag and upload the C5W file here

2. Under Import File Hashes using .csv file, do one of the following.

¢ Click the block to upload the CSV file.
o Drag and upload the CSV file in the block.

3. Specify the reason for blocking the File Hashes in the Comment section.
4. Click Import.

Note: Only the unique file hashes are imported during the Import process. If you import the .csv file
with few existing blocked file hashes, the Blocked File Hashes List view is updated to reflect the

corresponding changes. The duplicate file hashes are not accounted for the change in the total count of
blocked file hashes.

Note: While updating the CSV file, make sure you enter each file hash value in separate rows under a
single column and then upload the CSV file to block the file hashes. Refer the following figure.
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ccabe63588d5aa633bb6cal01c69c693534651e7cd14dd533bec5008f9a80f2116
ccabe63588d5aa633bbbca01c69c693534651e7cd14dd533bc5008f9a80f2117
ccabeb3588d5aa633bbbcallc69cb693534651e7cd14dd533bc5008f9a80f2118
ccabeb3588d5aab33bbbcallc69c693534651e7cd14dd533bc5008f9a80f2116
ccabeb3588d5aa633bb6callc69c693534651e7cd14dd533bc5008f9a80f2117
ccabeb3588d5aa633bbbcallc69¢b693534651e7cd14dd533bc5008f9a80f2118
ccabeb3588d5aa633bb6cal1c69c693534651e7cd14dd533bc5008f9a80f2119
ccabeb3588d5aa633bbbcallc69c693534651e7cd14dd533bc5008f9a80f2120
ccabeb3588d5aab33bbbcallc69c693534651e7cd14dd533bc5008f9a80f2121

ccabeb3588d5aab33bbbcal1c69c693534651e7cd14dd533bc5008f9a80f2122

Note: Analysts must have the contexthub-server.datasource.manage permission to import the file
hashes.

Delete File Hash

You can delete and unblock a blocked File Hash using the Delete option in the Blocked File Hashes

view.

To delete a blocked File Hash:
1. Go to Files > Manage > Blocked File Hashes.

The Blocked File Hashes view is displayed.

NETWITNESS

Y Filters . iles B . + AddHash

O ccabe63588d522633bb6ca01c69¢693534651¢7cd14dd533bc500.

2. Select the blocked File Hash and click Delete.
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The Delete Hash confirmation dialog is displayed.
3. Click Delete.

Blocked File Hashes List View

The Blocked File Hashes List view consists of a Filters panel and the Blocked File Hashes List.

Blocked File Hashes List

The Blocked File Hashes List displays all the Blocked File Hashes in the NetWitness Platform.
The following table describes the columns in the Blocked File Hashes List.

. Allows you to select the required Blocked File Hash.

File Hash Displays the list of Blocked File Hashes
Source Displays the Source used for blocking the File Hashes.

For Example: Import

Note: When you upgrade to 12.3 or later versions from the versions older than 12.0,
the Source column displays Investigate for all the File Hashes blocked in the
previous deployment using the Import option. The Source column displays Import
only for the File Hashes you block using the Import option in NetWitness Platform
12.3 or later versions. If you upgrade to 12.3 or later versions from 12.0 or later
versions, the Source column displays Import for the File Hashes blocked in the
previous deployment and the current deployment using the Import option.

Added By Displays the name of the administrator or the analyst who blocked the File Hashes.
Added Date  Displays the date on which the File Hashes are blocked.
For Example: 03/20/2023 10:00:00AM

Comment Displays the comment provided by the administrator or the analyst while blocking the
File Hashes.

File Status Displays the file status of the Blocked File Hashes.
For Example: Blacklisted.

Filter Blocked File Hashes

You can filter the Blocked File Hashes based on the following parameters.
e Value of the File Hash

o Source used for blocking the File Hashes
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o File status of the Blocked File Hashes
e User who blocked the File Hashes

Click Reset to remove the filters applied.

Resetting Risk Score of Files

You can reset the risk score for a file in these situations:

 If the alerts or events triggered by the host or a file are considered to be false positive, you can make
required changes to the Endpoint Application rules or ESA rules.

e After you take required action on a malicious file.

When you reset the risk score, the risk calculation for the file is deleted and score is set to 0. The risk
score on all the hosts on which this file exists is recalculated. You can reset the risk score for a single file
or multiple files.

To reset the risk score of a file:
1. Go to Files.

2. Select the Endpoint Server or Endpoint Broker.

3. Select one or more files and do one of the following:
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NETWITNESS nvestig ser S Files  Dashb

¥ Filters X ©EPS1-Endpoi.. v || View Certificates  ChangeFile Status | | (Analyze Events |~ || § More Actions v/

O  Fiename RISKSCORE ¢ FIRSTSEENTIME  ONHOSTS REPUTATION size SIGNATURE PE.RESOURCES...

09/15/202105:58. 5360.. microsoftsignedyalid.. Microsoft Corp..
Change File Status

e A Analyze Events 10/29/202102:52... - 35...  unsigned
Equals Google Lookup > 09/27/202111:3 = unsigned =

VirusTotal Lookup 11/08/2021 - microsoftsignedvalid  Microsoft Corp...

’ View Certificates
O Neutral 11/05/202105:54. microsoftsignedyalid... Microsoft Corp.

OB Download File to Server
11/02/202103: = 8 signedvalid

11/02/202101:59... - 5. signedinvalid

10/29/202105:44... 2 - microsoft signedyalid... Microsoft Corp...
10/29/202101:31 microsoft.signedyalid... Microsoft Corp..
10/25/202109:48. = 8. signedyalid

10/25/202109:48... - signedyalid

09/23/202107:28... - unsigned

09/23/202107:28... 1 86MB  unsigned

u] ) 09/23/2021 1 unsigned

¢ Right-click and select Reset Risk Score from the context menu.
¢ Click More Actions > Reset Risk Score in the toolbar.

All the alerts associated with the score are deleted.

Note: You can select a maximum of 100 files to reset the score.

4. Refresh the page to view and confirm if the file's score is reset. This may take sometime for changes
to take effect.
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Investigating Hosts

Note: The information in this topic applies to NetWitness Version 11.3 and later.

The Hosts view allows you to investigate on a host, which includes scan details, tracking events related
to alerts, anomalies, and process details.

Best Practices

The following are some best practices and tips that may help you investigate efficiently to identify and
isolate threats or attacks:

Analyze Events
Analyze Hosts (Navigate or Events g
View)
- Review Risk Contributors

Download Files for

- Perform Adhoc Scan )
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files Perform Host
Highest Risk Score Forensics

- Search on Snapshot

Change File Status Remediate

- Analyze Processes Perform Extemnal

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate

- Analyze Risky Users (Users View) Host fi P
ost from Netwo

* Review hosts with highest risk score and analyze the alerts contributing to the risk. Review the
entities, such as file name, processes involved in the alerts. For more information, see Analyze Hosts
Using the Risk Score.

» Review files or processes that created this suspected file, and check if any other files are accessed or
created in the Events view. For more information, see Analyzing Events.

* Review hosts for rare files in the On Hosts column. If a file is present on 100 hosts, it can be
legitimate. If a file is present on fewer hosts with a high risk score, it may be malicious and needs
further investigation.

o Filter to exclude hosts on host status, risk score, hostname, and so on. For more information, see
Filter Hosts.

» Search Google or VirusTotal with the file hash and review any reported activities. For more
information, see Launch an External Lookup for a File.
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Review the processes, autoruns, files, libraries, drivers, and system information. For example,
e Search for files in known malware locations. For example,

¢ C:\Windows\.

¢ C:\Users\<name>\AppData\<uncommon folder>.

e (C:\Users\<name>\AppData\Local\Temp.

¢ C:\Windows\Temp\.

o Search for a particular file name or hash and review the snapshot to check when the file was first
seen.

e Review any network connections established by the process, such as:
¢ Domain or IP address.

e Ports used (common (80 and 443) versus uncommon ports (8080 , 8888, and 3465)) and check if
the ports are listening actively.

¢ Check the file compile time. If the date is recent, it could be malicious.

Check the file creation time on the host.

Review reported anomalies, such as suspicious threads, kernel hooks, image hooks, and registry
discrepancies. For more information, see Analyze Anomalies.

Launch Process Analysis to view the sequence of activities performed on the host by the file or
process. For more information, see Analyze Processes.

Download suspicious files to the server for deeper analysis. For more information, see Analyzing
Downloaded Files.

Download MFT, process, or system dump to the server for forensic investigation. For more
information, see Performing Host Forensics.

After investigation if a file is found to be malicious you change the status of the file (blacklist or
graylist) and block infected or malicious file. For more information, see Changing File Status or
Remediate.

(Optional) If you suspect that a host is potentially compromised with the threat still being active, you
can isolate the host from the network and safely investigate possible threats within the host. For more
information, see Isolating Hosts from Network.

View Hosts

You can view all hosts present on a specific Endpoint server or consolidated list of all hosts on multiple
Endpoint servers using the Endpoint Broker for analysis. By default, hosts are sorted based on the risk
score. To view the hosts:

. Go to Hosts.

2. Select from the following:
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¢ Endpoint Broker Server to view all hosts across all Endpoint servers. When querying, the
Endpoint Broker ignores Endpoint servers that are offline. If the Endpoint server is online but is
not responding, the Endpoint Broker waits for 10 seconds, and ignores if it does not respond.

« Endpoint Server to view hosts on a specific Endpoint server.

NETWITNESS

Y Filters

Select

Equals

3. Select a host that you want to analyze.
4. Click a row to view the following details:

¢ Host Details displays the host information such as Network Interfaces, operating system,
hardware and others.

¢ Risk Details displays the distinct alerts associated to the risk score and the alerts severity. Click
Critical, High, Medium, or All to display all the alerts. For more information, see Analyzing

Risky Users.
5. Click Show next 100 hosts to view other hosts.

6. Click the host name to investigate the scan results. For more information, see Analyze Host Details.

Manage Hosts Using Tags

From version 11.7 and later, NetWitness Platform allows you to create Tags to manage the hosts
effectively. Tags are custom texts that you can create and assign to hosts for identifying them. A tag can
contain alphabets, numbers and special characters(Except\ ', [ ] " and space). You can use these tags to
create host groups. You can also filter hosts by tags using the filters pane on the Hosts screen.

Manage Tags

The Manage Tags option allows you to create and delete tags without selecting any hosts.
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To Create Tags:
1. Click Tags > Manage Tags on the Hosts tab.

NETWITNESS

Y Filters X 8 endpointbrok...

Manage Tags

remote?24

No Matching Tags, Click ® to create this tag.

Cancel

o The tag is created, and a success message will appear.
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NETWITNESS R @
Succ

Manage Tags

Cancel

3. Repeat step 2 to create more tags.

To Delete Tags:
1. Click Tags > Manage Tags on the Hosts tab.

NETWITNESS

Y Filters x Sendpointbrok... ® Tags v # More Actions -

Manage Tags ‘
o HOSTNAME RISK SCORE 1" OS - DESCRIPTION LAST SCAN TIME USERNAME

2. Select the tags that you want to delete and click Delete on the Manage Tags pop-up.

Manage Tags

[:ep52tag 'ﬁf| [AUI_tag EI| |:AUI_tag_manageTag5 Iﬁ|
[:ALH_tag_EDSQ_manageT3g5 E’| [:ALERTS E’| [:mﬂre_alerts Er| [:alert_demo 1|‘_W|

[demn_ta:a. ‘*| |€. itical_hosts E’| [:from_mypackager Er|

\ 2 tags will be deleted Delete
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3. Click Delete on the Delete Tags confirmation pop-up.

Delete Tags

Following tags will be deleted and un-assigned from all associated hosts. These
hosts will no longer be a part of groups that have these tags as criteria.

[:demo_tag] |:newtag:|

o

Note: The tags you deleted will also be unassigned from all associated hosts. If the associated
hosts are a part of groups created using these tags as one of the criteria, then the hosts will no
longer be a part of those groups. Refer What happens next after unassigning or deleting tags from
hosts? for more information.

Assign tags
1. Select one or more hosts on the Hosts tab.
2. Do one of the following.
o Select Tags > Assign Tags from the menu.

NETWITNESS estig ¢ Yashb por

Y Filt: X S endpointbrok...  Analyze Events |\ || OScan ® Tags v % More Actions

Assign Tags
. . O  HOSTNAME RISKSCORE & OS - DESCRIP’ SENT GROUPS LAST SCAN TIME
SAVED FILTERS Unassign Tags

o Select a host, right click and select Assign Tags.

The Assign Tags pop-up will appear and shows all the existing tags.

NETWITNESS

Filters | | Sendpointbrok.. v  AnalyzeEvents | v || OScan v || ®Tags v # More Actions \/

[  HOSTNAME RISKSCORE & OS - DESCRIPTION AGENT GROUPS LAST SCAN TIME SERVER USERNAME
Microsoft Windows 10Ent... - 09/08/202204:37:08am e endpointloghybrid1 - Endp..

Analyze Events >
Red Hat Enterprise Linux-7.2 - 08/30/2022 11:02:20 am endpointloghybrid1 - Endp.

Delete
Stop Scan

Network Isolation

Assign Tags
Unassign Tags
Download MFT to Server

Download System Dump to Server

Download Files to Server

Reset Risk Score For Selected Host

Uninstall Selected Agent
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3. Do one of the following.

* Enter a valid tag and click to create it. The newly created tag is selected by default.

Assign Tags

newtag

No Matching Tags, Click ® to create this tag.

Cancel

o Search for an existing tag using the text field and select it if required.
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Assign Tags

bulk?8

1 tags will be assigned

NETWITNESS
Y Filters ; & endpointbrok

HOSTNAME RISKSCORE < LAST SCAN TIME AGENT GROUPS. AGENT LAST SEEN

08/05/202112:42:48 pm

08/05/202112:42:03 pm

08/05/202111:01:43am amonthago
08/05/202111:01:42am
08/05/202112:21:32 pm

) (@emotes) () 08/0520211221:410m  win2kidemo 5100 amonthago

Create and Assign Tags When Generating the Agent Packager

You can add tags to the hosts while installing the Endpoint agents. When generating the agent packager
on the Agent Packager tab, you can either create new tags or select already existing tags. These tags will
automatically be assigned to the host in which the agent will be installed.
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1. Click Assign Tags under TAG CONFIGURATION on the Agent Packager tab.

General Data Retention Scheduler SSNigEld eS8 Relay Server  3rd Party Scan Permissions

Agent Packager

ficate Thumbprint

Generate Agent Padkager

RS /\ NETWITNESS' PLATFORM

2. On the Assign Tags pop-up, do one of the following.

o Search for an existing tag using the text field and click Assign.
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Assign Tags

[AU I_tag_manageTags |

AUIl_tag_eps2_manageTags | | demo_tag | | from_mypackager |

4 tags will be assigned

Enter a new tag in the text field and click to add it to the selection. Click Assign.
3. Assigned tags will appear under SELECTED TAGS.

ate Thumbprint

Generate Agent Packager
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Note: The tags added while generating the Agent Packager are applicable only to the newly installed
agents and not to the manually upgraded agents.

Unassign tags
1. Select one or more hosts on the Hosts tab.

2. Do one of the following.

o Select Tags > Unassign Tags from the menu.

NETWITNESS

< Filters & endpointbrok... 4 AnalyzeEvents | v || OScan v  Tags © $ More Actions

Assign Tags
[0 HOSTNAME RISK SCORE L OS - DESCRIPTION i LAST SCAN TIME TAGS SERVER USERNAME
Unassign Tags

100 Microsoft Windows 10Ent... - 09/08/202204:37:08am [ aliMachin. endpointloghybrid1 - Endp..

» Right click a host and select Unassign Tags. The Unassign Tags pop-up will appear and show all
the tag assigned to the selected hosts.

NETWITNESS westigate ) Jser ashboard

< Filters S endpointbrok... V/ | (4 Analyze Events v ©Scan v  Tags v $ More Actions

O]  HOSTNAME RISK SCORE . OS - DESCRIPTION AGENT GROUPS LAST SCAN TIME TAGS SERVER USERNAME

Microsoft Windows 10Ent.. 09/08/202204:37:08am  (aiimachin...) (theseare.. | endpointloghybrid1- Endp... -

Analyze Events i
Red Hat Enterprise Linux-7.2 - 08/30/2022 11:02:20 am ‘ allMachin. ] endpointloghybrid1 - Endp...

Delete
Stop Scan
Network Isolation
Assign Tags

Unassign Tags

Download MFT to Server

Download System Dump to Server

Download Files to Server
Reset Risk Score For Selected Host

Uninstall Selected Agent

3. Search for the tags you want to unassign, select them and click Unassign.
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Unassign Tags

1 tags will be Unassigned Cancel Unassign

4. Click Unassign on the confirmation pop-up.

Unassign Tags

Tags will be removed from the selected hosts.
MNote: Selected hosts will no longer be a part of groups that have these tags as
criteria.

| from_mypackager |

NETWITNESS

Y Filters

AST SCAN TIME

08/30/202101:49:11pm

09/03/2021 10:15:29 am

What happens next after unassigning or deleting tags from hosts?

Unassigning/deleting tags from hosts will immediately initiate group & policy evaluation. For example,
if a host is a part of the group created using only the unassigned/deleted tag as criteria, the host will no
longer be a part of that group. Refer to the following scenarios to understand more.
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Example Scenario 1: Assume you create a group with a couple of tags as grouping criteria, all the hosts
with these tags assigned will be a part of the group. And, if you delete these two tags(or unassigning
from the hosts), the hosts may no longer be a part of this group.

Example Scenario 2: Assume you create a group with a couple of tags and [P addresses as grouping
criteria; all the hosts assigned with these tags and IP addresses will be a part of the group. And, if you
delete(or unassigning from the hosts) the tags alone, the hosts may still be a part of this group as they are
still grouped using the IP addresses.

View Agent History

You can view the list of commands issued to the agents (by the server or actions performed by any
analyst) in the Host view and Host details. By default, commands are sorted based on the command time.

To view the commands:
1. Go to Hosts.

2. Do any one of the following,

To view all commands, click . You can also filter commands, for more information see Filter
Hosts.

Ste | e (£

O HoSTNAME RISKS.. AGENTLAST.. AGENTSCANST.. AGENTGROU. AGENTMODE AGENTVERSION  AGENT-D.. AGENT-INSTALLTI. AGENTID LASTSCANTI

The Agent History view is displayed. For more details, see Analyze History.

¢ To view commands specific to a particular host:
© Click the host for which you want to view the commands.

° In the Host details view, click History tab. You can also filter commands, for more information
see Filter Host Details.
The History view is displayed. For more deta

ALERTS ~ PROCESSES  AUTORUNS  FILES JRIVERS  LIBRARIES ~ ANOMALIES YOW

ee Analyze History.

SYSTEM INFO  HISTORY  YARA RULES

ils, s

GE

History

@) custompare | COMMANDTIME £ coMMAND TYPE USER NAME STATUS COMMAND PARAMETER PROCESSED TIME LAST RETRIEVAL TIME TOTAL RETRIEVZ 5}

09/1 12:53:17pm Download File system 18pm

09/1¢ 12:53:17 pm Download File system path = C:\Wind - 2 /16 2:53:18 pm
COMMAND TYPE

09/16/2022 12:53:17 pm Download File system path = C:\cygwin64!

Download File system \cygwin64\usr

Download File system

Download File system = Cicygwiné4\liby 8 09/16/202212:53:18 pm

REQUEST TYPE

Download File system = C:AWindows\ S 9/ 2:53:18 pm

Download File system = C:A\Program Files\ /16/ 2:53:19 /16! 18 pm

COMMAND PARAMETER 9/ 3: Download File system

\cygwin64! 9 % 2:53:18pm

Contains Download File system

02212:53:17pm  Download File system /202212:53:20 pm
022 1: Download File system 21pm
Download File system 21pm

09/16/2022 12:53:17 pm Download File system 09/16/2022 12:53:20 pm

2 £ LKL CKLCKLCKKKKK
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Filter Hosts

You can filter hosts on agent version, agent ID, agent mode, agent upgrade, agent last seen, last scan
time, operating system, hostname, username, Mac address, risk score, IPV4, driver error code, security
configurations, agent groups, and host status - managed, roaming, and isolated.

In the Host view > click , to filter the commands on command type, status, host name, request type,
command parameter and command time. In the Command Time field, you can filter by custom date
range.

Note: While filtering on a large amount of data, use at least one indexed field with the Equals
operator for better performance. The following fields are indexed in the database - Hostname, IPv4,
Operating System, Last Scan Time, and Risk Score.

NETWITNESS

Y Filters © Broker - Endp... O Tags v £ More Actions Vv

SAVED FILTERS HOSTNAME RISK SCORE AGENT VERSI..- LAST SCAN TIME

Select 11600 A

HOST STATUS

0 Managed 11600 A 09/29/202004:36:32....
O Roaming

A 09/29/2020 04:22:54 ...
O Isolated 116004

11.600 A
RISK SCORE
11600 A
11600 ® 09/28/2020 08:34:35....
11600 A 09/29/2020 05:01:05 ...
HOSTNAME

Equals

Showing 100 out of 1000+ hosts | O selected

To search multiple values within a field, set the filter option to Equals, and use | | as a separator.

For example, using Equals operator for multiple IPV4 values with a separator | |.
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Y Filters

USERNAME

Equals v Enter value

AGENT GROUPS

Equals v Enter value

NIC MAC ADDRESS

Equals v e.g.,00:00:00:00:00:00

IPV4

Equals +  10.87.225.68]|10.40.7.11

AGENT LAST SEEN

LAST SCAN TIME . CUSTOM DATE

OPERATING SYSTEM

O windows
O Linux
O Mac

ACENT MO

To filter on the agent last seen or last scan time, select the option from the drop-down list. If you select 3
Hours ago for the Last Scan Time, the result displays hosts that were last scanned 3 hours ago or earlier.

To filter on the risk score, use the slider to increase or decrease the values between 0 to 100.
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Y Filters

RISK SCORE

HOSTNAME

Equals v Enter value

USERNAME

Equals v Enter value

AGENT GROUPS

Equals v Enter value

NIC MAC ADDRESS

Equals v e.g.,00:00:00:00:00:00

IPV4

Equals v eg,1.1.1.1]]1.1.11

AGENT LAST SEEN

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added
to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click .

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

To filter the agents based on the upgrade status, select one of the upgrade statuses. For example, select
the Upgrade Available checkbox to get the list of agents available for an upgrade.
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Y Filters

AGENT LAST SEEN @ ) customparte

LAST SCAN TIME @ ) custompare

OPERATING SYSTEM
O Windows

O Linux

O Mac

AGENT UPGRADE

O Failed

O Pending
Upgrade Available

AGENT MODE
O Insights
O Advanced

SECURITY CONFIGURATIONS

To filter the agents based on single or multiple agent groups, select a group from the drop-down list. You
can also search the name of the groups from this list.
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Y Filters

HOSTNAME

Equals

USERNAME

Equals

AGENT GROUPS

(<alires) - Growin

linuxGrps
pureLinuxGrps
WindowsAndLinuxGrps

LinuxRhelGrps

Equals

AGENT LAST SEEN @ ) custoMDATE
Save Save as...

To filter the agents based on the installation status, select one of the installation statuses. For example,
select the Uninstalled checkbox to get the list of agents for which the uninstall is initiated or
successfully completed.
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Y Filters

O Failed
O Pending
O Upgrade Available

AGENT MODE

O Insights
O Advanced

AGENT INSTALLATION STATUS
O Installed
Uninstalled

AGENT- DRIVER ERR

Equal

AGENT ID

Equals

AGENT V

Equals

You can also filter the commands on command type, status, host name, request type, command

0

parameter and command time (In which you can filter by custom date range), by clicking :G)

In 12.3 and later versions, you can filter the hosts on specific versions of Windows, Mac, and Linux
using the Operating System Description field.

For Example: CentOS Linux 7 (Core), Microsoft Windows 10 Enterprise, and Microsoft Windows
Server 2016 Standard. Refer the following figure.
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Y Filters

AGENT LAST SEEN i‘) CUSTOM DATE

LAST SCAN TIME @ ) custombATE

OPERATING SYSTEM

O windows
O Linux
O Mac

OPERATING SYSTEM DESCRIPTION

|
CentOS Linux 7 (Core)

Microsoft Windows 10 Enterprise

Microsoft Windows Server 2016 Standard

O Upgrade Available

AGENT MODE

O Insights
O Advanced

AGENT STATUS

[ I SO | PR

Adding and Sorting Columns in the Table

By default, the Hosts view displays a few columns and the hosts are sorted based on the risk score. To
add or remove columns:

1. Go to Hosts.

2. Select the columns by clicking E<d in the right-hand corner.
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Username

Agent Version

3. Scroll down or enter the keyword to search for the column.

4. Click the arrow on the column header to sort the column in ascending or descending order.

Scan Hosts

You may want to perform an on-demand scan if you want to get the latest snapshot of the host.
You can either choose to perform a quick scan or a full system scan.

Quick scan - Scans all executable files that are loaded in memory. Both Insights and Advanced agents
support quick scan.

Full System Scan - Scans all fixed drives or the system drive You can perform a full system scan only
on advanced agents that are in version 11.6 or later. Native executables are included in the full system
scan, by default

When hosts are scanned, the Endpoint Agent retrieves the following data that can be used for
investigation:

» Drivers, processes, DLLs, files (executables), services, autoruns, anomalies, host file entries, and
scheduled tasks running on the host.

» System information such as network share, installed Windows patches, Windows tasks, logged-in
users, bash history, and security products installed.
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You can configure the NetWitness Platform to exclude specific files and folders from NetWitness
Endpoint Agent full system scans. When you exclude files or folders, the NetWitness Endpoint Agent
ignores them when it scans for security risks. When you exclude files and folders from full system scans,
the Endpoint Agent will not scan mission-critical files during scans, which would otherwise impact
customer service performance. If you exclude files and folders with large sizes, you might find that
Endpoint Agent scan time is reduced.

For more information on excluding files and folders, go to Exclude Files and Folders topic in the
NetWitness Endpoint Configuration guide .

To perform a Quick Scan:
1. Go to Hosts.

2. Select one or more hosts (up to 100) at a time, and do one of the following:

Click Scan > Start Scan from the menu (Or)

Right-click and select Start Scan from the context menu

3. Click Start Scan on the pop-up. Quick scan is initiated for executable modules loaded in memory.

The following are the scan statuses:

o o

Idle No scan is in progress.
Scanning  Scan is in progress.

Pending Scan request is sent to the server, and the agent will receive the request the next time it
communicates with the server.

Cancel Stop request is sent to the server, and the agent will receive the request the next time it
communicates with the server.

Note: By default, the scan utilizes 25% of the CPU. You can click CPU Maximum and select a value
from 5% to 100%. Increasing the CPU Maximum limit reduces the scan time but could lead to more
CPU usage.

To perform a Full System Scan:
1. Go to Hosts.

2. Select one or more hosts (up to 100) at a time for an on-demand scan, and do one of the following:

¢ Click Scan > Start Scan from the menu bar (Or)

¢ Right-click and select Start Scan from the context menu
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NETWITNESS

Y Filters X S endpointbrok... v [ Oscan v ‘ ® Tags v % More Actions v

Start Scan
T O HosTNAME RISK SCOK| SCRIPTION LAST SCAN TIME USERNAME
A ERS StopScan [

100 Microsoft Windows 10 Enterprise 11/15/202103:4607 pm  WINTAG\AdministratorWINTAG\ecatWindow M...
Microsoft Windows 10 Enterprise 10/29/202106:38:48am  DESKTOP-5QIN3DU\kslp.
Red Hat Enterprise Linux Server release 6.4 (Santiago) 11/15/202107:41:34am  —
Red Hat Enterprise Linux Server release 6.4 (Santiago) 11/03/202110:08:50am  —
Microsoft Windows 10 Home
Microsoft Windows Server 2016 Standard 11/11/202109:29:34pm  Window Manager\DWM-3Window Manager\DW...
Microsoft Windows 10 Pro for Workstations 11/02/202106:16:39pm  WINDOWS\ecatWindow Manager\DWM-1

Microsoft Windows 10 Enterprise 11/11/202101:1803pm  CORP\dhd CORP\dhd

1. From the Start Scan pop-up, select Full System Scan (Only on advanced agents that are 11.6 or
higher.)

2. Select System Drive(Default selection) or All Fixed Drives

3. Click Start Scan on the pop-up.

Start Scan X

Performs a quick scan of all executable files available in the memory. The total
time to complete the scan depends on CPU Maximum.

Full System Scan (For advanced agents that are in version 11.6 or higher)

DRIVE

System Drive
O All Fixed Drives

daiviag

Note: An Endpoint server supports up to 10k Full System Scans in a rollover period.
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Analyze Hosts Using the Risk Score
You can investigate a host by analyzing the risk contributors such as alerts and events to look for
suspicious or malicious activity.

Based on the severity of the alert triggered by the host, you can analyze the host using the following
options:

o View Alert Details: This option allows you to analyze the host when Critical and High alerts are
triggered. For more information, see Investigating a Process.

o Analyze Process Tree: This option allows you to analyze the host when Medium alerts are triggered.
For more information, see Investigating a Process.

To analyze the hosts (which trigger Critical or High alerts) using the risk score:
1. Go to Hosts.
The Hosts view is displayed.

2. In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the hosts.

3. Select the host and do any of the following.
¢ Click a row to view the risk associated with the host in the Risk Details panel.
o Click the hostname to investigate the host.
The Alerts tab is displayed.
4. In the Alerts > Severity panel, click the alert severity such as Critical or High.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.

SEVERITY HighAlerts @ Event Details

Event Metadata
B Investigate Timeline & View Alert Details

18> | @@ wioeoupuicares

EVENT TIME

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/202203:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/202203:44:20.000 pm

09/20/202203:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

09/20/2022 03:44:20.000 pm

FILENAME

ipsrus.xml

TIME
M 09/20/2022 03:44:20 pm

DIRECTORY
N/A o
418
SIGNED BY

N/A endpointloghybrid1

Note: For each alert, only the latest 1000 events are displayed.

6. To view all the details associated with a specific event, click on an event. The Event Details panel is
displayed with the summary and overview information associated with the event.
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7. You can also view the Event Metadata such as IP, Filename, File hash, and Category in the Event
Details panel.

Note: The contexthub-server.contextlookup.read permission is enabled only for Administrators,
Analysts, Malware Analysts, SOC Managers and Respond Administrators. Administrators can
enable this permission for other roles in the Hosts view to view context lookups for meta values
and perform the Add/Remove from List actions. For more information, see the "Role Permissions"
topic in the System Security and User Management Guide.

8. Click the drop-down option besides the metadata value to view additional information about the
specific metadata. The Context Highlights dialog displays a list of the data sources that have context
data available for meta value. These are the possible data sources: NetWitness Endpoint, Incidents,
Alerts, Hosts, Files, and Feeds.

CONTEXT HIGHLIGHTS

2 2
INCIDENTS ALERTS

REPUTATION

Context Lookup

Pivot to Investigate > Hosts/Files

Add/Remove from List

9. To investigate the original event and destination domain of the event, do any of the following:
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« To investigate the events in a specific time frame, click Investigate Timeline on the Event
Details panel. For more information, see the NetWitness Investigate User Guide.

o To investigate a particular process, click View Alert Details on the Event Details panel. For more
information on process analysis, see Investigating a Process.

To analyze the hosts (which trigger Medium alerts) using the risk score:
1. Go to Hosts.
The Hosts view is displayed.

2. In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the hosts.

3. Select the host and do any of the following.
¢ Click a row to view the risk associated with the host in the Risk Details panel.
o Click the hostname to investigate the host.
The Alerts tab is displayed.
4. In the Alerts > Severity panel, click the Medium alert severity.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.

Note: For each alert, only the latest 1000 events are displayed.

6. To view all the details associated with a specific event, click on an event. The Event Details panel is
displayed with the summary and overview information associated with the event.

ALERTS ~ PROCESSES AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES JOWNLOADS ~ SYSTEM INFO  HISTORY

SEVERITY o
Medium Alerts @ Event Details

1 | v @& rnumerates Local Account Policy eventy Event Metadata

B Investigate Timeline | | % Analyze Process Tree
EVENT TIME SUMMARY

‘Lg ‘ @ i0E DupLICATES

09/27/202201:52:52.000 am e created process net.exe

ed process net.exe v

TARGET FILENAME
net.exe o E

~ 09/27/2022 01:55:38 am
TARGET COMMAND LINE

net.exe ACCOUNTS

TARGET DIRECTORY
C:\Windows\system32\

TARGET USER

TARGET HASH
0bd94a338eea5ade1f2830ae326e6d19

7. You can also view the Event Metadata such as IP, Filename, File hash, and Category in the Event
Details panel.

8. Click the drop-down option besides the metadata value to view additional information about the
specific metadata. The Context Highlights dialog displays a list of the data sources that have context
data available for meta value. These are the possible data sources: NetWitness Endpoint, Incidents,
Alerts, Hosts, Files, and Feeds.
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CONTEXT HIGHLIGHTS

2 2
INCIDENTS ALERTS

REPUTATION

Context Lookup
Pivot to Investigate > Hosts/Files

Add/Remove from List

9. To investigate the original event and destination domain of the event, do any of the following:

o To investigate the events in a specific time frame, click Investigate Timeline on the Event
Details panel. For more information, see the NetWitness Investigate User Guide.

o To investigate a particular process, click Analyze Process Tree on the Event Details panel. For
more information on process analysis, see Investigating a Process.

ALERTS  PROCESSES  AUTORUNS 3 IBRARIES ) IES OWNLOADS  SYSTEM INFO  HISTORY

SEVERITY o
Medium Alerts @ Event Details

1 ] ycal Account Policy (1events) Event Metadata

b Investigate Timeline & Analyze Process Tree
EVENT TIME SUMMARY =
18> | @@ mwoeoupuicates

09/27/2022 01:52:52.000 am cmd. exe created process net.exe
Q@D F loating Mox
QD Hicden

TARGET FILENAME

) )
QD Tasks In Program irectory (8events) e

TARGET COMMAND LINE
net.exe ACCOUNTS

TARGET DIRECTORY
C:\Windows\system32\

TARGET USER

TARGET HASH
0Obd94a338eea5ade1f2830ae326e6d19
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Analyze Host Details

To look for suspicious files on a host, click the host name and view the details of the host, or start an on-
demand scan to get the most recent information. On the right-hand panel, you can view the following:

o Host Details displays the host information, such as Network interface, operating system, hardware
and others.

e Policy Details displays the complete resolved policy settings.

For more details, see Hosts View - Details Tab.

A)TERIT.S W o RO £ SEES AUTORUNS  FILES  DRIVERS  LIBRARILS ~ ANOMALILS DOWNLOADS  SYSIEM INFO HISIORY YARA RULES

SEVERITY Py
Critical Alerts @ + 8 4 4

K] uns Blacklisted File (5 events)

EVENT TIME SUMMARY TARGET PARAM

09/21/2022 03:00:32.000 pm scp.exe created process ssh.exe ssh. -oForwardAgent: ermitLocalCommany Show details with values only

09/21/2022 03:00:21.000 pm scp.exe created process ssh.exe ssh oForwardAgent: e itLocalComman Network Inter

Intel(R) 82574L Gigabit Network Connecti..

09/21/2022 02:58:43.000 pm

09/21/2022 02:58:34.000 pm

09/21/2022 01:07:42.000 pm

scp.exe created process ssh.exe

powershell.exe created process ssh.exe

explorer.exe created process ssh.exe

ssh.exe "x" "oForwardAgent=no" "-oPermitLocalCommand=no" "-.

ssh.exe \ma-logdcpp.log root@10.125.250.71:/root

ssh.exe

150:56:01:1C:30

10.118.128.1
CO:0:0:fff:1 fecO:0:0:ffff::2.fecO:0:0:ffff:3

miscous false

Operating
Microsoft Windows 10 Enterprise
18362
0

ame  ntoskrnl.exe

Filter Host Details

In the Processes, Autoruns, Files, Drivers, Libraries, and Anomalies tabs, you can filter the processes or
files on file status, reputation, file or process name, signature, and risk score. Click Save to save the filter
and provide a name (up to 250 alphanumeric characters). The filter is added to the Saved Filters panel on

the left. To delete a filter, hover over the filter name and click .

In the Host view > Files tab, you can filter the files available on host, and files deleted from host. The
result of files deleted from host depends on the data retention policy configured in the Endpoint Config
view > Data Retention Scheduler tab. By default, data retention policy is configured for 30 days, this
means only 30 days of deleted files are stored in the Endpoint server. These filter options are disabled if
All Files Available on Host toggle is disabled.

In the Host view > History tab, you can filter the commands on command type, status, host name,
request type, command parameter and command time. In the Command Time field, you can filter by
custom date range.

Click Save to save the filter and provide a name (up to 250 alphanumeric characters).The filter is added
to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click .

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.
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Search Files on Host

To investigate a host or to check if it is infected with a known malware, you can search for occurrences
of the file name, file path, or SHA-256 checksum.

Note: To search for a SHA-256 checksum, provide the entire hash string in the search box.

The result displays the matching files present on the host in All Files Available on Host category and in
the respective snapshot category with the details, such as file name, signature information,and
checksum. In addition, the snapshot category displays the system interaction, for example, ran as
process, library, autorun, service, task, or driver. To view more details, click the filename or system
interaction link.

Example, a user has clicked and executed a malicious attachment through a phishing email, and
downloaded it to C:\Users. To investigate this file:

1. Goto Hosts.

2. Select the host that you want to investigate or select the Endpoint Broker server to investigate all the
hosts.

3. In the Alerts tab, enter the file path C:\Users in the search box.

The search displays a maximum of 100 results of the executables in this folder. In this example, there
are some unsigned file that might be malicious. If the search is executed on an Endpoint Broker
server, it queries all the Endpoint servers.

77 Investigating Hosts



NetWitness Endpoint User Guide

N

Unsigned C:\Users\ecat\App
Data\Local\Programs\Python\Python3é\Lib\site-package
s\paramiko\__pycache_\ ffffcaBb45a2874af02648b07
242cc4d7a83feaBed45b8c65b64c43e2f31785d

Unsigned C:\Users\ecat\Docu
ments\sharemanu\Python36\Lib\site-packages\__pycach
e_\ 9628ba2dc73f6bdc20d089d21e0f3594000922ch
133420a2906630ea3b661d50

Unsigned C:\Users\ecat\Documents\share
manu\Python36\Lib\site-packages\Pylnstaller\utils\hook
s\ f2e623d83823fa691b74665a%eef91581e1c1d319f
13dda3d0a90449657eddbd

Unsigned \Users\ecat\Docu
ments\sharemanu\Python36\Lib\test\decimaltestdata
€a952da312fbc0a138f7093f9d98bde6c2864fh833e

b5a2c8dbd336854a535bf

Unsigned C:\Users
\ecat\Documents\ \Python36\Scripts\__pycach
e_\ 8d33b3589921194b9800céfaf911c3%ebe3cB86a4
2817b45d46a8d4d7e036f418

Unsigne
d C:\Users\ecat\AppData\Local\Programs\Python\Pyt
hon36\Lib\site-packages\libtaxii\xsd\  2cc298edada05
bf1200c8218c7e039881a6fa7f74bcae3512a7805df781
0ad94

Unsigned  C:\Users\ecat
\Documents\ Python36\Lib\site-packages\fut
ure\backports\email\__pycache_\ 1cel1999e0364a3da
62336eaa2bb3eea/5acd/fbdce5747t9473f361374d624
/b

Unsigned C:\Users\ecat\Documents\sharem

ant\PvithanlA\lih\idlalib\idle tect\

This file is run as a Process.
4. To view details of this file, click Process in the result.

This opens the Process tab where you can view the process details.

Analyze Processes

To analyze the process:
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1. In the Hosts details, select the Processes tab.

NETWITNESS

4 NT SCAN STA AGENT LAST SEEN
100 e 10 minutes ago ® snapsHoT TiME  11/03/202105:24:19 pm

ALERTS  PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES  DOWNLOAI SYSTEM INFO  HISTORY

Y Filters > Processes T —

O Process NAME LOCALRISK SCORE  GLOBAL RISK SCORE  ON HOSTS REPUTATION FILESTATUS  DOWNLOADED FiLe pATH
Equals g (o) ( it ¢
a ) ° 2 o Neutral C:AWindows\Syst]

FILE STATUS Neutral = C:\Windows\Syst

O Neutra
Neutral Neutral C:\Windows\Syst

Neutral i C:\Windows\Syst

Neutral = C:Windows\Syst

s Neutral T C:AWindows\Syst
Malicious

O Suspicio [ Neutral C:\Program Files\

Neutral m C:\Program Files\

Neutral i C:\Windows\Syst

Neutral C:\Windows\Syst

NETWITNESS

& - 20 minutes ago snapsHoT TiME  11/03/202105:24:19 pm

ALERTS  PROC S AUTORUNS  FILES  DRIVERS  LIBRARIES  ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

¥ Filters X Processes @ e view

O  PrOCESS NAME LOCAL RISK SCORE GLOBAL RISK SCORE  ON HOSTS REPUTATION FILESTATUS  DOWNLOADED

Eauls (o) - Neutral

FILE STATUS Neutral

O Neutra
Neutral Neutral
Neutral

Neutral

Neutral

O Malicious -
O Suspicious (o) - Neutral - Mags:0x0 fstateQ
O Unkn 2
O Known
O Known Go
O Invalid

Neutral = -

Neutral

Neutral

2. In the Processes Tab, do one of the following:
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o Click a row to view the properties of a process in the right panel.

NETWITNESS

e AGENT SCAN STATUS AST SEEN AGEN ‘
100 Epi snapsHoT TiMe  11/03/202105:24:19 pm

20 minutes ago

ALERTS ~ PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters & Change File Status 4 Analyze Events | v % More Actions @ ) TREEVIEW OneDrive.exe

FILE DETAILS
PROCESS NAME LOCALRISKSCORE  GLOBALRISK SCORE  ON HOSTS REPUTATION FILESTATUS  DOWNLOADED fueean @&

Neutral = CAProgram F\’Iesi

Neutral - C:\Windows\ £ th values only

OneDrive.exe Neutral C\Users\ecat\Ap ¢

OneDriveexe
Neutral T C:AWindows\Syst

4.283913667539894
Neutral T C:AWindows\Syst
14MB
Neutral i C:AWindows\Syst
pe
Neutral T C:AWindows\Syst
Neutral i C:AWindows\Syst
Neutral C:AWindows\Syst
9edb70213f7015a92e374a82725af2bf
Neutral C:AWindows\Syst
cfb3401a77f0450b13249631b89a17b33.

6 44bd2686cd0f31edf3da16162955¢1687...

NETWITNESS

AGENT LAST SEEN

100

SRR snapsHot Time  11/03/2021 05:24:19 pm

ALERTS  PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

< Processes | Process Details

-cat\AppData\Local\Microsoft\OneDrive\

When reviewing processes, it is important to see the launch arguments. Even legitimate files can be used
for malicious purposes, so it is important to view all of them to determine if there is any malicious
activity.

For example,

* rundl132.exe is a legitimate Windows executable that is categorized as a good file. However, an
adversary may use this executable to load a malicious DLL. Therefore, when viewing processes, you
must view the arguments of the rund1132.exe file.

e LSASS.EXE is a child to WININIT.EXE. It should not have child processes. Often malware use this

executable to dump passwords or mimic to hide on a system (1lass.exe, 1ssass.exe,
lsasss.exe, and so on).

e Most legitimate user applications like Adobe and Web browsers do not spawn child processes like
cmd. exe. If you encounter this, investigate the processes.
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You can view the sequence of activities performed on the host by the file or process using the process
analysis. For more information, see Investigating a Process.

Analyze Autoruns

In the Hosts details, select the Autoruns tab. You can view the autoruns, services, tasks, and cron jobs
that are running for the selected host.

For example, in the Services tab, you can look for the file creation time. The compile time is found
within each portable executable (PE) file in the PE header. The time stamp is rarely tampered with, even
though an adversary can easily change it before deploying to a victim's endpoint. This time stamp can
indicate if a new file is introduced. You can compare the time stamp of the file against the created time
on the system to find the difference. If a file was compiled a few days ago, but the time stamp of this file
on the system shows that it was created a few years ago, it indicates that the file is tampered.

Note: The Endpoint Broker queries the Hosts present across multiple Endpoint Servers for each
Autorun and displays the total count of the hosts for the respective Autoruns in the On Hosts column
in the Hosts > Autoruns Broker view.

For Example:

If an Autorun is running on 2 different hosts present across multiple Endpoint Servers, the On Hosts
count of the Autorun is displayed as 2 in the Hosts > Autoruns Broker view.

Analyze Files

To analyze the files, you can do either one of the following based on your requirement.

e In the Hosts view, select the Files tab.
You can view the list of all files (reported as part of scan and tracking) on the host including the
deleted files.

ALERTS ~ PROCESSES AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES DADS  SYSTEM INFO STOR YARA RULES

Y Filters x es @ ALL FILES AVAILABLE ON HOST

FILE NAME FILENAME LOCAL RISK SCORE GLOBAL RISK SCORE  ON HOSTS FILE STATUS REPUTATION DOWNLOADED PATH

Equals Neutral Known C:\Users\ecat\Do'

Neutral Known C:\Program Files\

Neutral Unknown C:\User: \Ap|

Neutral Known C:\Users\ecat\Do

Neutral Known C:\Python34\Lib\

Neutral Known C:\Windows\Instz

Neutral Known C:\Users\ecat\Do

Neutral Known C:\ramalLib\test\

Neutral Known C:\rama\Lib\test\

Neutral Known C:\Users\ecat\Do

Neutral Known C:\Users\ecat\Do

Neutral Known C:\Python34\Lib\

O valid nature

v
v
v
v
v
v
v
v
v
v
v
v

| Oselected

e To view the files reported as part of scan snapshot, you must disable All Files Available On Host
toggle and select the scan time from the Snapshot drop-down list.
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Example for analyze files, many trojans write random filenames when dropping their payloads to prevent
an easy search across the endpoints in the network based on the filename. If a file is named
svchOst.exe, sevhost.exe, Or svchosts.exe, it indicates that the legitimate Windows file named
svchost.exe is being mimicked.

Analyze Libraries

In the Hosts details, select the Libraries tab. You can view the list of libraries loaded at the time of scan.

For example, a file with high entropy gets flagged as packed. A packed file means that it is compressed
to reduce its size (or to obfuscate malicious strings and configuration information).

Analyze Drivers

In the Hosts details, select the Drivers tab. You can view the list of drivers running on the host at the
time of scan.

For example, using this panel, you can check if the file is signed or unsigned. A file that is signed by a
trusted vendor such as Microsoft and Apple, with the term valid, indicates that it is a good file.

Analyze Anomalies

Note: This tab is available only for advanced agent.

In the Hosts details, select the Anomalies tab. You can view the following details for the selected host:

* Image hooks - Hooks found in executable images (user-mode or kernel-mode) - IAT, EAT, Inline,
exceptionHandler.

e Kernel hooks - Hooks found on kernel objects (such as Driver Object [Pointers, IRP_ MJ, SSDT, IDT,
and so on]). This also includes filter devices.

» Suspicious threads - Threads whose starting address points to memory DLLs or floating code. The
threads could be running with either user-mode or kernel-mode privileges. These threads could run
malicious code inside a trusted application to execute their own code.

e Registry discrepancies - The Windows registry is a hierarchical database that stores configuration
settings and options on Microsoft Windows operating systems. It contains settings for low-level
operating system components and for applications running on the platform: the kernel, device drivers,
services, SAM, user interface, and third party applications all use the registry. The discrepancies
between low-level parsing with Win32 registry API are reported.

Note: Anomalies is applicable only for Windows hosts.

For example, hooking is used to intercept calls in a running application and to capture information
related to the API invocations. Malicious programs can implant hooks in various system applications for
different purposes, such as hiding files, directories, registry entries, intercepting users keystrokes to
establish a stealthy communication channel with the attacker.
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Analyze System Information
In the Hosts details, select the System Information tab. This panel lists the agent system information.
For Windows operating system, the panel displays the host file entries and network shares of that host.

For example, malware might use host file entries to block antivirus updates.

Analyze History

In the Host details, select the History tab. This tab lists the commands along with the respective status
and additional details.

When you review the history, look for the command status and retrieval count to check if the agent
retrieved the commands.

Below are some examples:

e A file download command is issued, but the file is deleted on the host. In this case status of the
command is failed as the file is not downloaded.

* The retrieval count increases, but the command is not processed. This happens when an analyst
requests a large number of files (For example, MFT, system dump, or process dump), and the
connection breaks when the agent uploads these files.

» If the agent command is not retrieved, the agent is either offline or busy processing other commands
(For example, uploading a system dump). In this case, the status of the command shows pending.

To view more details, click the Hostname link highlighted in blue. The Hosts details view is displayed.
In the case of MFT, download file, system dump, and process dump command types, Downloads tab is
displayed with details such as file name, type, status, size, downloaded time and SHA256 of the file,
when you click on the Hostname link.

Export Host Details or Files to JSON File

Note: Export Host details option is disabled if there is no snapshot time.

To export host details or files to JSON file:
1. Go to Hosts.

2. Select the hostname to open the host details.

3. Click i (More) beside the hostname and do any of the following:

¢ To export the scan data categories for the host, select Export Host Details. This exports files
such as:

° allfiles.json - This file consists of the file name, file path, signature, file checksum, and so on
that is reported as part of scan and tracking.

° fileContext.json - This file consists of the file name, file path, signature, file checksum, and so
on that is reported during the host scan.
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° machinedetails.json - This file consists of the machine details, including hardware, operating
system, interfaces, and so on, along with the agent details like version, policy details.

Note: If Endpoint Broker is selected and a host is communicated with multiple Endpoint servers,
during the host details export, all files and details of the host are exported from the Endpoint server
where the selected snapshot is stored.

Note: allfiles.json file is exported irrespective of the selected snapshot.

e To export all the files available on the host, select Export Files. This exports:

o allfiles.json - This file consists of the file name, file path, signature, file checksum, and so on

that is reported as part of scan and tracking.

Launch an External Lookup for a File

While analyzing a file, you can search Google or VirusTotal with the filename or hash to get more
information about the file. To launch the search:

1. Go to Hosts > Host Details (Autorun, Files, Drivers, Libraries, or Anomalies tab).

2. Right-click one or more files, or in the More Actions drop-down list in the toolbar, do the following:

Y Filters

FILE NAME

Equals

FILE STATUS
O Neutral
O Blackist
O Graylist
0 Whitelist

REPUTATION
0 Malicious

O Suspicious
0 Unknown

O Known

O Known Good
O Invalid

SIGNATURE
0 Unsigned
O Valid Signature

v

DRIVERS

Files

0

LIB

& Change File Status

FILENAME

LOCAL RISK SCORE

GLOBALRIS|

¢ MoreActions v
Google Lookup

VirusTotal Lookup

SaveaLocal Copy

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Neutral

Showing 3039 out of 3039 fles | 3 selected

[0 ALLFILES AVAILABLE ON HosT

REPUTATION DOWNLOADED PATH

Known CA\Users\ecat\Do

Known C\Program Files\
Unknown Ci\Users\ecat\Ap
Known CA\Userslecat\Do
Known C)\Python34\Libk
Known C:\Windows\Inste
Known CA\Users\ecat\Do
Known Cirama\Lib\test
Known Cirama\Lib\esty
Known C:\Userslecat\Do

Known C:\Users\ecat\Do

v
v
v
v
v
v
v
v
v
v
v
v

Known C)\Python34\Liby

~
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¢ Select Google Lookup to perform a search on the filename, MD5, SHA1, or SHA256.
¢ Select VirusTotal Lookup to perform a search on MD5, SHA1, or SHA256.

Note: To open files in multiple tabs, make sure you enable the pops-up in the browser.

Delete a Host

If the agent is uninstalled on a host or if you no longer require the host scan data, you can manually
delete this host from the Hosts view. Deleting a host deletes all scan data associated with the host. To
delete hosts:

1. Go to Hosts.
2. Select the hosts that you want to delete from the Hosts view and do one of the following:

NETWITNESS

Y Filters X © EPS1-Endpoi... G Analyzevents | v || OSanv || QTags v # MoreActions v [‘(:) m

Delete

Reset Risk Score
LegacyValidati
Download MFT to Server

Download System Dump to Server
Analyze Events > Download Files to Server

Delete Upgrade Selected Agent

Start Sca
n UninstallSelected Agent

D 1710 ®

Assign Tags

9daysago 1710 ®

Unassign T &
ign Tags 2daysago & 11710 @

I
Download MFT to Server 23daysago 1710 ®

Download System Dump to Server amonth ago 11710 @

Download Files to Server
Reset Risk Score:
Upgrade Selected Agent

Uninstall Selected Agent

¢ Right-click and select Delete from the context menu.

¢ Click More drop-down list in the toolbar and select Delete.

Note: If you accidentally delete a host from the Hosts view, the Endpoint Server forbids all requests
from this agent. The agent must be uninstalled manually from the host and reinstalled for it to appear
on the Hosts view.

Deleting Hosts with Older Agent Versions

After upgrading the 11.1.x and 11.2.x agents to 11.3 or later, if you want to delete the hosts with older
versions:

1. Go to Hosts view.

2. Filter the hosts based on the Agent version, and delete these hosts.
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If you do not delete, the hosts are deleted based on the Data Retention Policy settings.

Set Hosts Preference

By default, the Hosts view displays a few columns and the hosts are sorted based on the risk score. If
you want to view specific columns and sort data on a specific field:

1. Go to Hosts.

2. Select the columns by clicking £ in the right-hand corner. The following example shows the drop-
down list displayed while adding columns:

Hostname
Risk Score
Agent Last Seen

Can Status

Username

Agent Version

Agent- Driver Error Code

Operating 5

3. Scroll down or enter the keyword to search for the column in the displayed list.

4. Sort the data on the required column.

Note: The selections you make here become your default view every time you log in to the Hosts
view.

Export Host Attributes

You can export up to 100,000 host attributes at a time. To extract the host attributes to a csv file:
1. Go to Hosts.

2. Filter the hosts by selecting the required filter options.
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3. Add columns by clicking E=d in the right-hand corner.

4. Click to export the host attributes to a csv file.

NETWITNESS

¥ Filters X © EPS1-Endpoi.. v A AnalyzeEvents | v~ || OScan v || Tags v $ More Actions

veo Risk scoRe
Select 11710 ® ) LegacyValidati

"
H

11710 ®

H

11700 ®

11710 ®

11710 ®

FERATNO)

11710 ®

11710 ®

D ®@®®®aE

Equals

o
o
o
o
o
u}
o
o
o
o
o
o

You can either save or open the csv file.

Migrate Hosts

Hosts can be migrated from one Endpoint server to another using groups and policy associated with the
host. If a host is migrated, the Server column shows as Migrated. On all the tabs within the Hosts view,
the message Host is migrated to <Server-name> is displayed. You view the host details by clicking the
<Server-name>. The risk score of a migrated host is displayed on all Endpoint servers where it is
present.

Note: Some of the actions are disabled for the migrated host on the selected server, such as start scan,
start stop, analyze events, and others. If you want to perform the required action, select the Endpoint
server to which the host is migrated.

Note: To view only managed hosts, select the Show Only Managed Agents option in the Filters
panel.

Analyzing Risky Users

If you have NetWitness UEBA installed, you can view the alerts associated with users logged in on the
host. To analyze risky users:

1. Go to Hosts.
2. Click the host name you want to analyze.

3. In the Host Details panel, under the Users category, click the name.
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This opens the Entities tab for investigation in a new tab.

HOS[ DETAILS POQLIcY DEITAILS

Show details with values only

Users

Name
SessionID 1

Groups Administrators,Users

Resetting Risk Score of Hosts

You can reset the risk score for a host in these situations:

If the alerts or events triggered by the host or files on the host are false positive, you can make
changes to the Endpoint Application rules or ESA rules.

After you take required action on the host for malicious file activities contributing to the risk score.
When you reset the risk score, all the risk calculation for the host is deleted. When you reset the host's
risk score, it does not change the file's risk score. You can reset the score for a single host or multiple
hosts.

To reset the risk score of the selected host:

L.

Go to Hosts.

2. Select the Endpoint Server or Endpoint Broker.

3. Select one or more hosts and do one of the following:
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NETWITNESS

<’ Filters

8 endpointb

O HOSTNAME

Hosts

% © Tags v

AGENT GROUPS

Users

4 Analyze Events | v ¥ Scan v

RISK SCORE V' OS - DESCRIPTION

indows 10 Ent...

Analyze Events
rise Linux- 7.2

Delete

Start Scan

Network Isolation

Assign Tags
Unassign Tags
Download MFT to Server

Download System Dump to Server

Download Files to Server
Reset Risk Score For Selected Host

Uninstall Selected Agent

Files

Dashboarc Reports

¢ More Actions v

LAST SCAN TIME

09/08/2022 04:37:08 am
08/30/2022 11:02:20 am
10/04/2022 08:04:59 am

10/03/2022 05:59:18 am

¢ Right-click and select Reset Risk Score For Selected Host from the context menu.

¢ Click More Actions > Reset Risk Score For Selected Host in the toolbar.

All the alerts associated with the score are deleted.

4. Refresh the page to view and confirm if the host's score is reset. This may take sometime for changes

to take effect.

To reset the risk score of all the available hosts simultaneously:

L.

Go to Hosts.

2. Click More Actions > Reset Risk Score For All Hosts in the toolbar.
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¢ More Actions v

Upgrade All Agents
Uninstall All Agents

Reset Risk Score For All Hosts

All the alerts associated with the score are deleted.

Investigating Hosts
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Monitor Endpoint Agents' Last-seen Details

NetWitness Platform enables administrators and analysts to regularly create reports and find the details
of all endpoint agents that haven't reported for a specified number of days. By tracking the last-seen
status of endpoint agents, organizations can optimize resource allocation by identifying underutilized
devices or reallocating resources based on actual usage patterns.

Understanding when the endpoint agent was last active provides insights into the overall performance of
the endpoint devices. Monitoring the endpoint agents’ last-seen status is crucial for ensuring security,
compliance, operational efficiency.

NetWitness Investigate allows you to generate various reports and analyze metadata to identify the
event.type = of f1ine parameter, helping you locate all endpoints that have been offline for a
specific period. You can then proceed with further investigations or take necessary actions to address the
offline endpoint issues.

Note: Even after uninstalling the endpoint program from any agent, you will continue to receive agent
offline events from those agents for the duration specified by the data retention settings.

To monitor endpoint agents’ last-seen details

1. Go to Investigate.
2. Select the Endpoint server connected to the agents to determine the list of offline agents.
3. Select a duration, such as Last 24 Hours, to retrieve the details for that period.

4. In the Query bar, type the following:
event.type = offline

5. Click the Search icon and find all offline events.

6. Click on an offline event to view the details of the agent that has been offline for longer than the
specified time.

Note: Whenever the background job runs, a new event will be created for the same agent if it is
offline.

42 Events Events Meta 100 RSA Endpoint| *

- = \ OVERVIEW
EVENT TIME [ Pivotto Host Overview
SESSION ID
O 07/23/202401:33:00pm
®) SYSTEM EVENT
07/23/202401:33:00 pm HOST NAME
© 07/23/2024 01:33:00 pm 2 DESETOP-SEH-GN
07/23/202401:36:00pm
N NWE CATEGORY
Agent has been offine for 4 days
07/23/202401:36:00 pm System Event
COLLECTION TIME

07/23/2024 01:39:00 pm 07/23/2024 01:33:00 pm

EVENT TIME
07/23/202401:33:00 pm
07/23/2024 01:42:00 pm v/ EVENTMETADATA

07/23/2024 01:39:00 pm

07/23/2024.01:42:00 pm

@B 110x bupLicaTES
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Standalone Scan on Air-gapped Windows and Linux

Hosts

The Standalone scan feature allows administrators to run scans on the air-gapped Windows and Linux
hosts that are disconnected from the network. Administrators can download the scan command once
from Ul and execute it on multiple hosts. For the best utilization of resources, NetWitness recommends
running standalone scan every two weeks. Policies do not apply on air-gapped hosts, and features such as
downloading MFT to the server, upgrading agents through UI, downloading a file to the server are not
available for standalone agents.

The scan process involves two files:

o Offline Scan Configuration - Contains the configuration information needed to run the scan.

e Scan Results File - This contains the results of the Scan, which you can upload using the Scan >
Upload Offline Scan File option on the Hosts view. This file will be imported and processed by
NetWitness.
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Standalone scan workflow:

Download Offline Scan
Configuration File
hd

Transfer this configuration
file to the ai-gapped host

Install EP Agent on air-
gapped host

On the air-gapped host,
run the command to
register the agent for

standalone scan (required
only when an agent is
installed).

Execute the scan on the
air-gapped host.
hd

Transfer the scan result file
(password protected zip
file) from the air-gapped

host to trs console

Upload the standalone
scan result file to the
Endpoint server

The Endpoint server will
process the scan result file
once successfully uploaded

1. Hosts > Scan > Download Offline Scan Configuration

2. In the pop-up, type a password.
3. Click Download.

Refer to the Endpoint Agent Installation Guide to find
Generate an Endpoint Agent Packager topic.

On the Windows machine, open the command prompt in
Administrator mode and run the following command:
<servicename.exe> /standalone

Example: NWEAgent .exe /standalone

On the Linux machine, open the Terminal as a root user and run the
following command:
/opt/rsa/nwe-agent/bin/nwe-agent /standalone

Windows: servicename.exe /scan /password "<Password>" /scanfile
"<filepath>"
Example: NWEAgent.exe /scan /password "abc@123" /scanfile Users\sudhah\Downloads\2024-

02-16-Quick Scan Configuration.scanfile"
e Llinux: /opt/rsa/nwe-agent/b nwe-agent /scanfile "<file path>" /

password "<pwd>"

Example: /opt/rsa/nwe-agent/bin/nwe-agent /scanfile "/home/ubuntu/Desktop/2024-02-04-Full
Scan Configuration.scanfile" /password "abc@123"

1. Hosts > Scan > Upload Offline Scan File
2. In the pop-up, Click the folder icon and upload the scan results file.

3. Enter the same password that was entered while dowloading the
offline scan configuration file.

Note: Both Download Offline Scan Configuration and Upload Offline Scan File options are available
only on the Endpoint server view. These options can’t be accessed from Broker view.

Generate the scan configuration file

1. Click Scan > Download Offline Scan Configuration on the Hosts screen.
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NETWITNESS

Y Filters X & Endpoint-Serv... V OScan v || Tags v $ More Actions v/

Download Offline Scan Configuration
¢ ‘] Upload Offline Scan File

19 days ago

7 daysago 15/09/202109:41:25am  Updated

On the Download Offline Scan Configuration pop-up,
2. (Optional) Select CPU Maximum.

3. Enter a Password. (not more than 31 characters long)
4. Click Download.

Download Offline Scan Configuration

Download the scan configuration to perform a scan of all executable files
available in the memory. The total time to complete the scan depends on CPU
Maximum.

5. Transfer the Offline Scan Configuration file to the air-gapped host.

Install Endpoint Agent and Register for Standalone Scan

1. Install the Endpoint Agent on the air-gapped host. Refer to Endpoint Agent Installation Guide for
more information.

2. Register the agent for standalone scan (required only when an agent is installed).

o If you are using a Windows machine, open command prompt in administrator mode and execute
the following command:

ServiceName.exe /standalone
Example: NWEAgent.exe /standalone

o Ifyou are using a Linux machine, open the terminal as a root user and execute the following
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command:

/opt/rsa/nwe-agent/bin/nwe-agent /standalone

Start a Standalone scan on Windows

1. Open the command prompt in Administrator mode, on the air-gapped host.

2. Execute the scan using the following command (syntax):

ServiceName.exe /scan /password ”<password>” /scanfile "<filepath>”"

Example: NWEAgent.exe /scan /password "Abcl23$" /scanfile
"C:\Users\johndoe\Downloads\2021-12-06-Full Scan Configuration.scanfile"

e <password> is the password entered while generating the Offline Scan Configuration File.
e <filepath> is name of the scan configuration file with full path.

3. Wait until the scan is completed.

4. Transfer the scan result file (password protected .zip file) to upload to the UI.

Start a Standalone scan on Linux

1. Open the terminal as a root user, on the air-gapped host.

2. Execute the scan using the following command (syntax):

/opt/rsa/nwe-agent/bin/nwe-agent /scanfile "<file path>" /password "<pwd>"

Example: /opt/rsa/nwe-agent/bin/nwe-agent /scanfile "/home/ubuntu/Desktop/2024-
02-04-Full Scan Configuration.scanfile" /password "abc@123"

3. Wait until the scan is completed.

4. Transfer the scan result file (password protected .zip file) to upload to the UL

Upload the Standalone scan result file

1. Click Scan > Upload Offline Scan File on the Hosts screen.
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Upload Offline Scan File

Select file to upload....

LE

WIN-6D0OQ1D01L03-1d79056756e9e51.zip

o

2. Click and upload the scan result file.
3. Enter the same password that was entered while downloading the offline scan configuration file.
4. The Endpoint server will process the scan result file once successfully uploaded.

NETWITNESS

Y Filters

Note: Standalone agents can only be upgraded manually using the Endpoint agent packager. Refer to
Generate an Endpoint Agent Packager on Endpoint Agent Installation Guide for more information.
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Investigating a Process

Note: The information in this topic applies to NetWitness Version 11.3 and later.

Analysts can perform process analysis to investigate a particular process behavior to:

* Understand the entire process event chain, process parent-child relationships, and all associated events
in a timeline view.

* Analyze important process attributes, such as username, launch arguments, reputation, file status,
signer, signature, risk score, and file path.

The Analyze Process view provides a list of processes captured on hosts in a parent-child hierarchical
format over a time range. The process tree is created from the tracking event type "Process event" where
the action meta key is createProcess. The agent reports new events for the same createProcess if the
following parameters change:

» Parent process filename
e Child process filename
e Launch arguments

e User name

If the above parameters do not change, the event is reported only once every eight hours.

Best Practices

When reviewing a host for malicious activity, there are a few key things to review while looking for
malicious processes.

e Process Name - When reviewing running processes on a host, check for the name of the program that
looks suspicious. Sometimes malware uses random names, such as wzuduje.exe. In some cases, the
names might be misleading such as adob3.exe, scvhost.exe, or Microsoft.exe. Being familiar
with Windows processes and any type of internal tool that might be used throughout the environment,
also helps you to identify potentially malicious or suspicious files.

o File Path - Similar to knowing normal and key Windows processes, knowing what path the processes
originate from is a key to detect certain processes that imitate the legitimate process. For instance, if
you see svchost.exe running on a system from
C:\Users\<username>\AppData\Roaming\adobe\ (which is a valid file path), and knowing
that the legitimate Windows process originates from C: \Windows\System32\, you can determine
that the svchost . exe file starting from the C:\Users\<username>\AppData\Roaming\adobe\
directory is the suspicious one. To help determine further identification of a suspicious process,
review the Autoruns tab to see if this process is running as an autorun, service, or task.

« File Signature - When a software package is created, it has a valid digital signature. The following are
a few exceptions:

e [f a process that is running is not digitally signed, it does not automatically confirm that the file is
malicious.
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* While files may have a valid signature, it does not mean that they are legitimate. There are
instances of software identified as a Potentially Unwanted Program (PUP) or Adware, which can
have a valid signing certificate.

On Hosts - Indicates the number of hosts on which a file exist. If a file is present on fewer hosts with
a high risk score, it may be malicious and needs further investigation.

Reputation - Leveraging the reputation service is a way to find malicious processes.

Analyze events - For further insight to a process, you can analyze console events, network events, file
events, process events, and registry events.

¢ Network events - Look for any suspicious domains to which the process is connecting. Sometimes
malware creates legitimate connections to a known site, such as google.com, bing.com to hide its
activity on the network. Look for connections to Dynamic DNS domains where a lot of known
malicious activity resides. During analysis, consider uncommon processes making direct
connections to an IP address or to a uncommon port number.

 File and process events - Review process interactions that have occurred on the system with the
suspected file. You can look for key events such as writeToExecutable, renameExecutable,
and createRemoteThread, which indicate suspicious behavior.

Leverage other methods

¢ Look up with Google - You can search the file name or hash value against Google to determine if
the file is malicious.

e Look up with VirusTotal — You can search the hash value against the VirusTotal to determine if the
file is malicious between multiple AV vendors.

o Download file — Download and analyze a file to find indicators such as compile time, imported
DLLs, section names, and performing string searches. Look for TLD values (.com, .net, .biz) or
debug information of a compiled binary (.pdb), which can be easily changed or forged.

o Time stamp values — Review modified, accessed, and created dates associated with the binary.
Review how long a file has been residing on a host. While this value is correct most of the time,
attackers can change the time stamp values of a file.

Analyze a Process

Based on the Alert severity, you can analyze the processes using two different options:

e View Alert Details: This option allows you to analyze the processes associated with Critical and
High Alerts.

o Analyze Process Tree: This option allows you to analyze the processes associated with Medium

Alerts.

To analyze the process associated with Critical and High Alerts:

Go to Hosts and click on a host.

2. Click on an event associated with the Critical or High alert on the Host Details view. The Event

Details panel appears.
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3. Click View Alert Details to analyze the process activities of a file associated with the Critical or
High Alerts.

ALERTS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY YARA RULES

SEVERITY

HighAlerts @ Event Details

3 cess W P! orted Suspicious (16 events)
B Investigate Timeline @ View Alert Details

tched Yara Rule (40 events)

Parent (5 events) Summary

EVENT TIME SUMMARY cmd.exe created process 1sass.exe

09/21/2022 03:53:46.000 pm cmd.exe created process lsass.exe .
Overview

09/21/2022 12:30:10.000 pm cmd.exe created process 1sass.exe
TARGET FILENAME

09/21/2022 06:38:21.000 am cmd.exe created process lsass.exe Isass.exe

09/21/2022 06:34:22.000 am browser_broker.exe created process 1sass.exe TARGET COMMAND LINE

N/A
09/21/2022 06:35:22.000 am explorer.exe created process lsass.exe

TARGET DIRECTORY
C:\Windows\System32\

Ous (101 nts)

TARGET USER

TARGET HASH

aa52b2d3dd4b9b47f4496c0460bdedda791354018cf0782b89
9ef28acee8d21

The Process Tree Viewer is displayed in the Respond service.

4. Select the process in the Process Tree Viewer and click File Actions in the Details panel to perform
the following actions:

¢ Google Lookup

o VirusTotal Lookup

¢ Change File Status

* Download File to Server
¢ Analyze File

e Save a Local Copy
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¢ Reset Risk Score

NETWITNESS vestig Respond
70) Un

INCIDENTID  CREATED HOSTNAME  TACTIC TECHNIQUE
9/21/2022 f asquerading

EVENT TIME SUMMARY TARGET PARAM SOURCE PARAM USER SOURCE

Details
09/21/202203:53:46000pm  cnd.exe created process lsass. exe NA cmd.exe WINDOWS\ecat

b Investigate Timeline | | File Actions
Process Tree Viewer L e el

< Google Lookup

Summary
(o) oskmixe < VirusTotal Lookup

cmd.exe created process 1|
Change File Status
(o) smssexe t

Download File to Server

L’ @ smss.exe

I—» @ winlogon.exe CommandLine Reset Risk Score

A

File Status

Neutral

Reputation Status
400 explorer.exe own Good
Signed By
I—o 80) cmd.exe

Directory

Windc
L» @ Isass.exe User

To analyze the process associated with Medium Alerts:

Filename

1. Go to Hosts and click on a host.

2. Click on an event associated with the Medium alert on the Host Details view. The Event Details
panel appears.

3. To analyze the process activities of a file associated with the Medium Alerts, do one of the
following:

o In the Event Details panel, click Analyze Process Tree.

o Select the Processes tab and do one of the following:
- Right-click a process and select Analyze Process from the context menu.
- Click Analyze Process in the toolbar.

In the following example, the file cmd . exe has created process net . exe.

AUTORUNS  FILES  DRIVERS  LIBRARIES s OADS SYSTEM INFO  HISTORY

SEVERITY f
Medium Alerts @ Event Details

1 | QD rumerates Lo yunt Policy (1 events Event Metadata
B Investigate Timeline % Analyze Process Tree

EvenT TIME SUMMARY
\ 18> | @@mocouruicares
09/27/2022 01:52:52.000 am cmd.exe created process net.exe Summary

Q@D | loating Mod cnd. exe created process net.exe v
QI I oot of P

5

SESSIONID

TARGET FILENAME 50329

net.exe = TIME

2l 09/27/202201:55:38 am
TARGET COMMAND LINE

net.exe ACCOUNTS

SIZE

TARGET DIRECTORY

C:\Windows\system32\ endpointloghybrid1

TARGET USER FORWARD.IP

TARGET HASH & MEDIUM
0bd94a338eea5ade1f2830ae326e6d19 =32
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Clicking Analyze Process displays the process visualization. For each node, the process name, risk

score, and type of activity the selected process has performed (network . file . or registry -)
are dlsplayed. Optionally, you can change the time range to view data.

You can view the properties, such as process execution details, file properties of the selected process
in the bottom of the view.

PO
earch64 file iconPresent fileversionl . msvert dilntdlLdll api-ms-win-core-kemel32-4

. rdata_dats, pata, didat.rsrc. reloc

Windows Command Processor

Note: No result is displayed in the process visualization view if there is no data for last seven days
or if there is no createprocess event.

4. On the right side of the process visualization view:

¢ Click Events List to view the associated events. You can also filter events based on the events
category. For more information on filtering, see Analyze Events for a Process.

¢ Click Hosts to view the hosts on which this file is present and the associated risk score. For more
information, Analyze Hosts with File Activity.

¢ Click Risk Details to view the list of distinct alerts, such as Critical, High, Medium, and All. For
more information, see Analyze Hosts Using the Risk Score.

5. Hover over the process name to analyze important process attributes, such as username, launch
arguments, reputation, file status, signer, signature, and file path.
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NT AUTHORITY\SYSTEM

Signed

cwindows\system 32,

cmil.ee c\Suspicious bat
c\Suspcious.psl

(¥ Copy Launch Arguments

6. Click @ to view the child processes. The Process selection dialog is displayed with the child
processes associated with the process based on the risk score. You can filter the result on the event
type by clicking icons on the top panel. When no matching event types are available, these filter
options are disabled.

Depending on the type of event, the icons are highlights in the Event Types column.

a. Click View All to view all child processes or select the required processes and click View
selected. The associated events and properties are displayed in the right panel.
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N N © |
b. Click to change the process selection and click to collapse the view.

[Folai}

Al(70) @ Network{12) OFie(s)
PROCESS NAME RISE SCORE LAUNCH ARGUMENTS EVENT TYPES

omd exe /i certutil exe -uricadhe -spiit - httpsiew__ I

oot s (hd T -Foroehfl

omd e o dir /b /a-d Mtest-set=\"mollecfion™ hat
ping-n5 127001

Tzee e-bbl -paptsimulsion “Cmimieizlenc-files

Tz =e e -bbl -paptsimulator "c\mimilatzhenc-files

0
0
0
0
0
0

omd e fc dir /b /a-d Ltest-sets\"oommand-and-oon_
Showing 70 out of 70 | 70 selected

70 Process selected Cancel View all View Selected

Analyze Events for a Process

To analyze events for the selected process:

1. Perform steps 1 to 3 in To analyze the process associated with Medium Alerts:.

2. In the process visualization, click the Events tab.

3. To narrow down the search to find any suspicious indicators, behaviors, or specific type of event,
filter on a set of matched events based on a category - Process, File, Registry, Network Event, or
Console Event (for Windows).
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For example, to view only process events, select the Process Event category, and filter on action.

rents List (F46) E Ho

EVENT TIME CATEGORY ACTION  SOURCE FILE NAME SOURCE PARAMETER SOURCE DIRECTORY
11/25/201906:5...  Process Event openPr.. edlorerexe CWYindows',
& 1903:0.. Process Event openPr.. edxloreree CWWindows',
1157 191141 . Process Event openPr_.  edgplorerexe C\Windows',
1157 1707-1.. Proocess Event openPr_.  egplorerexe CVWindows',
11/ 15 - Process Event openPr..  explorerexe CWYindows',
1112 19 103, Process Event openPr.. edxloreree CWWindows',
147 19 06:4_. Process Event openPr_.  edqloreree C\Windows',

11,25, F025.. Proocess Event openPr_.  egplorerexe CVWindows',

(openProcess| 11/

Process Event openPr.. edlorerexe CWYindows',
1112 .. Process Event openPr.. edxloreree CWWindows',
14/29/2019 ] Process Event openPr_. =vchostexe -k netsves -p CWWindows! System3T,

11/ 15 . ProcessEvent  apenPr_. @ CWindaws! System3,

The result displays the sequence of activities involving this process for the selected filters.

Note: For the console events, the context for local and remote are available only if the data is sent
from 11.4 or later agents.

Note: At any given time, if the number of process events created from a single source VPID in Linux
exceeds the count of 100, only the first 100 events are displayed in the Process Visualization > Events
view for a time interval of 8 hours. Only after the time interval of 8 hours, the new set of events
created from the same source VPID (maximum 100 process events) will be displayed along with the
existing set of events.

For Example: At 12PM IST, if 1000 process events are created from a single source VPID, only the
first 100 events are displayed in the Process Visualization > Events view until $PM IST. After SPM
IST on the same day, the new set of 100 events created after §PM IST from the same source VPID
will be displayed along with the existing set of events.
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Changing File Status or Remediate

Note: By default, the blocking option is disabled in the policy. To enable blocking, in the policy
configuration, change the Blocking option to Enabled under Response Action Settings. For more
information, see the NetWitness Endpoint Configuration Guide.

To change the status of a file:

1. Do one of the following:
¢ Go to Hosts (Processes, Autoruns, Files, Drivers, Libraries, or Anomalies tab).
¢ QGo to Files.

2. Select one or more files and do one of the following:

NETWITNESS

Y Filters X S EPS1-Endpoi... v ‘& Change File Status  Analyze Events | v $ More Actions v [3

FILENAME RISKSCORE  + FIRST SEEN TIME ON HOSTS. REPUTATION SIGNATURE PERESOURCES.C.. FILESTATUS 3
09/15/202105:58:3... 3 microsoft signedyalid,ca... Microsoft Corpor... ~Blacklisted
10/29/202102:552:1... 4

- Change File Status
Equals 09/27/202111: n Neutral

Analyze Events
Google Lookup S 11/08/202110:32:4 - icrosoftsignedyalid Microsoft Corpor... Neutral
VirusTotal Lookup 11/05/202105:54:1... - 36 microsoft signedyalid,ca... Microsoft Corpor...  Neutral
11/02/202103:48:2.
11/02/202101:59:4..
Save a Local Copy 10/29/202105:440... ros Microsoft Corpor...  Neutral
Analyze File
10/29/202101:310... - microsoft signedyalid,ca... Microsoft Corpor... ~ Neutral
Scan with OPSWAT
10/25/202109:4890... - signedyalid - Neutral
Reset Risk Score
10/25/202109:48:.
09/23/202107:28:3.
09/23/202107:2833.. unsigned Neutral
09/23/202107:28:3, - unsigned Neutral
09/23/202107:28:3. - unsigned Neutral
09/23/202107:28:3.

09/23/202107:28:3.

¢ Right-click and select Change File Status from the context menu.

¢ Click Change File Status in the toolbar.
3. In the Change File Status dialog, select a status - Blacklist, Whitelist, Graylist, or Neutral.
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Change File Status

STATUS

Blacklist

Note: You cannot whitelist certain Microsoft files, such as cscript.exe, wscript.exe,
cmd.exe, bash.exe, as there is a potential risk of them being used for malicious purposes. For
more information, see Files Restricted from Whitelisting.

If you select Blacklist or Graylist, the following options are displayed:

a. Category: Select the appropriate category type: Generic Malware, APT: Advanced Persistent
Threats, Attacker Tool, Unidentified, Ransomware.

Caution: Before blocking, make sure that you review the file because this may cause the
system or software to be unusable.

b. Remediate: Select Block to block the file.
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Note: Blocking is supported only for Windows hosts that are running in advanced mode. All
PE files along with the following file extensions can be blocked.

.exe, .com, .sys, .dll, .scr, .ocx, .bat, psl, vbs, .vbe, vb, wsh, wsf, .cmd

You cannot block the following:.

- Memory DLL and floating code

- Files that are signed by Microsoft or RSA.

To delete a blocked file, users can log in to the host and execute the delete command using the
elevated command prompt.

4. Add a comment and click Save.

You can change the status of only 100 files at a time. When the status is changed, it impacts the file
status on all hosts on which the file is present. The status is sent as a session under the File category, and
available for investigation. If the file is seen in subsequent scan or tracking, the corresponding sessions
contain a meta value with the file status (except Neutral).

Import File Hashes using the Block Hash tool

The Block Hash tool allows you to import a set of file hashes which can be set to block state and change
the file bias status (whitelist, blacklist, and graylist). The tool allows you to block the imported file
hashes (suspicious, invalid, and malicious) and prevent them from opening or executing on the hosts.
You can block up to a maximum of 50,000 file hashes using this tool.

Note: For more information on changing the file status or blocking the file, see Changing File Status
or Remediate.

IMPORTANT:

- Enter only valid SHA256 hashes; otherwise, the blocking functionality might break.

- Do not block any file hashes signed by RSA, Microsoft, and Apple. It might make your Endpoints
unresponsive.

- Make sure the number of hashes entered in the JSON file is less than the number of the available
limit of hashes that can be blocked (the maximum limit is 50,000).

For example: If 100 file hashes are already blocked as part of NetWitness deployment, you can only
block 49,900 more file hashes using this tool.

JSON File Format

The example below describes the JSON file format for blocking and blacklisting the file hashes.
Sample demoblock.JSON:
[{

"checksums":
["1b30e463ebe0131db66fce7d4aadl3f3e149064d85c4c0dc5218b077886da2804","67fa30e4
63ebe0131dbo6fce7d4aad3f3e149064d85¢c4c0dc5218b077dsbhb561", "78vbba909e463ebel
131dsdsdb66fce7d4aad3f3eldsdsd49064d85dsdsmaneln"],

"fileStatus": "Blacklist",
"comment”: "File blocking set through new tool",
"remediationAction": "Block"

H
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The example below describes the JSON file format only for blacklisting the file hashes.
Sample demoblock.JSON:
[{

"checksums":
["2b30ed463ebe0131db66fce7d4aad3£f3e149064d85¢c4c0dc5218b077886daz2800","97fa30e4

63ebe0131db66fce7d4aad3f3e149064d85¢c4c0dc5218b077dsbhb500"™, "38vbba909e463ebel
131dsdsdbb66fce7d4aad3f3eldsdsd49064d85dsdsman68c" ],

"fileStatus": "Blacklist",

"comment": "File status change set through new tool",

]

To block the file hashes using the Block Hash tool:

1. SSH to node 0 and copy the JSON file (containing the file hashes to be blocked) stored in it.
2. Run the tool.

nw-block-hashes-tool <absolute path of json residing on node 0> <ESA node
IP/hostname>

Note: Enter the JSON file path in <absolute path of json residing on node 0> and
enter the ESA node IP in <ESA node IP/hostname>.
For Example: nw-block-hashes-tool /root/demoblock.json 10.125.250.118.

[root@adminserver ~]# nw-block-hashes-tool /root/demoblock.json 10.1
Enter the Admin Server password

Password:

This script allows you to upload a list of file hashes for blocking.
You can block up to 50k file hashes using this script.

This script will not change or override any of the analyst's actions
You should strictly follow the instructions mentioned below:

RRSEXX IMPORTANT Instructions

*Enter only valid SHA25 - erw blocking functionality might break
block any file S E g by RSA, Microsoft and Apple. It might make your Endpoints unresponsive.
' to proceed, 'no' to stop:

Fetching the count of available hashes

3 hashes are blocked already

Please Enter the password of ESA Primary Node

FIPS mode initialized

I've read & consent to terms in IS user agreement.

root@10.125. 25¢ 3's password:

"File status import will run in background. Verify after sometime."

***%*xScript execution is completed nowx*#**

[root@adminserver ~J# I
3. Enter the Admin Server password.

4. Follow the instructions displayed on the screen. Enter any one of the following options when
prompted.
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Fil

o yes: Enter yes to proceed with the execution of the script.

o no: Enter no to stop the execution of the script.

maximum limit of 50,000, the tool stops the execution, and

Note: At this stage, the tool validates the number of incoming file hashes through the JSON file
and the number of existing file hashes already blocked in the deployment. If the total of the file
hashes (incoming through JSON file and existing as blocked in the deployment) exceeds the

it will not proceed further.

es Restricted from Whitelisting

To view or update the files that are restricted from whitelisting, do the following:

1.
2.

On the NW server, run the nw-shell command from the command line.

Run the 1ogin command and enter your credentials.

3. Connect to the Endpoint Server using the following command:

connect endpoint-server

Run the following commands to view the list of files:
e cd endpoint/file/status/restricted/get
e invoke Whitelist

Run the following commands to add files to the list:

e cd endpoint/file/status/restricted/get

e invoke '{"id":"<filename>","restrictedStatus"
"enable":true}

Run the following commands to delete files from the list:
e cd endpoint/file/status/restricted/update

e invoke '{"id":"<filename>","restrictedStatus"
"enable":false}

: ["Whitelist"],

:["Whitelist"],
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Analyzing Downloaded Files

To perform a deep analysis of suspicious files, you can manually or automatically download the file to
the server.

Note: Saving or analyzing downloaded file works the same way irrespective of whether the file is
downloaded manually or automatically.

Note: Downloaded files are stored in the Endpoint Server which may fill up the disk space. To utilize
the storage efficiently without impacting the health of Endpoint Server, NetWitness recommends you
to configure an external storage mount, so all the Endpoint Server can use the configured location to
store the downloaded data.

By default, all files are downloaded to /var/netwitness/endpoint-server/<files>/. If you
want to change the location, make sure that you have endpoint-server.configuration.manage
permissions and do the following:

1. In the Explore view, go to endpoint/download,

2. In the base-path, provide the location of the directory.

Caution: By default, the status File Download Disk Usage stats in the Health and Wellness view
shows unhealthy if the disk usage reaches 60% and the file download stops automatically when the

disk usage is 70%. You can customize the warning or fatal thresholds in the O > Services >

Endpoint Server > view > Explore > rsa.endpoint.file-download-disk-thresholds.warning-percent
and rsa.endpoint.file-download-disk-thresholds.fatal-percent parameters respectively.

For the downloaded file, you can:

» Search for strings in the executable

* View text content for scripts

e View imported libraries and functions

e Save a local copy for further analysis

Download Files to Server

Downloading file to server is not supported for memory DLL and floating code.

Note: Downloading files may take significant time. Additional requests to the agent during download
are queued and processed when the download is complete.
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Automatic File Download

By default, the files that are unsigned and size lesser than or equal to 1 MB are downloaded
automatically to the NetWitness Endpoint server. And, only single copy of each file is downloaded

%

automatically. You can limit the volume of files to be downloaded in the O > Endpoint Sources
> Policies tab, so the files matching certain criteria are only downloaded automatically. For more
information on automatic file download settings, see "Create an EDR Policy" section in the NetWitness
Endpoint Configuration Guide.

The status of the download is displayed in the Files tab > Downloaded column.

Manual File Download

To manually download files to the server from the Hosts view:
1. Go to Hosts.

2. Select the hostname to open the Host Details view.

3. In any of the Processes, Autoruns, Files, Drivers, Libraries, or Anomalies tabs, select the file, and do
one of the following:

NETWITNESS

AGENT SCA

Pk ATUS A SEEN o
100 @ 3 snapsroT Tive  11/15/202103:46:07 pm

Scanning

ALERTS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters X Processes Z Analyze Process & Change File Status [ Analyze Events | v # More Actions TREE VIEW

Google Lookup >
PROCESS NAME O Process NAME 7 LOCALRISKSCORE  GLOBAL RISK SCORE ATUS  DOWNLOADED FLEpATH @

VirusTotal Lookup >
Equals

I 100 |
|
Analyze Process Download Process Dump to Server

CAWindows\S)

I C:\Windows\Syst
Change File Status || Download File to Server

Analyze Events C:\Windows\Syst

Google Lookup C:\Windows\
VirusTotal Lookup C:\Windows\
AWi

Download Process Dump to Server -
Neutral C:\Program Files\

Download File to Server Neutral C:\Program Files\

Neutral C:\Program Files\
O Known Good

Blacklisted T C:AWindows\Syst
O Invalid

Blacklisted = C:\Windows\Syst

Blacklisted C:AWindows\Syst

Blarbiictad = AW Gurch

¢ Right-click and select Download File to Server from the context menu.

¢ Select Download File to Server from the More Actions drop-down list in the toolbar.

To download files to the server from the Files view:
1. Go to Files.

2. Select the file and do one of the following:
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NETWITNESS

Y Filters x © endpointbrok... ~/ $ More Actions v

Change File Status
Analyze Events

| Google Lookup
VirusTotal Lookup

View Certificates

Download File to Server

o
o
o
o
u]
u}
u}

Reset Risk Score

o

icrosoft Corpo...  Neutral

¢ Right-click and select Download File to Server from the context menu.

¢ Select Download File to Server from the More Actions drop-down list in the toolbar.

The status of the download is displayed in the Downloaded column. The download statuses are
Downloaded, Not downloaded, and Error.

Save Downloaded Files

You can retrieve a downloaded file and save it to your local file system for further analysis. Downloaded
files are stored in the server in the configured location. This option is enabled only if the file is
downloaded to the server.

To save a file:
1. Go to Hosts or Files .
2. Right-click the file you want to save and select Save a Local Copy.

3. Browse the location and click Save.

Analyze Downloaded Files

You can use the Analyze File option to view detailed information about a downloaded file. This option
is enabled only if the file is downloaded to the server. To analyze a file:

1. Go to Hosts or Files.

2. Right-click the downloaded file and select Analyze File. The File Analysis view opens and
properties of the are is displayed in the right panel.
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NETWITNESS Respond Users  Hosts

AGEN SEEN AGENT VERSION

.
100 g i 11/15/202103:46:07 pm

Scanning 8days ago

ALERTS  PROC S  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Files | File Analysis - Strings View

DETAILS

STRING OFFSET uNICODE LENGTH
@eez 0x00014A15

70exception@std@@QEAA@AEBQEBD@Z 0x00015110 Show details with values only

H9u 0x000010A8 - File Detail

allocator@D@2@@std@@QEAAGHEZ 0x00014FDD - Format pe

2f3dab196682a24b2aa72e1b2f78f511
getSignedSamiToken 0x0000CF80

dbb953b38635d35bcA88aeB90bbB7d5ed14303c
H;S0s. 0x00000800
6 7d8248cf4ecd6(72c361051e2b977b1b12ddfc268cccAC695...

Before beginning impersonation 0x0000D190
955K8

KPEBD11@Z 00012072 7d8248cf4ecd6(72c361051e2b977b1b12ddf268cccAChS..
TCafSmartPtr@UiVariant@Caf@@U12@@@V? 0x000130BB ownlc th  Aar/netwitness/endpoint-server/files/7d824
num properties - %d 0x0000C758

D8PhuZH 0x00001300
AMD64/x64

Executable,Large Address Aware,DLL

Showing 51

3. View strings in the file in the Strings view while analyzing an executable (such as macho, pe, el1£).
This view contains the string, offset in the binary, unicode, and the length of the string. You can
search for or filter on a specific string value in the Filter String field.

4. View the text content of the file and look for any suspicious behavior in the script file.

For example, if the file contains C2 information in the form of domain names or IP addresses, it is
highly suspicious.

100 (e

Idle amonthago

ALERTS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ANOMALIES ~DOWNLOADS  SYSTEM INFO  HISTORY

‘ File An: Strings View FutersTRINGs M3 Exec.exe

sTiNG oFeseT unicoe LENGTH
0x00000A07 v 19

0x00000A96 v 22 Show details with values only

0400000828 v 2 File Details
pe
d16f277c8d94437b751917d87ddc8d91
60ec5ca33072dff849a1d9eac946c20834a4...
b266afb334f3dec596dac6501f70994c8f942...
6.0 KB
b266afb334f3dec596dac6501f70994c8f942...

ach /var/netwitness/endpoint-server/files/b266a

1386/x86

Executable,Large Address Aware

01/14/2019 10:20:25.000 am

0X00002C4A

Windows Console

Showing 3 of 123 strings

If you see unprintable keyboard keys listed within the file, such as: [F1], [F2]...[Page Up], [Enter],
[ESC], and so on, that may be indicative of a keystroke logger.
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AGENT LAST SEEN

100

amonth ago

KEYLOG
ALERTS  PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES  ANOMALIES \DS YSTEM INFO  HISTORY

File Analysis - Strings View  riurer stines

sTRING orrser unicoDE LenGTH

[oen] 000055070

] 000055128

[Rightl 0x00055068

SVAIZ 0x0004612F pe
5242de7eee306123c50c1d0dcad83062

292026222 000061810

daccA0cfoedb8dsScdce6615e506209¢f18..
010005505
c9eb0aad0ean22685a6aceaa24136e98472...

elere 0
deletef] 0300056100 10K

TIEO0RSENER. Ox00062308 9eb0aad0eaa22685a6aceaa24136e98472.

faOri 0x0005C2F4 th Nvarmetwitness/endpoint server/files/coebo
TCIKTSTINg? 000062015
[PageDown] 00005511 e
newl) 000056078 Charact Executable32-bi

thur 0x00056610 mpile Time  02/22/2019 11:46:23.000 am
o1apal 000061809 Q000
55515 0:00062489
re 0:0005C5CB

[Num Lock] 000055218

[End] 0x00055060

Showing 29 of 1510 strings
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Performing Host Forensics

Note: The information in this topic applies to NetWitness Version 11.4 and later.

You can perform the following forensic investigation on a host:
* Master File Table (MFT)
e System Dump

e Process Dump

Note: This is applicable only for Windows agent (in Advanced mode) with NetWitness Platform
version 11.4. Downloading system dump files may take significant time. Additional requests to the
agent during system dump download are queued and processed when the download is complete.

MFT, system dump, and process dump downloads are not supported for agents communicating through
Relay server.

Note: MFT, system dump, and process dump are stored in the Endpoint Server which may fill up the
disk space. For large deployments, to utilize the storage efficiently without impacting the health of
Endpoint Server, NetWitness recommends you to configure an external storage mount, so all the
Endpoint Server can use the configured location to store the downloaded data.

By default, all files are downloaded to /var/netwitness/endpoint-server/<file type>/,
where <file type> is MFT, system dump, or process dump. If you want to change the location,
make sure that you have endpoint-server.configuration.manage permissions and do the following:

1. In the Explore view, go to endpoint/download.

2. In the base-path, provide the location of the directory.

Download Master File Table

Master File Table contains metadata of every file on the host. It keeps track of information, such as
filename, size, timestamps, permissions, and location of the file on the host. It consists of two sets of
timestamps - Standard Information ($SI) and File Name ($FN). Each set has the following timestamps -
creation, access, update, and modification.

Time stomping is a technique that modifies the timestamps for a file (creation, access, update, and
modification time) to mimic files that are in the same folder, making it difficult to identify suspicious
files on a host. To perform forensic investigation of a suspicious file, you can download and analyze the
MFT, and focus on files that are time stomped. For more information, see Analyze Downloaded MFT.

During MFT analysis, you can also search for suspicious filenames, and also files that were created
before or after a known malicious event. You can also download files from the MFT viewer for further
analysis.

Download MFT to Server

To download MFT to the server from the Hosts view:
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1. Go to Hosts and do one the following:

o Select one or more hosts and select Download MFT to Server from the right-click context menu,
or from the More Actions drop-down list in the toolbar.

NETWITNESS IR | Hosts

Y Filters S Broker - Endp...  Analyze Events | Vv || OScan v £ More Actions ™/

eset Risk Score
Delete

Downioad MFT toServer CBDDF1D7-1343-9664-1D40-9EAEB7868681

DO Sy te e 0 Server BOBAD2CE-96C0-2CBF-BEFC-31FA289A5223
Download Files to Server ) 89A2B44A-76BC-2F44-ABBS-B5ABDFOBDEBY
Upgrade Agent ® BC7DCEG0-95AD-8F9E-FBOS-75DAIDA001D9
Uninstall Agent 6F7008E4-OF 1B-4A7B-BC70-3FBFDBC34AB6
5CFE11DCF91D-43C5-BIFA-FBD464DF7A4F

11510 F5489124-E77E-402D-A636-9ADI553DD477

11510 861381D8-AB24-4EFF-9F2A-FOCDA3144026

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Download MFT to Server.

2. In the Download MFT to Server dialog, select one of the following:
e System Drive - to download MFT to the system drive.

¢ Select Drive - to download MFT on assigned drive.
You can select any drive from the Drive drop-down list. By default the selected drive is C.

¢ Specify NTFS mount path - to download MFT on the path to the folder where it is mounted
Click Download.

Download MFT to Server

Download MFT of a volume by selecting its assigned drive or path to the
folder where it is mounted.
m Drive
O Select Drive

O Specify NTFS mount path

Cancel Download

3. View details of the downloaded MFT in the Downloads tab within the host details. For more
information, see Hosts View - Downloads Tab.

116 Performing Host Forensics



NetWitness Endpoint User Guide

NETWITNESS vestigat e v Hosts

100

Idle afew seconds ago
ALERTS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY
¥ Filters x  Downloads

0 Name DOWNLOADED  size DOWNLOADED TIME sHA256 FILE PATH
8] - v 1973M8 7 minutes ago NA (<

[0 > C:\Users\"\NTUSER DAT - - 24 minutes ago

0O > C\Users\um exe\exe\" - adayago

O >e - = 2days ago

o

Equals

Analyze Downloaded MFT

You can use the MFT viewer to begin analysis where you can search for files based on file name, time
stamps, and identify files that are timestomped.

View MFT

To view the content of the downloaded MFT:

1. Go to Hosts.

2. Select the hostname to open the host details and select the Downloads tab.
3. Click the file name. The MFT viewer is displayed.

All available files are displayed in a tree view similar to the Windows Explorer in the All Files
folder. The Deleted Files folder contains a sequential list of all deleted files.

Performing Host Forensics 117



NetWitness Endpoint User Guide

NETWITNESS

100

ALERTS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO

| < Downloads || V7 Fitters | MFT Viewer

MFT-C-WINDOWS10-2019-11-14T06-47-52- 7772 [  wName CREATION TIME ($FN)

v 8c: E  NWE-Trace-Oclctxt 11/12/2019 07:02:03 pm
> [ inetpub
O ™P
O wampb4
0 Windows
Users

NWE-Trace-Oaccrar 111272019 11:54:16 am

®

@

NWE-Trace-Oacctxt 11/12/2019 1248:33am

NWE-Trace-0f80.rar 19/12/2019 1208:39 am

®

)

J ProgramData NWE-Trace-0f80.txt 11/11/2019 09:25:01 pm
7 Program Files (x86)
) $RecydeBin
) Perflogs
Program Files
- $Extend
(J Recovery
= Documents and Settings
> [ System Volume Information

NWE-Trace-OaSctxt 11/11/201907:32:11 pm

®

NWE-Trace-Ocd4 - Copy.txt 11/11/2019 06:56:29 pm

NWE-Trace-1fc0.bt 11/11/2019 05:44:35pm

1)

)

NWE-Trace-Ocd4.txt 11/11/2019 05:43:31 pm

NWE-Trace-0c30.txt 11/11/2019 05:42:05 pm

(0}

(0}

11/11/2019 05:03:16
DELETED FILES DataCollectorO1.csv oo

(i

NWE-Trace-264c - Copy.bt 11/11/2019 0502:52 pm
ALL FILES

0O 00 0 0 00 0D D 00D
()

(0}

NWE-Trace-264c txt 11/06/2019 09:38:24 pm

4. Click P4 to view the folder structure. Click the row to view the folder content.

The details of the MFT is displayed in the table. By default, the table is sorted on the creation time

($EN). If the $ST and $FN timestamps are different, the columns are highlighted in red (.)
indicating that it is time stomped.

NETWITNESS

= g AGONT LAST SEEN
e sy

ALERTS RO AUTORUNS  FILES DRIVERS LIBRARIES ANOMALIES ~DOWNLOADS  SYSTEM INFO  HISTORY

< Downloads ¥V Filters MFT Viewer

MET-C-INGSMUDALPLAC 2019 11-29T09- 1065307 'CREATION TIME ($FN) 4 CREATION TIME ($51) 'MODIFICATION TIME ($FN) MODIFICATION TIME ($51) /ACCESS TIME ($FN) /ACCESS TIME ($51)

G# Origin Festure Branch
Git Origin Master

1110201906706 3m 11/11/201906:1706 3m 112019061706 3m 1111/201906:47.06 3m

z 11/07/201901:0228om 19010238 pem

DeepWeb 2015) VTSAG]
) Ge
SysintematiSuite 3 110772019 125722 0m 110772019 125732 0m

11/07/201901:01:54pm 11/07/201901:01:54pm 11/07/201901:01:54 pm

09/14/201911:5402 3m 0971472019 11:54023m 09/14/2019 11:5402am 09/14/201911:5402 am

02/22/20190154:19pm 02/22/201901:5419pm 0 02/22/201901:5419pm 02/227201901:5419 pm

00/22/201901:54:19 pm 02/22/201901:5419pm 08/22/201901:5419pm 00/227201901:54:19 pm

067262019 10.44:42 3m 04262019 10:44:423m 087262019 10:44423m 0672672019 10:44:42 3m

04/06/20190531:54pm 04/06720190531:54pm
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5. Select one or more files and click Download File to Server on the toolbar to download files to the
server.

Note: Downloading a folder is not supported and hence the option is grayed out for folders.

Filter MFT

You can filter files on file name, creation time ($FN), creation time ($SI), access time ($FN), access time
($S1), update time ($FN), update time ($SI), modified time ($FN), and modified time ($SI).

NETWITNESS vestigate Respond Hosts es shboard Reports & =

71 [

AGENT SCAN STATUS  AGENT LAST SEEN
idle afew seconds ago

ALERTS  PROCESSES  AUTORUNS  FILES DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

¥ Filters x < Dowmloads MFT Viewer

MET-CNGSMUDALPLAC-2019-11-29T09-10-45-317Z 0 ~ame CREATION TIME ($FN) 4 CREATION TIME ($51)

O Git Origin Feature Branch O B setupstiog 11/11/201906:17:06 am 11/11/2019 06:17:06 am
> O GitOriginMaster
> O Temp 11/07/2019 010338 pm 11/07/201901:03:38 pm
O DeepWeb (2015) [YTSAG] ©  SMSAdvancedClient configngri810-cien... 11/07/2019 01:01:54 pm 11/07/2019 01:01:54 pm
> DGt
O Sysinteralssuite 11/07/20191257:32pm 11/07/2019 1257:32pm
> Do
> O inted
[ Documents and Settings = 08/22/201901:54:19 pm 08/22/201901:54:19 pm

09/14/2019 11:54:02am 09/14/2019 11:54:02am

> O Windows

> © Recovery
Q) oM ek s O Users S 06/26/2019 10:44:423m 06/26/2019 10:44:423m

08/22/2019 01:54:19 pm 08/22/2019 01:54:19 pm

> O ProgramData
O Program Files (x86)

06/06/201 31:54pm 06/06/2019 05:3: pm

@) cusTomDaTe

> O $RecycleBin

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

To filter, save, and delete MFT, see Filter Downloaded Files, Save Downloaded File, and Delete
Downloaded Files.

System and Process Memory Dump

To perform forensic investigation during an incident response, you can request a memory dump of a host
or a process running on the host. You can analyze these dumps using third-party tools, such as Volatility,
Rekall.

Download System Dump to Server

To download system dump to the server from the Hosts view:

1. Go to Hosts and do one the following:

o Select a host and select Download System Dump to Server from the right-click context menu, or
from the More drop-down list in the toolbar.
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NETWITNESS

Y Filters & Broker - Endp... [ AnalyzeEvents | v || OScan Vv i More Actions

SAVED FILTERS ] HOSTNAME RISK SCORE + OS - DESCRIPTION

Select NA Microsoft Windows 10 Pro for Workstati...

N/A Red Hat Enterprise Linux- 7.2
HOST STATUS
] Managed N/A Red Hat Enterprise Linux- 7.2
O Roaming

O Isolated

= s cuse s 8scntermrice

Analyze Events
Delete
Start Scan

Network Isolation > [iterprise

HOSTNAME nterprise
Download MFT to Server
Equals

Download System Dump to Server
USERNAME Download Files to Server

Equals
Reset Risk Score

AGENT GROUPS MICrosort Windows 7 Enterprise

o Select the hostname to open the host details and select Download System Dump to Server from
the More option besides the hostname.

NETWITNESS d Hosts

D/' AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

E ew seconds ago snapsHoT TiMe  11/30/2021 12:02:28 pm)
Start Scan

Export Host details
ALERTS PROCESSES AU LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY

Export Files
SEVERITY
Critical Alerts @

6 >

Download MFT to Server
Download System Dump to Server

Download Files to Server

40 3Ja|  Uninstall Agent

S (78 events)

24 events)

2. View the details of the downloaded system dump in the Downloads tab within the host details. For
more information, see Hosts View - Downloads Tab.
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Remote Shell

From version 12.3 or later, NetWitness Remote Shell feature (Hosts > Select the hostname > click H
(More) beside the hostname > Remote Shell) allows you to access the agents installed on your Windows
machine remotely and execute a list of commands to perform certain actions such as deleting the files,
changing the directories, terminating specific processes, and executing the processes on the remote host.

Warning:

- Use NetWitness Remote Shell feature with utmost caution to avoid the potential for negative impact
on the system. NetWitness Platform is not responsible for any damages, loss of data, or other
consequences that may arise after using NetWitness Remote Shell feature.

- If you are an administrator, NetWitness recommends you to add roles and assign the role permissions
only for the selected users in the Security > Roles view to avoid any damages to the system.

Note:

- NetWitness Remote Shell feature can be used only if Windows Advanced mode Agents are installed
on the machine. The agent version must be 12.3 or higher to access the NetWitness Remote Shell
feature.

- NetWitness Remote Shell feature is not supported if the agent is communicating with the server
through proxy.

- NetWitness Remote Shell feature supports connection with the agents that communicate through the
relay servers (RAR). To access the NetWitness Remote Shell feature for the agent that communicates
through the relay servers (RAR), you must download the latest relay packager from the Endpoint
Server (EPS) and install it on the existing relay server.

For more information, see https://community.netwitness.com/t5/netwitness-platform-online/optional-
installing-and-configuring-relay-server/ta-p/669551.

List of Supported Commands

The following table provides information about the list of supported commands displayed in the
NetWitness Remote Shell console.

help View the list of available commands

cd Change the current working directory

del Delete a file

rmdir Delete a folder

dir List the contents of a directory

mkdir Create a new directory

tasklist List all the active processes on the computer
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taskkill Terminate a process
call Execute a process on the remote computer
reg View or modify Windows registry settings

Note:

- You must use only the silent commands to perform the required actions.

- You must end the session and re-connect if you run any command that requires user inputs. Refer the
following figure.

Example Scenarios

Example 1: If you want to delete a specific file that exists in different subfolders, you must run the
following command.

del /s /q <full file path>

Here,

- del refers to delete.

- /s refers to the deletion of the file from all the subfolders.

- /q refers to quiet or silent mode execution.

- <full_file _path> refers to the location where the file exists.

Example 2: If you want to terminate a specific process running on your Windows machine, you must
run the following commands.

taskkill /f /im <process-name>

taskkill /f /pid <process-id>
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Here,

- taskkill refers to terminate.

- /f refers to force shutdown.

- /fim refers to image name.

- <process-name> refers to the specific process.
- <process-id> refers to the specific process ID.
- /pid refers to process ID.

Example 3: If you want to delete a specific registry, you must run the following command.
reg delete /f <keyname> [/v ]

Here,

- reg delete refers to deleting a registry key.

- /f refers to deleting the existing registry subkey or entry without asking for the confirmation.

- <keyname> refers to the registry key name.

- [/v] refers to deleting a specific entry under the subkey.

To execute commands using NetWitness Remote Shell:

1. Go to Hosts. Do one of the following.

o Click a row in the Hosts list view and go to More Actions > Remote Shell.

$ More Actions ~~

Delete

Download MFT to Server

Remote Shell

The NetWitness Remote Shell window is displayed.
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MetWitness Remote Shell

* Click the Hostname and click H (More) beside the hostname in the Host Details view to select
Remote Shell.

The NetWitness Remote Shell window is displayed.

MetWitness Remote Shell

o Right-click a row in the Hosts list view and select Remote Shell.
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Analyze Events

Delete

Start Scan

Remote Shell

Assign Tags

Unassign Tags
Download MFT to Server

Download System Dump to Server

Download Files to Server
Reset Risk Score For Selected Host

Uninstall Selected Agent

The NetWitness Remote Shell window is displayed.

2. Enter the commands once the Agent is connected.
NetWitness Remote Shell

Q DESKTOP-

End Session
Please note that all activities performed in this session is being recorded in the system's audit log for security purposes.

Here is a list of available commands that can be used with the remote shell feature:

Use appropriate quiet and force flag for any command which needs action confirmation.

Note: The Remote Shell connection will disconnect after 15 minutes of inactivity.

3. Click Send Command or press the Enter key.
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4. Click End Session in the NetWitness Remote Shell window once the required action is performed.
The confirmation window is displayed.

5. Click End Session to close the NetWitness Remote Shell window.

RBAC Permissions for Remote Shell

Users with Analysts and other roles must have the endpoint-server.remoteshell. manage permission to
view and access the NetWitness Remote Shell feature. Administrators can assign the endpoint-
server.remoteshell. manage role permission to a specific user or to a specific role. The existing roles
must be duplicated in the Security > Roles view and the new users must be assigned to the duplicated
roles to assign the endpoint-server.remoteshell. manage role permission only to the specific new users.

You must go to (Admin) > Services > select the Endpoint Server Service > View > Config >
Permissions view to assign the endpoint-server.remoteshell. manage permission to the specific users.
For more information on duplicating a role, adding a role and assigning permissions, and editing the role
permissions, see System Security and User Management Guide for 12.3.

Administrators can configure the RBAC Permission at Endpoint Server level. You can allow the users
assigned to a specific role to view and access the NetWitness Remote Shell feature on any specific
Endpoint Server. When you allow the user to view and access the NetWitness Remote Shell feature
only on a specific Endpoint Server such as EPS1, the user cannot view or access the NetWitness
Remote Shell feature on any other Endpoint Servers such as EPS2 and EPS3. If the user has the access
to the NetWitness Remote Shell feature on one of the Endpoint Servers such as EPS1, the user can view
the NetWitness Remote Shell feature enabled in the Endpoint Broker Server view for all the agents.
In this case, the user can access the feature and connect with the remote agent from the Broker view, if
the selected remote agent is present only in EPS 1 and not in any other Endpoint Servers such as EPS2
and EPS3. If the user attempts to connect with the remote agent which is present only in EPS2, the
NetWitness Remote Shell console screen keeps loading. This happens since the user can access the
feature only on EPS1 and not on EPS 2.

Note: If you configure the endpoint-server.remoteshell. manage permission at the role level in the
Security > Roles view, the users assigned to the role can access the NetWitness Remote Shell feature
on any Endpoint Servers such as EPS 1, EPS 2, and EPS 3.

For more information on Configuring the RBAC permissions at the role level, see (Optional) Add a
Role and Assign Permissions section in the System Security and User Management Guide for
12.3.

To configure Remote Shell RBAC permission to the specific users at the endpoint server level:

a
1. Goto (Admin) > Services.

In the Services view, select the required Endpoint Server service.

»

Click & e and select View > Config.

Go to Permissions tab.

Select the role you duplicated in the Security > Roles view from the Roles panel on the left.

AN

Select the permission endpoint-server.remoteshell. manage from the Permissions section.
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NETWITNESS

Goraral  Data Retenson Shedier  Agent Packager  Relay Sarver  3ed Party San

Roles (17) ) rMIsSions Assigned Users (2)

Matmae Anabls

[

7. Click Save.

For more information on configuring the permissions at the Endpoint Server level, see Manage Role
Permissions at Endpoint Server Level.

Download Process Dump to Server
To download process dump to the server:
1. Go to Hosts.

2. Select the hostname to open the host details.

3. In the Processes, Libraries, or Anomalies tab, select Download Process Dump to Server from the
right-click context menu, or from the More Actions drop-down list in the toolbar.

NETWITNESS Investigate  Respond sers  Hosts
AGE s AGENT LAST SEEN
Idle afew seconds ago

100

SNAPSHOT TIME  06/24/2020 21:30:33
ALERTS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY

Y Filters X Processes @ Analyze Process & Change File Status 4 Analyze Events | v # More Actions @ ) TReEVIEW

PROCESS NAME [J PROCESS NAME LOCAL RISK SCORE  GLOBAL RISK SCORE  ON HOSTS REPUTATION FILE STATUS DOWNLOADED

Equals o 100 100 2 Known Good Blacklisted
T 2 Known Good Blacklisted
Analyze Process
2 Known Good Neutral
Change File Status
s Evonts Known Good Neutral
Google Lookup 5 2 Known Good Neutral

VirusTotal Lookup

Known Good Neutral

O Suspicious Download Process Dump to Server Known Good Neutral

O Unknown

O Known Download File to Server Koovn Good Reistral
O Known Good

O Invalid

Known Good Neutral

Known Good Neutral

4. View the details of the download process dump in the Downloads tab within the host details. For
more information, see Hosts View - Downloads Tab.
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To filter, save, and delete system dump or process dump, see Filter Downloaded Files, Save Downloaded
File, and Delete Downloaded Files.

The following are some errors you might encounter during system and process dump download:
Issue Explanation

Parameter is incorrect. The process for which the dump is requested might be
running with a different process ID.

Element not found The process for which the dump is requested is no longer
active.

java.io.IOException:Unable to unwrap data, Connection to the agent is interrupted.
invalid status [CLOSED]

java.net.SocketTimeoutException The network is slow or the system is down.
One or more arguments are not correct Agent might be in the Insight mode or driver is not
running.

Download Files Using Full Path or Wildcard

You can manually download files that help in investigations by either providing full path of the file or
using wildcard.

Note: This is applicable only for agents in Advanced mode with NetWitness Platform version 11.5 and
later.

To download files to the server:
1. Go to Hosts and do one of the following:

¢ Select one or more hosts from the same operating system, and select Download Files to Server
from the right-click context menu, or from the More Actions drop-down list in the toolbar. You
can download files from only top 100 selected hosts at a time.

NETWITNESS

Y Filters

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

Reset Risk Score

* Select the hostname to open the host details, click E (More) beside the hostname, and select
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Download Files to Server.

NETWITNESS mestigte  Respond  Users Hoss

} AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION
100 [ ‘ ¢ e soponds a8 : snapsHoT TiME  11/30/2021 12:02:28 pm
Start Scan

Export Host details

ALERTS PROCESSES AU LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY
Export Files

SEVERITY

Critical Alerts @

Download MFT to Server
Download System Dump to Server
b events)

Download Files to Server

24 events)

2. In the Download Files to Server dialog, enter the full path where the files may be present or search
using wildcard. For wild card search, you can use a maximum of two *, one at a folder level and the
other at a file level.

For example, to retrieve the registry hive, you can enter the full path,
C:\Windows\System32\config\SYSTEM.

If you want to retrieve user settings and configuration preferences for all users, download all files
using the wildcard C: \Users\ *\NTUSER. DAT.

Download Files to Server

FILE PATH

Enter the path where files may be present. For wildcard search, a™' can be
used at a folder and file level.

TUSER.DAT

3. For wildcard search, enter the number of files to download and size of the file. By default, the
number of files is set to 10 and file size is set to 100 MB. For example, if the maximum number of
files is set to 10 and file size is set to 10 MB, first 10 files within 10 MB are downloaded.
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Note: You can set a limit to the Maximum Number of Files field on the explore page of the

Endpoint server (. > [Endpoint server| > explore > endpoint/command > max-file-count).

By default, the limit is set to 100, and you can change it to any value between 100 - 1000 in each
Endpoint server. In broker view, if the Endpoint servers have different max-file-count, the lesser

value will be taken as the limit.

4. Click Download.

All files downloaded as a part of wildcard search are grouped together based on the search criteria. For

example, all files downloaded using C: \Users\*\NTUSER.DAT are grouped, and you can click > I
expand and view all files under this group. You can sort the groups on the downloaded time and view the
status of the download in the Downloaded column.

NETWITNESS Ve 1 e Hosts

- g1 A R
idle afew seconds ago

ALERTS  PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES  ANOMALIES

Y Filters x  Downloads

NAME DOWNLOADED  SIZE DOWNLOADED TIME FILE PATH

> C:\Users\"\NTUSER DAT v - 8 minutes ago

- adayag

v
v = 2days ago
v

Filter Downloaded Files

You can filter the downloaded files on wildcard downloads, file type, file name, SHA256 (for files), and
downloaded time. In the Downloaded Time field, you can also filter by custom date.

NETWITNESS
ALERTS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES WNLOADS SYSTEM INFO HISTORY

Y Filters x  Downloads

NAME DOWNLOADED  SIZE DOWNLOADED TIME FILE PATH

0 ]
Select o v 197.3M8 7 minutes ago a
[ > C\Users\"\NTUSER.DAT = = 24 minutes ago
[ > C:\Users\! ' \Desktop\exe\exe\"  — = adayago
D ey = 2daysago

> C:\Users\"y AN*

Equals

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.
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Save Downloaded File

You can retrieve the downloaded file and save it to your local file system for further analysis. To save
the file:

1. Go to Hosts.
2. Select the hostname to open the host details and select the Downloads tab.

3. Right-click the file you want to save and select Save a Local Copy from the context menu or from
the toolbar.

NETWITNESS

Y Idl

ALERTS  PROCESSES  AUTORUNS  FILES  DRIVERS B S ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

D

Save a Local Copy

Files are ready to download.

If you navigate away from the current host, the download will stop.

Cancel Download

4. In the Save a Local Copy dialog, click Download.

Note: For wildcard downloads, select a file from the group that are downloaded successfully to save a
local copy. You cannot save multiple files in the group at a time or save files with errors.

Delete Downloaded Files

If you want to delete the downloaded file from the server:

1. Go to Hosts.

2. Select the hostname to open the host details and select the Downloads tab.

3. Right-click one or more files you want to delete, and select Delete File from the context menu or
from the toolbar.
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NETWITNESS

AGENT LAST SEEN
afewseconds ago

windows

ALERTS  PROCESSE AUTORUNS DRIVERS  LIBRARIES  ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

¥ Filters Downloads Save a Local Copy Delete File

0 wame TYPE DOWNLOADED DOWNLOADED TIME SHA256 FILE PATH

MFT v

a
] > C:\Users\"\NTUSER DAT Save a Local Copy v i i
> C\Users\ Delete File v i i

Note: For wildcard downloads, you can select the group to delete all files that are downloaded.
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If you need to investigate a particular host, IP address, username, filename, or hash to look for related
activity across a time range, you can pivot to Navigate view to get the entire context of the activity. By
default, the time range is set to 7 days. You can change the time range.

Note: By default, the system detects the best data source to pivot to Navigate view. To change the
data source, modify the investigate service ID under endpoint or investigate in the Explore view.

Analyze Events from Files View

To investigate a particular filename or hash (SHA256 and MD5):

1. Go to Files.

2. Select the file you want to analyze and do one of the following:
¢ Right-click and select Analyze Events from the context menu.
¢ Click Analyze Events in the toolbar.

NETWITNESS
Y Filters X 8 endpointbrok... V' @ ChangeFileStatus | | (£ AnalyzeEvents | v || § MoreActions v/
o FILE NAME RISK SCORE ¥ FIRST SEEN TIME ON HOSTS REPUTATION SIZE SIGNATURE PER

Change File Status

100 10/28/202109:49:00am 1 Known 235KB  unsigned Mw..ow(:l

A T 02107:44:07am 1 Known 520KB unsigned Microsof
o= 4 Console Events

Google Lookuj > 02107:44:07am 2 Known 150KB  unsigned Microsoft
P Network Events i

VirusTotal Lookup e bnerrem M 3145..  unsigned

Process Events 102104:40:28 am Known 5.. unsigned

Registry Events
102107:44:07 am Known unsigned

Save a Local Copy

10/29/202107:44:07 am Unknown 5.. unsigned
Analyze File

Scan with OPSWAT 10/29/202107:44:07 am Known unsigned

Reset Risk Score 10/29/202105:06:01am 2 Malicious unsigned
10/29/202107:51:29am 2 Known unsigned
10/29/202107:4407am 2 Known .5...  unsigned

10/29/202107:51:29am 2 Known 35KB  unsigned

10/29/202107:44:07am 2 Known 180KB  unsigned

out of 1000+ files

This opens the Navigate view with data related to the file. For more information on analyzing events
in the Navigate and Events views, see the NetWitness Investigate User Guide.

Note: If the values are not indexed, the results take time to load. For more information, see
Troubleshooting NetWitness Endpoint.

Analyze Events from Hosts View

To investigate a particular host, IP address (IPV4), or username:
1. Go to Hosts.
2. Do one of the following:
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o Right-click a host, select Analyze Events from the right-click context menu or in the toolbar, and
select a specific event type (such as network events, file events) that you want to view.

o Select the hostname to open the host details. Right-click a file or in the toolbar, select Analyze
Events, and select a specific event type that you want to view.

The following figure is an example of the Autoruns tab.

Y Filters Autoruns

FILE NAME £ Analyze Events |\

Equals
O REGISTRY PATH oN HosTS TvpE LAUNCH ARGUMENTS _ FILENAME FILE PATH

HKEY_LOCAL MACHINE\System\CurrentControl... 2 winsockProvide... C:\Windows\System32\
Change File Status
HKEY_LOCAL MACHINE\System\CurrentControl... e C:\Windows\System32\

[ —— < Analyze Events
HKEY_LOCAL_ MACHINE\System\CurrentControl... 2 {Googielllookup C:\Windows\System32\
Network Events

HKEY_LOCAL MACHINE\System\CurrentControl.. < VirusTotal Lookup C:\Windows\System32\
File Events

Download File to Server
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432... 2 Process Events C:\Program Files (x86)\Common Files\Java\Java Update\

N Registry Events "
HKEY_LOCAL_ MACHINE\SOFTWARE\Microsoft\.. 2 = C:\Program Files\VMware\VMware Tools\
HKEY_LOCAL_MACHINE\SYSTEM\CurrentContro... logon - C:\Windows\SysWOW64\

HKEY_LOCAL_ MACHINE\SYSTEM\CurrentContro... logon - C:\Windows\System32\

HKEY_LOCAL_MACHINE\System\CurrentControl... winsockProvide... C:\Windows\SysWOW64\

HKEY_LOCAL_MACHINE\System\CurrentControl... 2 ‘winsockProvi - C:\Windows\SysWOW64\

HKEY_LOCAL_MACHINE\System\CurrentControl... winsockProvide... - C:\Windows\SysWOW64\

13 out of 13 autoruns | 1 selected

This opens the Navigate view with data related to the file.

For more information on analyzing events in the Navigate and Events views, see the NetWitness
Investigate User Guide.

Text Analysis for an Endpoint Event

You can view all Endpoint events in their original text format in the Events view Event List panel. When
you click an event in the Event list panel, the adjacent panel shows the Text Analysis. Pagination
controls add flexibility when paging through the reconstructed text of an event. The Text Analysis
displays the following:

* Event Header, which provides summary information about the event. (Version 11.5 and Later) The
event header includes host name, process, and user name details in addition to other event details if
the selected Endpoint event contains these metadata.

* Options for exporting - log, csv, xml, and json formats.
* Option to pivot to the Endpoint Thick Client to analyze the meta value.
e Option to analyze process details associated with the event.

* Option to view the host details for further analysis.

Below is an example of the Process event for Endpoint. The text in the Text Analysis panel explains that
a source process WmiPrvSE.exe opened a browser process named chrome . exe. In the events, if there
is a meta value that exceeds 255 characters, the value is displayed in the Large Meta Values panel.
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© EPS1-Server - Concentrator V' | | 02/27/2019 07:43am - 03/26/2019 07:42am openbrowserprocess ' x

5,423 Events (Asc) ~ X Endpoint Event Details | Text Analysis
e e s
Download Log [2 Pivot to Endpoint Thick Client [2 Analyze Process [2 Pivot to Host Overview

03/14/201909:4134am  Endpoint 2019-03-14T02:

NW SERVICE SESSION ID NWE CATEGORY COLLECTION TIME EVENT T
EPS1-Server - Concentrator 6965 Process Event 03/14/2019 09:41:34 am 03/14/2019 09:36:26 am
03/14/201909:41:34am  Endpoint 14T09:36:.

03/14/201909:41:34am  Endpoint

031472019 09:4134am  Endpoint ® 03/14/2019 09:36:26 an @ @ NT AUTHORITY\NETWORK SERVICE sessionip
TimE
WniPrVSE.exe openBrowserpros chrome. exe e
03/14/201909:4134am  Endpoint FORWARD.IP
1P.ALL
03/14/201909:4134am  Endpoint ; . A MEDIUM
paran. dst=chrom rashpad-handler "--user-data-dir=C:\Users\ \AppData\Local\Google\Chrome\U: DEvICETYPE P
Data” /prefetch: itor-self-annotation-ptype-crashpad-handler "-- DIRPATHSRC I

03/14/201909:4134am  Endpoint . \AppData\Local\Google\Chrome\User Data\Crashpad” "--metrics- DIRPATHALL s
\AppData\Local\Google\Chrome\User Data” --ur! /clients2.google.com/cr/report - DIR.PATH.SRE windowsSystem32
-annotation-plat=Hin64 --annotatio .3683. iti DIRPATHALL windowsSystem32

client-data=ex1e8,0x1ed, 0x1e8,8x1dc, Ox1ec, Bx7 FFa64916830, x7Fa64916840,, 0x7F 264916850 CONTEXT.SRC file-found

03/14/201909:41:34am  Endpoint

CONTEXT.ALL file:found
03/14/201909:41:34am  Endpoint coNTEXT.sRC fle.protected

CONTEXT.ALL fle proteced

3am - 03/26/2019 07:42am  V network event

22,535 Events (Asq) < Endpoint Event Details | Text Analysis m|

Download Log [3 Pivot to Endpoint Thick Client | | [3 Analyze Process | | [3 Pivot to Host Overview

COLLECTION TIME Tvee EVENT TIME

NW SERVICE sEssIoN 1D NWE CATEGORY coLLECTION TiME EVENT TIME
_ EPS1-Server - Concentrator 6768 Network Event 03/14/2019 09:41:34 am 03/14/2019 09:34:15 am
03/14/201909:41:34am  Endpoint :34:. :10003

NETWORK REMOTE ADDRESS

03/14/201909:41:34am  Endpoint

031472019 09:4134am  Endipoinc © 03/14/2019 09:34:15 an @ @ NT AUTHORITY\SYSTEM sessioniD
TIME
03/14/201909:4134am  Endpoint . secureConnector. exe 10.254.20.23 ; size
FORWARD.IP
1P.ALL

03/14/201909:41:34am  Endpoint
MEDIUM

paran. src=SecureConnector.exe -performer -id ADGAB2C2CAS54FBF9AC3109807DC7148 -token pevice.Tve P—

031472019 0%:4134am  Endpoint €22114e7617841b0392af5464293e€4600269dc -ip 10.254.20.237 -port 10003 -sha2s

PORT.DST 10003
34E3B6B148C6FICBDAERBCOBABY1 FA42F7291DBBOFD4@0355880226252628B5D ~1Cif 7 -event PORT.ALL 10003
FSA_TMP_5388_5C89DE73_B@G2PERFORMER_CNTL -rrd @ PORT.DST.ALL 10003
03/14/201909:4134am  Endpoint
DIRPATH.SRC programfiles
DIRPATHALL programfiles
03/14/201909:4134am  Endpoint :34:. CONTEXT.SRC fle.autorun
CONTEXT.ALL file.autorun
CoNTEXT.SRC file.found
03/14/2019 09:41:34am  Endpoint
file.found

fle cratedinlasiMont

For more information on Events view, see the NetWitness Investigate User Guide.
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Isolating Hosts from Network

Note: By default, the network isolation option is disabled in the policy, and you cannot view options
mentioned in this section. To enable network isolation, in the policy configuration, select Enabled in
the Network Isolation option under Response Action Settings. For more information, see the
NetWitness Endpoint Configuration Guide.

To isolate a host from the network:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Isolate from Network from the right-click context
menu, or from the More drop-down list in the toolbar.

NETWITNESS d  Users  Hosts

Y Filters 8 Broker - Endp... v O Tags v £ More Actions Vv

SAVED FILTERS HOSTNAME RISK SCORE v  OS- DESCRIPTION LAST SCAN TIME

Select NA Microsoft Windows 10 Pro for Workstati... 05/08/2020 02:2

NA Red Hat Enterprise Linux- 7.2 05/05/2020 05:5
HOST STATUS
0O Managed NA Red Hat Enterprise Linux- 7.2 05/06/2020 07:3
O Roaming

O Isolated

=
05/06/2020 07:4:

Analyze Events
05/05/2020 01:0:
Delete

Start Scan 05/06/2020 07:2¢

RISK SCORE

Network Isolation Isolate from Network
HOSTNAME Download MFT to Server
Equals
Download System Dump to Server

USERNAME Download Files to Server 05/06/2020 07:3

O|o0o(O0(O0(O0|O0(0O|O

Equals Reset Risk Score

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Isolate from Network.

NETWITNESS Irves . = e el

100 = s AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION
ew seconds ago
Start Scan
Start Yara Scan
ALERTS PROCESSES 5 3 RAR s ANOMALIES
Export Host details
SEVERITY

3

Critical Alerts Export Files

Network Isolation Isclate from Network

Download MFT to Server

Download System Dump to Server

Download Files to Server

Uninstall Agent
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2. In the Isolate from Network dialog, by default, a set of IP addresses are excluded from isolation. For
more information, see Network Isolation. To add IP addresses to the list, select the Add your IPs to
Exclusion List checkbox. You can enter up to 100 IP addresses separated by comma.

|solate from Network

Network Isolation blocks the host from connecting to the networl.
All attempted network connections are monitored and reported to the
Endpoint Server.

Add IP addresses to the Exclusion List

3. Enter comments.

4. Click Isolate Host.

Note: When a host is isolated, the connection to the following IP addresses are allowed:

- Endpoint Server, Relay Server, DNS, DHCP, Gateways, 0.0.0.0, 255.255.255.255, and any other
IP addresses that the agent connects with.

- Other IP addresses that you include in the exclusion list.

Edit Exclusion List

To edit the exclusion list:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Edit Exclusion List from the right-click context
menu, or from the More drop-down list in the toolbar.
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NETWITNESS

Y Filters & Broker - Endp... D Tags v £ More Actions \/

SAVED FILTERS [0 HOSTNAME RISK SCORE v  OS-DESCRIPTION LAST SCAN TIME

Select NA Microsoft Windows 10 Pro for Workstati... 05/08/202002:21
NA Red Hat Enterprise Linux- 7.2 05/05/2020 05:59

HOST STATUS

O Managed N/A Red Hat Enterprise Linux- 7.2 05/06/2020 07:381

O Roaming

O Isolated Analyze Events

05/06/2020 07:47

Delete 05/05/2020 01:07

RISK RE
Start Scan -1 (Ootpa) 05/06/2020 07:207

. cation
0 Network Isolation Release from Isolation

Edit Exclusion List
HOSTNAME Download MFT to Server

Equals Enter Value
! - Download System Dump to Server 05/07/2020 08:44

Download Files to Server 05/06/2020 07:32

Reset Risk Score

Microsoft Windows 7 Enterprise 05/08/2020 06:53;]

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Edit Exclusion List.

NETWITNESS gate eSpon( Hosts il ashb eports

100 AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION SNAPSHOT TIME
‘ew seconds ago 09/16/2022 12:05:20 pm (Yara Scan)
Start Scan
Start Yara Scan
ALERTS PROCESSES A LIBRARIES ANOMALIES OWNLOADS SYSTEM INFO HISTORY
Export Host details
SEVERITY

1

Critical Alerts @ Export Files

Network Isolation Release from Isolation

Download MFT to Server Edit Exclusion List

Download System Dump to Server

Download Files to Server

Uninstall Agent

2. Add or modify the IP addresses in the list.

3. Enter comments and click Save.

Release Isolated Hosts

Releasing the isolated host restores the network connection and removes IP addresses added to the
Exclusion list. To release the host from isolation:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Release from Isolation from the right-click context
menu, or from the More drop-down list in the toolbar.
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NETWITNESS

Y Filters & Broker - Endp... O Tags v % More Actions

SAVED FILTERS ] HOSTNAME RISK SCORE < OS - DESCRIPTION

Select N/A Microsoft Windows 10 Pro for Workstati...

N/A Red Hat Enterprise Linux- 7.2
HOST STATUS

O Managed N/A Red Hat Enterprise Linux- 7.2

O Roaming
O Isolated Analyze Events

indows 8.1 Enterprise

Delete 04.4LTS

Start Scan erprise Linux 8.1 (Ootpa)

indows 10 Education
Network Isolation > | Release from Isolation

Edit Exclusion List
Download MFT to Server

Equals Download System Dump to Server

Download Files to Server

USERNAME

Equals Reset Risk Score indows 10 Education

O/ o0|OojO(O0|0|0|0)|0O3

Microsoft Windows 7 Enterprise

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Release from Isolation.

NETWITNESS

100

09/16/2022 12:05:20 pm (Yara Scan)
Start Scan
Start Yara Scan
ALERTS  PROCESSES A SRARIES  ANOMALIES OWNLOADS  SYSTEM INFO  HISTORY
Export Host details
SEVERITY

1

Critical Alerts @ Export Files

Network Isolation 3 Release from Isolation
Download MFT to Server Edit Exclusion List
Download System Dump to Server

Download Files to Server

Uninstall Agent

2. Enter comments and click Release Host.
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High Availability (Endpoint Recovery)

The High Availability or Endpoint recovery configuration feature in the Admin Server - Source Server

Explore view Admin > Services > select the Source Server > View > Explore >
endpoint/recovery) allows administrators to map the service ID of an Endpoint server with the recovery

Endpoint service ID as part of recovery configuration.

Note: Map the service IDs of multiple Endpoint servers in the form of comma separated Key Value
pairs. You must enter ‘:’ in between the Key Value pairs. The Key refers to the service ID of the
unavailable Endpoint server and the Value refers to the service ID of the recovery Endpoint server.
For Example: <Unresponsive EPS Serviceld-1>: <Recovery EPS Serviceld-2>, < Unresponsive EPS
Serviceld-3>: < Recovery EPS Serviceld-4>

To configure the Endpoint Recovery

1. Goto Admin > Services.
The Services view is displayed.

2. Select the Source Server. Go to View > Explore.
The Explore view is displayed.

3. Click endpoint/recovery.

4. Enter the service IDs of the Endpoint servers in failover-service-id-mapping field.

endpointirecovery

gpol0opROQEOOGROOD

Endpoint Recovery Use Case Example

The following use case provides an example of an Endpoint administrator using the High Availability
feature in the NetWitness Platform to configure the Endpoint recovery.
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Use Case: Endpoint Server EPS 1 turns unresponsive

Administrator Steven finds that an Endpoint server EPS 1 in the environment is not responding from
a long time and the communication between the agents and the Endpoint server EPS 1 is failing.
Steven navigates to the Admin Server - Source Server Explore view and selects
endpoint/recovery configuration. As part of the Endpoint recovery configuration, Steven maps the
service ID of EPS1 with the service ID of an active Endpoint server EPS 2.

Pre-requisites for Endpoint Recovery Configuration

Make sure the following pre-requisites are met before you perform Endpoint Recovery
Configuration.

o Before you install the recovery Endpoint server EPS 2 and perform Endpoint recovery
configuration, make sure you copy the nwerootca-key.pem and nwerootca-cert.pem certificate
files from EPS 1 (unresponsive Endpoint server) to EPS 2 (recovery Endpoint server). If the
certificate files in EPS 1 and EPS 2 do not match, the agent fails to communicate with EPS 2 in
case of EPS 1 failure.

IMPORTANT: Once you install EPS 1 on your machine, backup the nwerootca-key.pem and
nwerootca-cert.pem certificate files. If you fail to do so and the EPS 1 fails due to some disaster,
you cannot copy the nwerootca-key.pem and nwerootca-cert.pem certificate files in EPS 1 to
EPS 2.

For more information on how to backup and copy the certificate files, see Configuring Multiple
Endpoint Log Hybrids section in Install NetWitness Platform Virtual Host in Virtual
Environment topic in the Virtual Host Installation Guide for 12.3.1.

o When you replace an unresponsive relay server configured on an Endpoint server with the new
relay server, make sure you re-use the same Fully Qualified Domain Name (FQDN) or IP address
of the unresponsive relay as part of the relay recovery configuration.

¢ You must enter the Forwarder address of the recovery Endpoint server in Endpoint Sources >
Policies view immediately after mapping the service IDs of the Endpoint servers in the Admin
Server - Source Server Explore view. During the failure of an Endpoint server EPS 1, if the IP
address of the recovery Endpoint server EPS 2 changes, and you do not provide the Forwarder
address of the recovery Endpoint in Endpoint Sources > Policies view, the agent fails to
communicate with the recovery Endpoint server EPS 2.

o The HTTPS ports of the Primary Endpoint server and the recovery Endpoint server must match
during the Endpoint recovery configuration.

DNS Recovery Configuration

Note: The agent cannot establish communication through RAR mode as part of DNS Recovery. If
Endpoint server is not directly reachable, the DNS recovery fails.

When all the Endpoint servers in the deployment are unresponsive, the agent searches for the
recovery Endpoint server through the DNS entry. You must configure the new recovery Endpoint
server in the deployment and include it in the DNS record to allow the agent to communicate with
the newly added recovery Endpoint server.
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To add the recovery Endpoint server to the DNS entry
1. Enter the following in DNS server.

o Domain Name: Enter the domain name of the recovery Endpoint server in the form of
<service ID>.nwrecovery.local.

For example: Domain Name must be entered in the form of 5bdv7ado-69a0-41{2- 8574-
d3ffc78b9.nwrecovery.local.

Here, <service ID> is the service ID of the unresponsive Endpoint server which is variable
and nwrecovery.local is a static element in all the domain names.

o [P Address: Enter the IP address of the recovery Endpoint server as the IP address for the
domain name.

2. Perform Endpoint recovery configuration in Admin Server - Source Server Explore view. For
more information, see To configure the Endpoint Recovery.

The agent establishes communication with the newly added recovery Endpoint server.
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About Load Balancing

The load balancing feature enables administrators to distribute agents' loads equally across the endpoint
servers in the environment.

When organizations become larger, the need to add new agents for deployments increases, and
distributing agents across Endpoint Servers becomes difficult. Administrators must download a different
Packager for each endpoint server and use policies to distribute the load based on conditions.

Using the load balancing feature, customers only need to download one agent packager and push it to all
the endpoint agents. Based on the defined load and parameters, the load will be equally distributed across
Endpoint Servers.

By implementing load balancing, organizations can ensure that their deployment scales efficiently,
reducing the risk of overloading any single endpoint server and maintaining optimal performance across
the network.

Note: - Load Balancing feature is applicable only for the fresh-installed agents. It is not applicable for
the existing agents that are already communicating with the endpoint servers in your environment.

- By default, the Load Balancing feature is disabled in the Global Config view (% (Admin) >
Services > select the Endpoint Server > ¥ ° > View > Config). To use the load balancing capability,
you need to enable load balancing.

If the settings in the Global Config view change, any Packagers downloaded before will have outdated
information and cannot be used anymore. To register new agents, download a new Packager from the
Agent Packagers page.

About Agent Packager Type

Agent Packager Type is a new field introduced in the Agent Packager view ( (Admin) > Services >
select the Endpoint Server > # /> View > Conlfig) that allows you to select any of the following options:

o Single Packager

o Standard Packager

About Single Packager

When the number of endpoint servers in the deployment increases, managing separate packages for each
server becomes more difficult every time fresh agents are deployed.

To ease this process, the Single Packager option is introduced in B (Admin) > Services > select the
Endpoint Server > #° > View > Config > Agent Packager that enables administrators to download and
install a single agent packager (consisting of the IPs of all endpoint servers in the deployment) for all
endpoint servers.

When load balancing is enabled, agents are not randomly registered. This process does not affect agents
that are already registered and communicating with the server. Existing agents will continue to
communicate with the server as usual.

Single Packager addresses the following two scenarios:
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e Scenario 1: If load balancing is disabled

When you download the Single Packager, freshly installed agents randomly register with one of the
endpoint servers available in the deployment. If any server is in an unhealthy state or not available,
then it will register with another endpoint server available, irrespective of its load. This ensures a
random distribution of agents across all the available endpoint servers in the deployment.

e Scenario 2: If load balancing is enabled

When you download the Single Packager, freshly installed agents register with the least loaded
healthy endpoint server in the deployment. When load balancing is enabled, agents are not randomly
registered. If all the endpoint servers in the deployment have reached the number of agents limit, no
new agents can be registered.

About Standard Packager

The Standard Packager option lets you only download and install the agent on a specific endpoint server.
This option is useful when you do not want to distribute the load across endpoint servers like Managed
Security Service Provider (MSSP) deployments .
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Enable Load Balancing

The load balancing feature enables administrators to distribute agents' loads equally across the endpoint
servers in the environment. By default, the Load Balancing feature is disabled in the Global Config view
B3 (Admin) > Services > select the Endpoint Server > # > View > Config). To use the load
balancing capability, you need to enable load balancing.

When you enable Load Balancing, the Standard Packager option is grayed out, and only the Single
Packager option is available in the Agent Packager view.

Note:

Only an administrator can perform the following actions.

- Enable or disable the Load Balancing feature.

- Select Single Agent Packager for multiple endpoint servers in large deployments.

To enable Load Balancing
1. Goto (Admin) > Services > select the Endpoint Server > * ' > View > Config > Global Config.
The Global Config view is displayed.

NETWITNESS

HOST: S EVENTSC ENDPOINT SOURCES  HEALTH & WELLNES: SYSTEM SECURITY

£ Change Service | EndpointServer2 - Endpoint Server | Config &

General  Data Retention Scheduler ~ Agent Packager ~ RelayServer 3rd PartyScan Permissions [REBREReenIrS

Quick Help

The Load Balancing feature allows administrators to
‘equa istribute the load of agent: itiple
Endpoint Servers.

1. By default, the Load Balancin; bled. You must
«click Enable option in the Load

Servers field to enable the Load Bal

2. Configure the maximum number of agents for each
Endpoint Server.

multiple Endpoint S

2. Select Enabled option in Load Balancing for Endpoint Servers field.

3. Configure the maximum number of agents that you want to communicate with each Endpoint server
in the Maximum No. of Agents Per Server field (The max value is 50,000).

For example, If you want each Endpoint server to communicate only with a maximum of 20 agents,
set the value to 20 in the Maximum No. of Agents Per Server field.
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Note: Once the maximum no. of agents reaches the limit for an Endpoint server say EPS 1, any
new fresh-installed agent will be allowed to communicate only with the next available Endpoint
server say EPS 2 and so on.

Agents will not be registered to any Endpoint Server that is in an unhealthy state, regardless of
load. Registrations to the Endpoint Server will resume once the server status becomes healthy. New
agents will not be registered if all Endpoint Servers with good health status have reached the
maximum limit. The administrators need to decrease the load in EPS by deleting the existing
agents or increasing the maximum limit to resume registering new agents.

IMPORTANT: If an agent is assigned to a server through the endpoint server policy, the agent
will be registered to the server mentioned in the policy regardless of its load. The registration will
happen even if the server has reached its maximum limit.

4. Click Save.

5. Go to the Agent Packager view.

O Y Eraiganna faroed - Eradgaes e Gy
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6. Select Single Packager option.

7. Generate the Agent Packager.

For more information, see Generate an Endpoint Agent Packager topic in NetWitness Endpoint
Agent Installation Guide for 12.5.
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NetWitness Endpoint with Third-Party Antivirus

Products

If you want the NetWitness Endpoint agent to coexist with any of the security products, make sure to
whitelist the agent. For more information, see the respective third-party product documentation.
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Troubleshooting NetWitness Endpoint

This section provides information about possible issues when using NetWitness Endpoint.

General Issues

Some of the hosts or files data are not displayed when Endpoint Broker is selected for
querying.

The Endpoint Broker aggregates data from all Endpoint Servers, which responds within
10 seconds. You must increase the query timeout value to see the result of Endpoint
server that is online. Perform the following:

Q
1. Goto (Admin) > Endpoint Broker service.
2. Click & > View > Explore.

3. Click endpoint/broker node.

4. In the query-timeout field increase the value, for example, 30 seconds.

The Endpoint Agent is unable to communicate with the Endpoint Server. The connection
may not be established due to any of the following issues:

 UDP
HTTPS

Firewall

To verify the UDP or HTTPS connection, you must verify the connection between
Windows Endpoint Agent and Endpoint Server:

1. Go to System32 folder using the following command:
cd C:\Windows\System32

2. Execute the following command:

<Agent Service name>.exe /testnet
For example, NWEAgent .exe /testnet

e If the issue is with the firewall, check the incoming and outgoing firewall rules.

The Endpoint Agent is unable to communicate with the Log Decoder. The connection
may not be established due to any of the following issues:

 UDP
 TCP
e TLS
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e Firewall

e To verify the UDP, TCP, and TLS connection, you must verify the connection between
Windows Endpoint Agent and the Log Decoder:

1. Go to System32 folder using the following command:
cd C:\Windows\System32

2. Execute the following command:
<Agent Service name>.exe /testlognet

For example, NWEAgent .exe /testlognet

 If the issue is with the firewall, check the incoming and outgoing firewall rules.

Multi-server Issue

Agent is not communicating with the Endpoint Server after migration.

Check the Nginx logs of the Endpoint Server to which the agent has migrated, and if the
agent is communicating with error code 403, that means the certificate of the first
Endpoint Server and second Endpoint Server are different. This is because during the
installation of second Endpoint Server, the certificate of first Endpoint Server is not
copied to the second Endpoint Server.

Reinstall the second Endpoint Server by copying the certificate of first Endpoint Server,
and reinstall the agent. For more information, see the Physical Host Installation Guide.

Hosts View Issues

An error has occurred. The Endpoint Server may be offline or
inaccessible.

When attempting to access the Hosts or Files view, the view opens with the message.

Endpoint Server or Nginx Server is not running. Check the status of the Endpoint

Server under (Admin) > Services or check if the Endpoint Server host IP
address is registered with the Admin Server. For more information, see the Physical
Host Installation Guide or Virtual Host Installation Guide. If the service is not
running, start the Endpoint Server.

Hosts view shows 'No Results Found.' error in the following scenario:

o Host A belongs to Endpoint server A and does not exist in Endpoint server B.
» Endpoint server B is selected in Hosts view.
¢ In a new window/tab, open the Host details page (of Host A)

o Navigate to Hosts view using [Host Name] > Actions > Pivot to Investigate
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> Hosts/Files

Endpoint server B is selected by default, and the page shows
'No results found.' error.

This is expected behavior. The Endpoint server that is selected first is considered to
be current /active throughout the session.

Ensure the correct Endpoint server is selected, and Pivot to Investigate >
Hosts/Files will behave normally.

For MFT download:

1. The request fails with file not found error for drives/mount paths created on
the machine after agent is installed.

2. Incorrect MFT is downloaded for the provided NTFS mount path.

Make sure that the agent version is 11.6 or later.

Files View Issues

Unable to analyze events from Hosts and Files view.

Other than Broker or Concentrator, if any aggregation service, such as Archiver, is
aggregating data from the Log Decoder that is configured for metadata forwarding
from any Endpoint server, clicking Analyze Events from Hosts and Files view for
this Endpoint server may not work. To resolve this issue:

Note: To get the investigate-service-id:
1) Go to K& (Admin) > Services > Concentrator service.

2) Click e | > View > Explore tab.
3) Expand the sys/stats node list.
4) In the UUID filed, copy the value.

Q4
1. Goto (Admin) > Services > Endpoint Server service.

2. Click ¥ N View > Explore tab.

3. In the endpoint/investigate ficld, specify the investigate-service-id.

Policy Issue

Policy status in the Policy Details panel is not updated or shows Policy
Unavailable/Permission Required.

Policy Unavailable - Hosts belong to previous versions, such as NetWitness Platform
11.1 or 11.2, where a policy is not applied.
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Permission Required - If you do not have permissions, see the "Role Permissions"
topic in the System Security and User Management Guide.

Policy Status shows error.

Policy may have wrong configurations. Check the error description, logs in Endpoint
server, and audit logs for details. Contact your system administrator with the error
details.

Driver Issue

While loading the driver on the host, an error is encountered.

Check the driver error code in the Agent-Driver Error Code column under Hosts
view. Contact your system administrator with the error code.

Download Issue

Downloads (Files, MFT, System/Process dumps, etc.) fail at times.

Downloads fail when there is not sufficient disk space on the Endpoint Server.

Clean up some disk space and try downloading again. We recommend you keep
sufficient disk space before initiating any download.

File Reputation Service Issue

When you configure RSA Live for the first time and the File Reputation service is not
connected.

You must manually enable the File Reputation service. To enable the File Reputation
service:

Q
1. Goto (Admin) > System > Live Services.
2. In the Additional Live Services section, select the enable File Reputation check box.

3. Click Apply.

Risk Scoring for Hosts or Files Issue

NetWitness Endpoint takes a long time to process risk scoring for Hosts or Files.
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Check the backlog of alerts for risk scoring.
1. SSH to the ESA Primary appliance.

2. Execute the following command:

mongo respond-server --authenticationDatabase admin -u deploy
admin -p <deploy admin password> --eval 'db.staging.find({"Sor":
[{state:"STAGED"}, {state :"WORKING"}]}).count()' --quiet

The backlog count is displayed. If the backlog count is 1 million or greater, you must
disable the risk scoring and Endpoint ESA alerts.

3. To disable risk scoring:
Q
a. Goto (Admin) > Services > Respond service.

b. Click B > View > Explore.
c. Expand the respond/scheduled/jobs node list.
d. In the risk-scoring-enabled field, set the value to false.
4. To disable Endpoint ESA alerts:
a. To disable NetWitness Endpoint ESA alerts generation for severity; Critical, High
and Medium.
i. Goto (Configure) > ESA Rules.
The Configure view is displayed with the Rules tab open.

ii. In the Options panel, under Deployments, select the Endpoint deployment to
delete.
A confirmation dialog is displayed.

iii. Click Yes.
b. To disable only Medium severity NetWitness Endpoint ESA alerts:
1. Go to K&l (Admin) > ESA Correlation service (on which Endpoint
deployment is added).
i Click ® 7 > View > Explore.

iii. Expand the correction/alert node list.

iv. In the transient-enabled ficld, set the value to false.

Endpoint Broker/Server Issue

User have access to one Endpoint server and unable to access the other.

Reach out to the administrator and check if you have access to that endpoint servers.
Request for access if required.

Troubleshooting NetWitness Endpoint 152




NetWitness Endpoint User Guide

In the Endpoint Server Broker view, the user can scan hosts that belong to a particular

Issue . .
Endpoint server but cannot scan hosts that belong to another Endpoint server.

User may not have access to that endpoint server. Check with the Administrator to see

DR if if.c uscr has access.
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This section is intended to help you understand the purpose and application of NetWitness Investigate >
Hosts view and Files view. For each view, there is a brief introduction and a What Do You Want To Do
table with links to related procedures. In addition some of the reference materials include workflows and

Quick Looks to highlight important features in the user interface.

e Files View
e Hosts View

e Hosts View - Details Tab

e Hosts View - Process Tab

e Hosts View - Autoruns Tab

e Hosts View - Files Tab

e Hosts View - Drivers Tab

e Hosts View - Libraries Tab

e Hosts View - Anomalies Tab

e Hosts View - Downloads Tab

e Hosts View - System Information Tab

e Hosts View - Agent History Tab
e Hosts View - YARA Rules Tab

NetWitness Endpoint Reference Materials
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Files View

Note: The information in this topic applies to NetWitness latest version.

The Files view provides a holistic view of all files in your deployment. To access this view, go to Files.
By default, the Files view displays 100 files. To display more files, click Load More at the bottom of
the page.

You can either view files specific to an Endpoint server or view all files from multiple Endpoint servers
by selecting the Endpoint Broker.

Workflow

Analyze Events

(Navigate or Event
Analysis View)

Whitelist Files/ Create Fikier &
reate Filter to
Certificates Signed by Identify Files Anal Fil > Download Files for
entify Files for nalyze Files
Known Good y_ ) Y Deeper Analysis
Investigation
Vendors

Perform External

—

—

Lookups

What do you want to do?

User
Role

Threat whitelist files and certificates signed by known good  Analyze Certificates

Hunter vendors*®

Threat create filter to identify files for investigation* Filter Files

Hunter -

Threat analyze files* Investigating Files

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for
Hunter a File

Threat change file status or remediate* Changing File Status or
Hunter Remediate

*You can perform this task in the current view
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Related Topics

e Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Analyzing Events

e Analyze Certificates

* Manage Blocked File Hashes

e Changing File Status or Remediate

Quick Look

Below is an example of the Files view:

NETWITNESS ¢ Hosts  Files  Dashboard  Report S % ®  admin

Filters || & endpointbrok... Manage “ Change File Status | | 7 Analyze Events # More Actions v/

FILE NAME RISK SCORE FIRSTSEENTIME  ON HOSTS REPUTATION SIZE

FILE DETAILS

76 05/29/202306:06... 1 - 3490.. mi Neutd| | | Tvpet
05/25/202310:22... 2 - 8820.. mi isk Score Neuts Show details with values only
05/25/202310:36... 0 - 11MB i Neutd | | General

FileName  cmd.exe
05/25/202310:22... 2 = 7.1MB i Neut!

Ents 4.666021015593989

05/25/2023 11:47... = 655KB  mi oce! Neut!

3490KB

05/25/2023 10:36... = 28.0KB  mi e Neut:
e

05/25/202310:36... = 240KB  mi Neut!

e Signature
05/25/202307:32... 2 = 862KB  mi Neut: natur

microsoftsigned catalog
05/25/202307:32... - ! Neut:
Timestamp 11/07/201408:02:40.305 am
/ : ~ ’
05/30/202310:22... E Neuts Thumbprint  df3b9b7e5aeal1aa0b82a255422620095...

05/25/2023 10:36. - 0...  mi SHAZS6 Neut: eI M rasr it
05/25/202310:36... - 4 microsoft signed Microsoft Corp...  Neuti
05/28/202310:22.. - microsoft signed Microsoft Corp...  Neuti

f52e03de0adé60f5b17b82f2cd68402fe
05/25/202310:22.. - microsoft signed Microsoft Corp...  Neuti R T~

05/25/2023 10:22.. - 8 microsoft signed Microsoft Corp...  Neuti 67B8HBBITbOf1d5465c2826e5b47523598..

05/25/2023 = microsoft,signed,catal... Microsoft Corp...  Neut:

Filter Files. You can filter the files by selecting the options in the Filters panel and create
filters. For more information, see Filter Files.
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Actions in the toolbar:

Server drop-down list - You can select the Endpoint server or Endpoint Broker server to view
the hosts.

Manage - You can select any of the following drop-down options in the Manage drop-down
list.

o Certificates - Allows you to view a list of code-signing certificates reported by hosts found
in your deployment and their associated properties. For more information, see Analyze
Certificates.

Blocked File Hashes - Allows you to add or import new file hashes and manage the existing
blocked file hashes.

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected files to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.
* Download files to server, save a local copy, and analyze files for deeper analysis.

¢ Reset risk score.

Note: You can perform the above actions from the right-click context menu.

Sort Columns. Lets you sort on column titles.

Settings Menu. You can set Files view preferences by selecting columns from the Settings
menu. For more information, see Set Files Preference.

Show/Hide File Properties Panel. Click a row to show or hide the File Properties panel. It
displays the following tabs:

File Details - Displays the file information.
Risk details - Displays the distinct alerts associated with the risk score.

Hosts - Displays the top 100 hosts based on the risk score on which the file is present. For
more information, see Analyze Hosts with File Activity.

Export to CSV - Extracts global files to a CSV file. For more information, see Export Global
Files,

[ ]

File Details View

To access this view, go to Files, and select a file. Below is an example of the File Details view:
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NETWITNESS Investigate  Respond Users fosts ashboard eports O] % @®  admin

100 = 5 ON HOSTS SIGNATURE SIZE FILE STATUS.
1 unsigned 27KB Neutral

AITRTS | ANAIYS

SEVERITY ..
Critical Alerts @ FILE DETAILS HOSTS

1 Opswal Reporled Infected (1 events)

EVENT TIME SUMMARY TARGET PARAM — - — —
Fect ils with values only
10/03/2022 07:50:46.000 am ufw-init N/A

/03/2022 07:50:46.130 am

fw-init
4.945658548611346
27KB

ript

Agent and Scan Details. You can view the following agent and scan details of the selected host:
Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Analyze Events - Lets you investigate a particular host, [P address, username, filename, or hash
to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to perform external lookups.

On Hosts - Indicates the number of hosts on which a file exist.
Signature - Provides signatory information.

Size - Size of the file.

File Status - Status of the file. For example, Neutral.

WA Alerts Severity tab - Displays list of distinct alerts, such as Critical, High, Medium and All,
along with the total number of events associated with the alert.

Analysis tab - Provides detailed information about a downloaded file. For more information, see
Analyzing Downloaded Files.

Displays events for an alert and metadata associated with a specific event.

"8 Show/Hide File Properties Panel. Click a row to show or hide the File Properties panel. It
displays the following tabs:

File Details - Displays the file information.

Hosts - Displays the hosts on which file activities are present. For more information, see Analyze
Hosts with File Activity.
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Hosts View

Note: The information in this topic applies to NetWitness latest version.

The Hosts view provides a list of all hosts with an Endpoint agent installed. To access this view, go to
Hosts. By default, hosts are sorted based on the risk score.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files

-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

Analyze Events
(Navigate or Events [y
View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

Remediate

Change File Status

[Optional) Isolate
Host from Network

N TR

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details* Analyze Host Details

Hunter

Threat search on snapshot* Search Files on Host

Hunter

Threat analyze processes* Investigating a Process

Hunter

Threat review reported anomalies* Analyze Anomalies

Hunter
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N TN

Threat analyze risky users* Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT*, system dump*  or process Performing Host Forensics
Hunter dump

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Investigating a Process

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Hosts view:
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NETWITNESS est € r Hosts ’ R n

Y Filters

Equals

Equals

AGENT GROUPS

Equals

Equals

S Broker - Endp... & AnalyzeEvents | v || OScan v § More Actions v/ 2 &0

HOST DETAILS
1 nosTNAME RISKSCORE & OS- DESCRIPTION LAST SCAN TIME USERNAME AGENT LAST SEEN AGENT sCAN 5T/

o 0 100 Microsoft Windows 10 Enterprise  06/24/202021:30:33 WINDOWS10\ecat,..  afewsecondsago idle

100 ft Windows 10 Enterprise  06/28/202021:30:08 WINDWOS10-O\ec a die

e 67 (Final) 06/29/202014:3023 = 2 die S

Windows-security

2

Administrators

= Intel(R) 825741 Gigabit Network...

sy 101252441
10.31.64.22,1031.64.23

false
@) customoare

Microsoft Windows 10 Enterprise

18362

Filter Hosts.You can filter the hosts by selecting the options in the Filters panel and create
filters. For more information, see Filter Hosts.

Actions in the toolbar:

Server drop-down list - You can select the Endpoint server or Endpoint Broker server to view
the hosts.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

Start Scan - Starts a scan for the selected hosts.
Stop Scan - Stops a scan for the selected hosts.

More Actions - Provides options to:
* Reset risk score.

e Delete - Lets you delete hosts manually from the user interface. After deletion, the Endpoint
server does not process any request from this host. For more information, see Delete a Host.

e Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.

e Isolation host from the network. For more information, see Isolating Hosts from Network.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Note: You can perform the above actions from the right-click context menu.

Sort Columns. Lets you sort on column titles.
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Export to CSV - Extracts host attributes to a CSV file. For more information, see Export Host
Attributes.

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

Show/Hide Host Properties Panel. Click a row to show or hide the Host Properties panel. It
displays the following tabs:

Host details - Displays the host information such as Network Interfaces, operating system,
hardware and others.

Risk details - Displays the distinct alerts associated with the risk score.

View Agent History - Displays the list of commands issued to the agent. For more
information, see View Agent History.
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Hosts View - Details Tab

Note: The information in this topic applies to NetWitness latest version.

The Details tab provides details of the selected host. To access this view, go to Hosts view, and select a
host.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Sean
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Change File Status Remediate

- Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) Host from Network

What do you want to do?

N TR

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details* Analyze Host Details
Hunter

Threat search files on host* Search Files on Host
Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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N TN

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

analyze risky users*

analyze events*

download files for deeper analysis
perform external lookups

change file status or remediate
isolate host from network*

download MFT*, system dump, or process
dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

* Investigating Hosts

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Details tab:

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded Files

Launch an External Lookup for a
File

Changing File Status or Remediate

Isolating Hosts from Network

Performing Host Forensics
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NETWITNESS Investigate

100 Z 3 AGENTSCANSTATUS  AGENTLASTSEEN  AGENT VERSION sNAPSHOT TIME

Idle 24 days ago

ALFRTS | PROCFSSFS  AUTORUNS  FILFS  DRIVFRS | IBRARIFS e} ADS SYSTEM INFO  HISTORY

SEVERITY
Critical Alerts @

1 ; Blacklisted File (s events)
EVENT TIME SUMMARY TARGET PARAM
08/30/2022 11:02:20.000 am libnspra.so present in /usr/1ib64 // Sho letails with values only
211:02:20.000 am 1vm2-monitor.service present in /usr/1ib/systemd/systen Users
211:02:20000am Libgerypt.s0.11.8.2 present in /usr/1ibs4
08/26/202212:58:21.000 pm lvn2-monitor. service
211;28:37.000 am Libgerypt.s0.11.8.2

e ens192
08/26/2022 11:23:29.000 am 1libnspré.so

5 00:50:56:01:39:87

10.125.248.1

false

Red Hat Enterprise Linux-7.2

Agent and Scan Details. You can view the following agent and scan details of the selected host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.
Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping Scan.
For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or hash
to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Start a scan for the selected hosts. For more information, see Scan Hosts.

e Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

* Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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P Scarch files on host. Lets you search the files on the host iﬁle name, file path, and SHA-256

checksum). For more information, see

KBl Show/Hide Right Panel - Displays host and policy details panel.

Host Details Panel - Displays all properties of the selected host. It is grouped as follows:
Groups - Groups on which the host is added on.

User - Information related to the user.

Network Interfaces - Network adapter information, such as Mac Address, Gateway.
Operating System - Operating system version and build information.

Agent - Agent-related information, such as agent ID, driver error code, install time, and agent
mode.

Hardware - Information related to the architecture.

Locale - Time zone and language that is local to the host.
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L Policy Details Panel - Displays the following:
* Policy Status -
e Updated - Host has the latest policy.

¢ Pending - Policy is resolved but the latest policy is not updated on the host. When the
host communicates with the Endpoint server next time, the latest policy is applied if there
are no errors.

¢ Unavailable - Hosts that belong to previous versions, such as NetWitness Platform 11.1 or
11.2, or the source server is not installed.

e Error - Problem applying the latest policy along with the error description.
* Blocked Hashes Status -
e Updated - Host has the latest blocked hashes.

¢ Pending - Hashes are blocked but the latest hashes are not updated on the host. When the
host communicates with the Endpoint server next time, the latest hashes are applied if
there are no errors.

¢ Evaluated Time - Time when the Endpoint server evaluated the policy.
e Relay Server. Displays the Relay Server details.

© Server - Host name or IP address of the Relay Server.

° Port - Port number.

°© HTTP Beacon Interval - HTTP beacon interval value in minutes.

e Complete resolved policy settings. For more information, see "Managing Policies" in the
NetWitness Endpoint Configuration Guide.

Note: The values that are not set in the policy are not displayed.

Alerts Severity - Displays list of distinct alerts, such as Critical, High, Medium and All, along
with the total number of events associated with the alert.

gl Displays events for an alert and metadata associated with a specific event. For more
information, see Analyze Hosts Using the Risk Score.
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Hosts View - Process Tab

Note: The information in this topic applies to NetWitness latest version.

The Process panel provides a list of processes running on the host. To access this tab, select a host from
the Hosts view and click the Process tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )
Deeper Analysis

- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files

Perform Host
Forensics

Remediate

Highest Risk Score Change File Status

-Search on Snapshot
- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)

What do you want to do?

T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat 1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

¢ Investigating Hosts

¢ Analyzing Downloaded Files

¢ Changing File Status or Remediate

¢ Investigating a Process

¢ Analyzing Events

¢ Performing Host Forensics

¢ Isolating Hosts from Network

Quick Look

Below is an example of the Process tab:
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NETWITNESS cstigate Responc Users Hosts Files Dashboard Repc

100 H AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION SNAPSHOT TIME
Idle afew seconds ago 12/13/202207:39:13 am

JRUNS  FILES DRIVERS ~ LIBRARIES ~ ANOMALIES OADS  SYSTEM INFO  HISTORY

¥ Filters Proc 4 Analyze Process | | ‘@ Change File Status H 4 Analyze Events |\/ ‘ # More Actions 2 @) TREEVIEW

a PROCESS NAME LOCAL RISK SCORE GLOBAL RISK SCORE ON HOSTS REPUTATION FILE STATUS DOWNLOADED FILEPATH || &2
© Known Good Neutral - C:\Windows\Syst e Lo isl
WizsuinfEeed Matized] - NI, 3 Show details with values only
Known Good Neutral . C:\Windows\Syst
Known Good Neutral C:\Windows\Syst
Known Good Neutral C:\Windows\Syst
Known Good Neutral - C:\Windows\
Known Neutral - C:\Progranj Files I
) 167KB
Known Good Neutral - C:\Windows\Syst
Known Good Neutral - C:\Windows\Syst
Known Good Neutral - C:\Windows\Syst
Known Good Neutral . C:\Program) Files'
b2d3f07f5e8a132f98828b3c02800880
Known Good Neutral - C:\Windows\Syst
e4586989ebbBe8f8084bSeb49afbfd2...

£900eR107229337dhd1c56£224611

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

e Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

* Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you select the snapshot
time from the drop-down menu.
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Actions in the toolbar:

Analyze Process - Lets you perform process analysis to investigate a particular process
behavior, and understand the entire process event chain, process parent-child relationships, and
all associated events. For more information, see Investigating a Process.

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Perform external lookups.
¢ Download files to server, save a local copy, and analyze files for deeper analysis.

e Download process dump to server.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots, Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

"l Toggle. Lets you toggle between List view and Tree view.

Process panel - Displays process information, such as process name, local risk score, global
risk score, On Hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties of a process in the right panel:
o Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.
Hash - Hash type of the file (MD5, SHAT1, and SHA256).
Time - Time when the file was created, modified, or accessed.
Location - Location of the file.
Process - Details of the process, such as image size and PID.

Image - Image details loaded by the process.

* Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and AlL

e Hosts - Displays the top 100 hosts based on the risk score on which the file is present.

gl Filter Files. You can filter processes by selecting the options in the Filters panel and create
filters. For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference,
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Process Details

Clicking the process name displays the process details of a specific process as shown in the following
figure:

NETWITNESS nvestig espond  Users  Hosts  Files  Da d O % @

43 AGENT SCAN STATUS AGENT LAST SEEN AGENT \ o
100 e e Ot snapsHoT TiMe  11/03/2021 05:24:19 pm

ALERTS  PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES  ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

< Processes | Process Details

PATH LAUNCH ARGUMENTS

CA\Users\ecat\AppData\Local\Microsoft\OneDrive\ /background

Process Name Name of the process. For example, server.exe,

PID ID of the process. For example, 492.

Path Path of the file associated with the process on the disk. For example,
C:\Windows\System32.

Launch Command line arguments passed to the process when it is launched. For example, -k

Arguments LocalServiceNoNetwork.

e List of loaded libraries for the selected process, such as DLLs (for Windows), Dylibs (for Mac), or
.SO (for Linux).

e List of autoruns (if configured).

e List of image hooks and suspicious threads (for Windows).
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Hosts View - Autoruns Tab

Note: The information in this topic applies to NetWitness latest version.

The Autoruns panel provides a list of autoruns, services, tasks, and cron jobs running on the host. To
access this tab, select a host from the Hosts view and click the Autoruns tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Secan
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) Host from Network

What do you want to do?

T T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot™* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files Filter Host Details

Hunter

Threat i1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Autoruns tab:
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NETWITNESS Investigate  Respond  Users  Hosts  Files  Dashboard  Reports

AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION SNAPSHOT TIME

7
100 G o
Idle afew seconds ago 12/13/2022 07:39:13 am

SSES AUTORUNS FILES  DRIVERS  LIBRARIES \NOMALIES S SYSTEM INFO HISTORY

Tasks vsocklib.dll

| AILS  LOEAL RISK DEFAILS  H@STS
£ AnalyzeEvents |\

Type tofilter list
REGISTRY PATH ON HOSTS TYPE LAUNCH ARGUMENTS  FILENAME FILE PATH

HKEY_LOCAL_ MACHINE\System\CurrentControl... 2 winsockProvide... - C:\Windows\System32\ Show details with values only
Autoru
HKEY_LOCAL MACHINE\System\CurrentControl... 2 winsockProvide... y C:\Windows\System32\ Eerun
Registry Path  HKEY_LOCAL_MACHINE\System\Curren...
HKEY_LOCAL_MACHINE\System\CurrentControl... 2 winsockProvide... - C:\Windows\System32\
5 Type  winsockProviders
HKEY_LOCAL_MACHINE\System\CurrentControl... winsockProvide... — C:\Windows\System32\
HKEY_LOCAL_ MACHINE\SOFTWARE\Wow6432... logon e e C:\Program Files (x86)\Common Files\Java\Java Update\ Statu
on - Known
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\... 2 logon -nvmusr .exe| C:\Program Files\VMware\VMware Tools\

HKEY_LOCAL MACHINE\SYSTEM\CurrentContro... logon - n C:\Windows\SysWOW64\ General
- . y vsocklibdil
HKEY_LOCAL_MACHINE\SYSTEM\CurrentContro. logon = C:\Windows\System32\
6.137908757322461
HKEY_LOCAL_MACHINE\System\CurrentControl... winsockProvide... - C:\Windows\SysWOW64\
66.7KB
HKEY_LOCAL MACHINE\System\CurrentControl... winsockProvide... C:\Windows\SysWOW64\
pe

HKEY_LOCAL MACHINE\System\CurrentControl... winsockProvide... d C:\Windows\SysWOW64\ ke

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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7

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.
¢ Download process dump to server.

* Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays the following tabs:
e Autoruns - Files that are executed at start-up.
* Services - Files that are running as a service for the selected host.
e Tasks/Cron jobs - Files that are configured to run as scheduled tasks along with the trigger.
Show/Hide Right Panel - Displays the following properties in the right panel:
o Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.
Hash - Hash type of the file (MD5, SHA1, and SHA256).
Time - Time when the file was created, modified, or accessed.
Location - Location of the file.
Autoruns/Services/Tasks - Details related to autrouns, services, or tasks.

e Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and Al

» Hosts -Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Files Tab

Note: The information in this topic applies to NetWitness latest version.

The Files tab displays all files on the host including the files deleted within last 30 days. To access this
tab, select a host from the Hosts view and click the Files tab. By default, it displays 100 files. To display
more files, click Load More at the bottom of the page.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files
-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

N TR

Analyze Events

View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

[Optional) Isolate
Host from Network

(Navigate or Events [y

Change File Status Remediate

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details

Hunter

Threat search files on host* Search Files on Host

Hunter

Threat analyze processes Investigating a Process

Hunter

Threat review reported anomalies Analyze Anomalies

Hunter
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N TN

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT*, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Files tab:
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NETWITNESS estigate  Respond  Users es  Dashboard  Reports S s % @  admin

ALERTS PR

7 3 AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION SNAPSHOT TIME

Idle afew seconds ago 12/13/202207:39:13 am
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C:\Windows\SysWOW64\ 2 68.5KB
C:\Windows\System32\ 2 110.5KB seElE R el caay
C:\Windows\System32\ 2 7200KB
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C:\Windows\SysWOW64\ 548.5KB
C:\Windows\System32\ 61.0KB
C:\Windows\System32\ 14.5KB
C:\Windows\System32\ 11.0KB
C:\Windows\System32\ 669.4KB
C:\Windows\System32\ 3025KB
C:\Windows\System32\ 106.5KB
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Showing 1315 out of 1315 files | 1 selected 154§527fc4d7e3768c2526...

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.

Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

Start a scan for the selected hosts. For more information, see Scan Hosts.

Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

Isolation host from the network. For more information, see Isolating Hosts from Network.

Download MFT to the server. For more information, see Performing Host Forensics.

Download System Dump to the server. For more information, see System and Process
Memory Dump.

Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.

¢ Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search files on host. Lets you search the files on the host (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

B All Files Available on Host - Lists all files (reported as part of scan and tracking) on the host.
By default, All Files Available on Host toggle is enabled for Windows and Mac.

SRl Details Panel - Displays information, such as filename, local risk score, global risk score, on
hosts, reputation status, file status, package details and others.

Show/Hide Right Panel - Displays the following properties in the right panel:

o Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

* Hosts - Displays the top 100 hosts based on the risk score on which the file is present.

g Clicking a filename lets you navigate to the Files view for further analysis.

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.

Note: In the Deleted column, a trash icon appears next to the deleted file. The Deleted
column is not displayed if you disable All Files Available On Host.

For more information, see Filter Host Details.

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

[ ]
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Hosts View - Drivers Tab

Note: The information in this topic applies to NetWitness latest version.

The Drivers tab lists the drivers running on the hosts at the time of scan. To access this tab, select a host
from the Hosts view and click the Drivers tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Secan
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) Host from Network

What do you want to do?

N TR

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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N TN

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT*, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Drivers tab:

NetWitness Endpoint Reference Materials 182



NetWitness Endpoint User Guide

NETWITNESS vestigate  Respond  Users  Hosts  Files  Dashboarc
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Known Good Neutral - C:\Wihdows FileName  vmelsys
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Known Good Neutral - C:Windows | Hash
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1 d85e6aba8Sfedet
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.

Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

Start a scan for the selected hosts. For more information, see Scan Hosts.

Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

Isolation host from the network. For more information, see Isolating Hosts from Network.

Download MFT to the server. For more information, see Performing Host Forensics.

Download System Dump to the server. For more information, see System and Process

Memory Dump.

Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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7

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Perform external lookups.

¢ Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

Details Panel - Displays information, such as filename, local risk score, global risk score, on
hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties in the right panel:
o Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.
Hash - Hash type of the file (MD5, SHA1, and SHA256).
Time - Time when the file was created, modified, or accessed.
Location - Location of the file.

Image - Loaded image.

¢ Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,

High, Medium and Al
¢ Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Libraries Tab

Note: The information in this topic applies to NetWitness latest version.

The Libraries tab lists the libraries loaded at the time of scan. To access this tab, select a host from the
Hosts view and click the Libraries tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Secan
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) Host from Network

What do you want to do?

T T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot™* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat i1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Libraries tab:
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process

Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.
¢ Download process dump to server.

* Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays information, such as process context, filename, local risk score, global
risk score, on hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties in the right panel:

o Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Process - Details of the process, such as image size and PID.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

e Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference,

L]
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Hosts View - Anomalies Tab

Note: The information in this topic applies to NetWitness Version 11.3 and later.

The Anomalies panel provides a list of image hooks, suspicious threads, kernel hooks, and registry
discrepancies running on the host. To access this tab, select a host from the Hosts view and click the

Anomalies tab.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files
-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

T T

Analyze Events

View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

[Optional) Isolate
Host from Network

(Navigate or Events [y

Change File Status Remediate

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts

Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details

Hunter

Threat search on snapshot™* Search Files on Host

Hunter

Threat analyze processes Investigating a Process

Hunter

Threat review reported anomalies* Analyze Anomalies

Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files Filter Host Details

Hunter

Threat i1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Anomalies tab:
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Perform external lookups.
¢ Download process dump to server.

* Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays the following tabs:

* Image Hooks
e Kernel Hooks

e Suspicious Threads

e Registry Discrepancies

Show/Hide Right Panel - Displays the following properties in the right panel:
o Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Image Hooks/Kernel Hooks/Suspicious Threads/Registry Discrepancies - Details related
to image hooks, kernel hooks, suspicious threads, or registry discrepancies.

¢ Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

e Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files, You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,
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Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

Image Hooks

Image hooks found in executable image are displayed in the following columns.

Type

Local Risk
Score

Global Risk
Score

Reputation

Signature

Downloaded

Hooked
Process

Hooked
Filename

Hooked
Symbol

Kernel Hooks

Type of the hook . Possible values are - inline, iat, eat, or exception Handler.

Risk score of suspicious or malicious activities performed by the file on a specific
host.

Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.

Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown, Known,
Known Good, and Invalid.

Provides signatory information.

Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.
Process in which hooks are placed.

Name of the file that was modified by the hook.

Symbol in which the hook is performed.

Hooks found on kernel objects are displayed in the following columns.

Type

Driver name

Type of kernel object which was modified. Possible values are:
objectlnitializer,basicObjectPointer, majorFunction, invalidObject, fastlO,
notifyRoutine, attachedDevice, device, miniPort, sdt, sysEnter, or type.idt.

Name of the driver which placed the hooks.

Local Risk Risk score of suspicious or malicious activities performed by the file on a specific
Score host.

Global Risk Aggregated score of all suspicious and malicious activities performed by the file

Score across all hosts.
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Reputation Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown, Known,
Known Good, and Invalid.

Signature Provides signatory information.

Downloaded Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.

Object Name of the object function hooked into.
Function

Hooked File ~ Name of the file that was modified by the hook.
Name

Suspicious Threads

Threads whose service table was hooked are displayed in the following columns.

Start Address Start Address - Start address of the thread.
DLL Name Name of the DLL.

Local Risk Score ~ Risk score of suspicious or malicious activities performed by the file on a specific
host.

Global Risk Score  Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.

Reputation Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown,
Known, Known Good, and Invalid.

Process File name and PID of the process in which thread is running.

Downloaded Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.

Signature Provides signatory information.

Thread ID ID of the running thread.

Thread Address of the thread environment block.

Environment

Block

Registry Discrepancies

Configuration settings and options on Microsoft Windows operating systems that are stored are displayed
in the following columns.
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Hive Name of the registry hive when possible, otherwise it displays the hive ID. Possible
values are: hkeyClassesRoot, hkeyCurrentUser, hkeyLocalMachine,
hkeyUsers, or hkeyPerformanceData,

Reason Type of registry discrepancy. Possible values are: notFound, embeddedNull,
accessDenied, parentlsHidden, or dataMismatch.

Registry Path Registry path that is affected. The value is separated by a @ character.
Raw Type Value type found in the low-level parsing.

Raw Data Value data extracted from the low-level parsing.

API Type Value type from the Win32 registry APIL

API Data Value data from the Win32 registry APIL.

Hosts View - Downloads Tab

Note: The information in this topic applies to NetWitness Version 11.4 and later.

The Downloads tab provides information about all downloads (MFT, files, system dump, and process
dump) performed on the host. To access this tab, select a host from the Hosts view and click the
Downloads tab.

Workflow

Analyze Events
Analyze Hosts [Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Scan )
Deeper Analysis

- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files

Perform Host

) Change File Status Remedizte
Forensics

Highest Risk Score
- Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) e v—
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What do you want to do?

User

Role

Threat review hosts with highest risk score Analyze Hosts Using the Risk
Hunter Score

Threat analyze hosts Investigating Hosts

Hunter

Threat perform adhoc scan Scan Hosts

Hunter

Threat review host details Analyze Host Details

Hunter

Threat search on snapshot Search Files on Host

Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies

Hunter

Threat analyze risky users Analyzing Risky Users
Hunter

Threat analyze events Analyzing Events

Hunter

Threat download files for deeper analysis Analyzing Downloaded Files
Hunter

Threat perform external lookups Launch an External Lookup for
Hunter a File

Threat change file status or remediate Changing File Status or
Hunter Remediate

Threat isolate host from network™ Isolating Hosts from Network
Hunter

Threat download MFT, download files, system dump, or Performing Host Forensics
Hunter process dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

* Investigating Hosts
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e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Downloads tab:

NETWITNESS n te  Respond

2 AGENT SCAN STATUS AGENT LAST SEEN
100 s Idle afewseconds ago
2

DETAILS  PROCESS AUTORUNS  FILES  DRIVERS  LIBRARIES ANOMALIES DOWNLOADS

Y Filters x = Downloads | SavealocalCopy Delete File 3

0 dwmee

@ customoaTe

SYSTEM INFO  HISTORY

DOWNLOADED TIME

SHAZS6 FILE PATH

HBAIZLITASH 126224600
700630c2555b4de7..

14a5R52R9:896914TFeee .

NA
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

 Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download files to the server. For more information, see Download Files Using Full Path or
Wildcard.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Filter Files. You can filter downloaded files by selecting the options in the Filters panel and
create filters. For more information, see Performing Host Forensics,

Actions in the toolbar:
Save a Local Copy - Lets you retrieve the downloaded MFT and save it to your local file
system for further analysis.

Delete File - Deletes the downloaded MFT from the server.

For more information, see Performing Host Forensics.

View MFT Details. Click the filename to view the MFT details. For more information, see
MFT Viewer,

The table displays the following information:

File Name Name of the file that is downloaded. For example, VGAuthService.exe,

Type Type of file downloaded - MFT, file, memory dump.
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Downloaded Status of the download:

- Download successful
. - Processing the downloaded file

. - Errors including download failed

- Errors downloading one or more files in the group.
Size Size of the downloaded file.

Downloaded Time Time when the MFT was downloaded.

SHA256 SHA256 of the file.

Note: This is applicable only for files.

MFT Viewer

You can analyze the downloaded MFT using the MFT Viewer. For more information, see Analyze
Downloaded MFT.

Below is an example of the MFT Viewer:
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NETWITNESS

100 . a few seconds ago
windows

DETAILS PROCESY | AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO

MFT Viewer 3

‘ < Downloads »

Y Filters

MFT-C-WINDOWS10-2019-11-14T06-47-52-777Z NAME CREATION TIME ($FN)

ProgramData
Program Files (x86)
$RecydeBin
Perflogs

) Program Files

$Extend

Recovery

Documents and Settings
System Volume Information

DELETED FILES

ALL FI

LES

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.

NWE-Trace-Ocictxt

NWE-Trace-Oacc.rar

NWE-Trace-Oacc.txt

NWE-Trace-0f80.rar

NWE-Trace-0f80.txt

NWE-Trace-OaSctxt

NWE-Trace-Oc44 - Copy.tt

NWE-Trace-1fcO.txt

NWE-Trace-Ocd4.txt

NWE-Trace-0c30.txt

DataCollector01.csv

NWE-Trace-264¢ - Copy.txt

O0(0| 0000000000 B

NWE-Trace-264ctxt

For more information, see Filter MFT.

Folder Details. Lets you view the content of the MFT.

Download File to Server. Downloads files to the server.

The table displays the following information:

Column

Name

Size

Creation Time ($FN)

Creation Time ($SI)

Description

Name of the file. For example, dtf.exe,
Size of the file.
File Name ($FN) creation time.

Standard Information ($SI) creation time.

11/12/2019 07:02:03 pm

19/12/2019 11:54:16 am

11/12/2019 1248:33am

11/12/2019 1208:39 am

11/11/2019 09:25:01 pm

11/11/201907:32:11pm

11/11/2019 06:56:29 pm

11/11/2019 05:44:35 pm

11/11/2019 05:43:31 pm

11/11/2019 05:42:05 pm

11/11/2019 05:03:16 pm

11/11/2019 05:02:52 pm

11/06/2019 09:38:24 pm
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Modification time ($FN)

Modification time ($SI)

Access time ($FN)

Access time ($SI)

$FN modified time.
$SI modified time.
$FN access time.

$SI access time.

Update time ($FN) $FN updated time.

Update time ($ST) $SI updated time.

Full Path Path of the file.

Allocated Size File size on the disk.

Archive Indicates if a file is archived.

Compressed Indicates if a file is compressed.

Encrypted Indicates if a file is encrypted.

Hidden Indicates if a file is hidden.

Directory Indicates if it is a directory.

Extension Type of the file. For example, exe, pdf, txt.
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Hosts View - System Information Tab

Note: The information in this topic applies to NetWitness latest version.

The System Information tab lists the agent system information. To access this tab, select a host from the
Hosts view and click the System Information tab.

Workflow

Review Hosts with
Highest Risk Score

Analyze Events

Analyze Hosts
- Review Risk Contributors

- Perform Adhoc Sean

- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files

- Search on Snapshot
- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

(Navigate or Events [y
View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

(Optional) Isolate
Host from Network

Change File Status Remediate

I

Threat Hunter

Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter

Threat Hunter

review hosts with highest risk score

analyze hosts*

perform adhoc scan*
review host details

search on snapshot*
analyze processes

review reported anomalies
analyze risky users
analyze events

download files for deeper analysis

Analyze Hosts Using the
Risk Score

Investigating Hosts

Scan Hosts

Analyze Host Details

Search Files on Host

Investigating a Process

Analyze Anomalies

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded
Files
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arron i ooumron

Threat Hunter perform external lookups Launch an External Lookup
for a File

Threat Hunter change file status or remediate Changing File Status or
Remediate

Threat Hunter isolate host from network™ Isolating Hosts from
Network

Threat Hunter download MFT, system dump, or Performing Host Forensics

process dump*
*You can perform this task in the current view.

Related Topics

e Focusing on Endpoint Analysis

e Investigating Hosts

Quick Look
Below is an example of the System Information tab:

Hosts Files

NETWITNESS estigate

AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION s TIME

Idle 5 days ago 024 08:44:05 am

Hirs DRIVERS LIBRARITS ANOMAL LI JOWNIOADS SYSTIEM INIC HISTORY
Sccurity Products ows Patches  Sccurity Configuration  Installed Applications

IP ADDRESS DNS NAME

scinstallche
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B Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

 Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

checksum). For more information, see Search Files on Host,

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256

System Information Panel - See System Information Panel.

System Information Panel

The System Information panel displays the following tabs:

Host File All network redirections written in the host file. For example, IP Address -
Entries 10.10.10.3 and DNS Name -
localhost, localhost.localdomain, localhost4, localhost4.localdoma
in4
Network Network name of the shared resource (for Windows only). For example, Name -
Shares Admin$, Description - Remote Admin, Path - C:\, Permissions - None, Type -

disk, special, Max Users - 4294967295, Current Users - 0.
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Security Installed security products (for Windows only). For example, Display Name -

Products Windows Defender, Instance - D68DDC3A-831F-4FAE-9E44-DA132C1ACF46,
Features - Enabled, Type - antiVirus.

Windows List of patches applied by Windows update (for Windows only). For example,

Patches KB2959936,

Security Security configuration details on the host. For example, firewall disabled or enabled,

Configuration  smart screen filter disabled or enabled. This field is only applicable for Windows and
Mac.

Installed Displays the information about the various applications installed on a Windows

Applications  machine.
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Hosts View - Agent History Tab
The Agent History tab lists the commands along with the respective status and additional details.

Quick Look
Below is an example of the Agent History tab:

NETWITNESS

@ WIN81x64-1 & i
0 vs I afew seconds ago

ALERTS PROC S AUTORUNS FILES DRIVERS LIBRARIES ~ ANOMALIES DOWNLOADS TEM INFO HISTORY

3

Y Filters ) « | | Agent History

HOST NAME COMMAND TIME COMMAND TYPE USER NAME

COMMAND TIME @) custompaTE

04/24/202007:03:34am Scan admin

04/22/202009:29:38 2m Reset File LogBookmark admin

04/22/202008:12:41am Download File admin

04/22/202007:58:05 am Reset File LogBookmark

04/21/202009:33:03 pm Download File system

04/21/202009:33:03 pm Download File system
REQUEST TYPE 1 04/21/202009:33:03 pm Download File system

04/21/202009:33:03 pm Download File system

04/21/2020 06:26:02 pm Download File system

Contains 04/21/2020 06:26:02 pm Download File system

04/21/2020 06:26:02 pm Download File system

00 out of 113 Comma
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Bl Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

e Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Pl Search files on host. Lets you search the files on the host (file name, file path, and SHA-256
checksum).
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Rl Details Panel- Displays information, such as:
e Command Time - Command issued time.

e Command Type - Type of the command (Identity, scan, stop scan, download file, MFT,
process dump, system dump, start isolation, update isolation exclusion list, stop isolation,
reset file logbookmark, and download multiple files, agent upgrade, and uninstall agent)
issued.

* User Name - User who issued the command. For example, Analyst, System.

e Status - Status (success, pending, expired, failed, or cancelled) of the command issued.

Note: If the command's status is expired, it means that the agent is unable to process the
command even after five retries.

* Command Parameter - Parameters associated with the command. For example, Command
parameter for command type Download File is path = C:\Windows\System32\ |
filename = cmd.exe | hash =
6£88fb88ffb0£f1d5465c2826e5b4£523598b1b8378377c8378ffebcl71badl8b

Note: Command types such as identity, scan, stop scan, stop isolation, system dump do not
contain any associated command parameters.

* Processed Time - Time at which the command is completed, pending, expired, failed, or
cancelled.

e Last Retrieval time - Last time when the command is issued to the agent.

e Total Retrieval - The number of times the command is issued to the agent.

Note: After you upgrade to NetWitness version 11.5, the commands executed in the previous
versions are displayed automatically. The fields such as last retrieval time, total retrieval, and
user do not contain any values. For system generated commands, the user field value shows as
system.

Sl Filter Files. You can filter commands by selecting the options in the Filters panel. For more
information, see Filter Host Details.

Settings Menu. You can set History view preferences by selecting columns from the Settings
menu.

Hosts View - YARA Rules Tab

Note: The information in this topic applies to NetWitness Version 12.0 and later.

The YARA Rules tab lists the various YARA rules used for the scan and their status. To access this tab,
select a host from the Hosts view and click the YARA Rules tab.
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Workflow

Analyze Events
Analyze Hosts [Navigate or Events Lo
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Scan )
Deeper Analysis

- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files

Review Hosts with Perform Host

Remediat
Highest Risk Score emediate

ch File Stat
Forensics s us

- Search on Snapshot

- Analyze Processes

Perform External

Loockups
- Review Reported Anomalies

(for Windows)

[Optional) Isolate

- Analyze Risky Users {Users View) L —.

What do you want to do?

T T T

Threat Hunter review hosts with highest risk score Analyze Hosts Using the

Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

Threat Hunter

analyze hosts*

perform adhoc scan*
review host details

search on snapshot*
analyze processes

review reported anomalies
analyze risky users
analyze events

download files for deeper analysis

perform external lookups

change file status or remediate

isolate host from network*

download MFT, system dump, or
process dump*

Risk Score

Investigating Hosts

Scan Hosts

Analyze Host Details

Search Files on Host

Investigating a Process

Analyze Anomalies

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded

Files

Launch an External Lookup

for a File

Changing File Status or

Remediate

Isolating Hosts from

Network

Performing Host Forensics
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*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

Quick Look
Below is an example of the YARA Rules tab:

NETWITNESS vestigale  Respond  Users

AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

100

Idle afew seconds ago

ALCRTS  PROC RUNS ) S LIBRARIES
YARA RULE STATUS
Rules\all-yara-FireEyeyar v/ Loaded

Rules\match-rule-yara-psryar v/ Loaded

Reporls S S @ admin

SNAPSHOT TIME . i Q
09/16/2022 12:05:20 pm (Yara Scan)

M INFO HISTORY YARA RULCS
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B Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 12.0.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

e Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

* Download System Dump to the server. For more information, see System and Process
Memory Dump.

o Perform remediation actions using the Remote Shell option. For more information, see
Performing Host Forensics.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

w“

YARA Rules Panel - Displays the following tabs:
e YARA Rule: This tab lists all the YARA rules used for the scan.
o Status: This tab displays the status of the YARA rules.
For Example: If the YARA rule is successfully loaded, the status is displayed as Loaded.

For more information on YARA Scans, see Analyze Files Using YARA section in
Investigating Files topic.
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